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Quick Reference: Trade Promotion Analysis Datasets
HELP! Email questions & issues to support@cgsquared.com

Documents at www.i-TPM.com/promotion-planning and www.i-TPM.com/deduction-management

O * Activities Payments BoxFiles ITPM Transactions Lists Reports Analytics

Access to Analytics, Datasets and Workbooks: /TPM data sources your dataset

1. Create a new dataset.
2. SHARE your dataset with members of your team.
3. Permission to access NetSuite Analytics

New DATASETS: Use these one-time steps to create new NetSuite datasets: NetSuite data sources

Step 1: Go to the ANALYTICS center tab and click NEW dataset.

Step 2: Select a RECORD TYPE. Example: ‘transaction’

Step 3: Create the CRITERIA. Use search to find a field. Drag and drop the field into criteria.
Step 4: Find DATA FIELDs, and drag them into your data set.

Step 5: Create FORMULA FIELDs (if any), and drag them into your data set.

{TPM Data Description of NetSuite Datasets and Workbooks for ;TPM data

Deductions 210 OPEN Deductions: Analyze open deductions by customer and many other attributes.440
220 ALL Deductions: Analyze ALL deductions by customer and many other attributes
230 OPEN Deductions Last Month + more: Open deduction aging as of a specific date.

Resolutions | 310 Settlements: Analyze promotional settlements by promotion, customer and item.
320 Journal Entries: Journal entries created by .TPM that resolve open deductions.
330 Statement Charges: Analyze invalid deductions that were reinvoiced and recovered.
340 All Resolutions: All of the above in one dataset.

Promotions 410 KPIs by Promotion: Analyze promotions using many metrics.
420 KPls by Promotion and ITEM: Same metrics with the item dimension.
430 KPIs by Promotion and PERIOD: Same as by promotion with Period dimension.
440 KPIs by Promotion. ITEM and PERIOD: Same as above but with item dimension:
450 .TPM Off-invoice: Analyze .TPM discounts applied to sales orders, invoices and RMAs.

Accruals 510 Accrual Log: Use the event-based log to assess & true-up your period-based accruals.
520 PERIOD Accruals: These are financial accruals, also known as 'live accruals”.
530 EVENT Accruals: These are financial accruals based on your iTPM Promotions.

Budgeting & | 610 Budget: Use this to analyze the native NetSuite budget.

Forecasts 810 Base Forecasts: Roll-up iTPM base forecasts by customer, item and other attributes.
Accruals 710 Reconcile Open Deductions to GL: Use this to reconcile open deductions to a GL.

720a DDN Balance Reconciliation: Use this to reconcile deduction balances.
720b Deductions for Balance Reconciliation Use this to reconcile deduction balances.
730 ALL Open Deduction Transactions: Use this to review All Open deductions.

Sales Orders 910 Sales (Invoiced): Use this to review all sales.
920 Sales Orders: Use this to review all sales orders..
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1.0 Introduction to the .TPM Analytics SuiteApp

[T PM Analytics is a SuiteApp library of over 20 pre-build, role-based datasets and workbooks created for ;TPM.

After .TPM is installed into your NetSuite production account, these pre-build datasets and workbooks can be
installed in your NetSuite instance. See Chapter 10.0 Technical Reference more info.

This user guide will help you to use NetSuite SuiteAnalytics to do Trade Promotion and Deduction Analysis.

({TPM Analytics is described in SuiteApp.com, also accessible in your NetSuite center tab 'SuiteApps".

SuiteApps

|iTPM 2 SuiteApps Found SORT 8Y  |First Release Date -

Vertical and Business Need

VERTICALS
Advertising 0 .
TPM iTPM

Consulting ‘T P

Extend NetSuite for Extend NetSuite for
ERP Trade Promotion Trade Promotion
Health Management Management
IT Services v

Manufacturing
Media and Publishing

MNonprofit

iTPM Analytics

CG Sguared, Inc.

iTPM: Integrated Trade
Promeotion Management by

CG Sguared, Inc.

Other Industry Solutions

Wholesale Distribution

< sak iTPM Analytics

i'PM
Extend NetSuite for

Trade Promotion
Management

iTPM is a native SuiteApp that extends NetSuite for trade
promotion management. iTPM Analytics includes pre-built
NetSuite datasets and workbooks that provide role-based real-
time trade promotion insights for your NetSuite dashboard.

Overview Features Publisher

Pre-built NetSuite Analytics for iTPM

NetSuite Datasets for iTPM

* (riteria filters specific to the workbook
* Measures renamed for end-user readibility
* Shared with the appropriate iTPM standard roles

NetSuite Workbooks for iTPM

* Pivot tables to address key issues
* Shared with the appropriate iTPM standard roles

Limited Access ()

PUBLISHER
CG Squared, Inc.

FIRST RELEASE DATE
11/21/2024

INSTALLED VERSION
LATEST VERSION
1.01

UPGRADES
Managad

© 2025 CG Squared, Inc.
All Rights Reserved
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1.1 What are NetSuite WORKBOOKS and Datasets?

NetSuite workbooks are in SuiteAnalytics. NetSuite workbooks work like Excel spreadsheets inside
NetSuite! You can create multiple workbooks from the same dataset. A data set defines the data and data fields
that are available for your workbooks, pivot tables, lists and graphs.

Advantages include:
e You can keep your data and pivot tables inside NetSuite without exporting data to Excel.
Refresh the view anytime for real-time data.
Create once and done. No need to re-create your pivot table, formulas, etc.
Share the workbook with other users.
Put important pivot views and charts directly on your NetSuite dashboard!

Promotion KPIs by promotion

Promotion KPls by promotion and item

Promotion KPIs by promotion and NetSuite period
Promotion KPIs by promotion, item and NetSuite period
Event-based accrual Log

Open Deductions

All Deductions

Settlements

({ PM Journal Entries

JPM applied off-invoice

1.2 ACCESS to NetSuite workbooks and datasets

If a role has access to SuiteAnalytics, users will see the ANALYTICS center tab.

&) ¢ 6\ Activities Payments BoxFiles ITPM Transactions Lists Reports Analytics Documents

If a user needs access to Analytics, add the following permissions to the role:

Permissions Restrictions Forms Searches Users Preferences Dashboard Translation

Transactions » Lists+ Setup= Custom Record =
PERMISSION LEVEL
Account Detail View
SuiteAnalytics Workbook Edit
© 2025 CG Squared, Inc. www.i-tpm.com Page 6 of 180
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1.3 Create a NEW DATASET

You also have the option for someone on your team to manually create .-TPM workbooks and share them with the
team. This is a one-time task.

If you manually create datasets, we suggest a ‘technical’ person on your team create and share ;TPM workbooks
for your team to use.

o Helpful Hint: This User Guide identifies the specifics for each of the following steps by type of ;TPM
data. There are workbooks specific to deductions, settlements, ;TPM journal entries, promotions and the

promotion accrual log.

If a dataset is already created, use the .;TPM Workbook User Guide to create pivot tables, lists and charts
from your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

MNew Dataset
Step 1: Go to the ANALYTICS center tab, click on Datasets and click .

@ * /ﬁ\ Activities ITPM Payments Transactions Lists Reports Analytics

? My favorite workbooks

Workbooks Datasets

“ -"\\‘ All Datasets » | Showing 25 Datasets New Dataset
DATASET NAME =_ DETAILS DESCRIPTION SCRIPTID OWNER ROOT RECORD LAST OPENED = LAST MODIFIED
Actual Time Analysis » Details TimeT... Syst... Time Tr...

Step 2: Select a RECORD TYPE. Example: ‘transaction’

Q

Scroll up & down to find ‘transaction’, or enter ‘transaction’ in the search field and click search

New Dataset
Search for a record type that includes fields that you would like to show in your dataset.
SEARCH RECORD TYPES
Q Cancel

Showing 332 Record Types

RECORD TYPE = | RECORD CATEGORY RECORD ID

-1TPM Accrual Log # Custom CUSTOMRECORD_ITPM_ACCRUALLOG

© 2025 CG Squared, Inc. www.i-tpm.com Page 7 of 180
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Step 3: Create the CRITERIA. Use search to find a field. Drag and drop the field into criteria.

<ETransaction Dataset @

e Apply to workbook  Cancel Export + [ECUCEES

typd % | « Drop fields here to add criteria.

MEMO : o EnTITY DOCUMENT NUMBER

~ Records

No records found. no idea what this is 1 l
6/4/2018 Deduction applied on ... 10
1243720 W

~ Flelds 2/3/2018 test using minus void ... 100

Transaction Type T I 12/3/2018 test using minus void ... 101

Transaction Abbrev. Type T 1/7/2019 Research and split as .. 102

Step 4: Find the DATA FIELDs, and drag them into your data set.

Helpful Hint: This is a complicated, one-time task. If you have difficulty with this task, we
suggest you contact your technical resource for this step, or email support@cgsqguraed.com.

=EiTPM Open Deduction Analysis @ G €D

(i) This dataset is used in 1 Workbooks. Making a change here will affect these workbooks.

s C

TOM w o &L ~ Criteria summary Show details
Type = AND =~ Status

~ Records

Field [Accrual journal Entry] on [- iTPM Accrual Log]
Field [Accruing Transaction] on [- iTPM Accrual Log] 11 Type is - iTPM Deduction
. - AND * s

ield [Expense Journal Entry] on [- iTPM Expense Queue)
) _ 1 Status is - iTPM Deduction : Open
Fleld [iTPM Deduction] on [- iTPM Deduction Split]

Field [iTPM Deduction] on [- iTPM Expense Queus]

Field [iTPM Deduction] on [- iTPM Resolution Queue]

Reset Criteria

~ Fields . . A
3 RESEARCH STATUS C REASOMN CODE 1
Transaction iTPM Customer
Transaction Apply iTPM Discounts
Transaction ITPM Amaunt i Approved Damages
Transaction iTPM Applied To ar & T _
© 2025 CG Squared, Inc. www.i-tpm.com Page 8 of 180
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Step 5: Create FORMULA FIELDs (if any), and drag them into your data set.

o Helpful Hint: This is a complicated, one-time task. If you have difficulty with this task we
suggest you contact your technical resource for this step, or email support@cgsquraed.com.

0 « Crlteria summary Show details

Type = AND - Status
1 Aging Brackets —'——-‘—“

Transaction LTS Aging Brackets (reference... % DATE i DAYS DPEN :
> Assigned To Employee
I New Formula I 5/16/2018
Billing Address Address
» Competitors Competitor 172019

¥ Controller Fmnloves

Step 6: Optional: SHARE the DATASET with members of your team.
Share while viewing the dataset: You can share with a specific person, or to all people using a role.

Look for the SHARE button next to the save button in the upper right corner.

Share while viewing a list of workbooks, in the ACTIONS column, click = to share your workbook:
\9 * /5\ Activities IiTPM Payments Transactions Lists Reports Analytics Customization Documents
> My favorite workbooks
Workbooks Datasets
C'\‘ ‘;—.I Datasets - ‘ Showing 25 Datasets
DATASET NAME = | DETAILS DESCRIPTION SCRIPTID OWNER ROOT RECORD | LAST OPENED = LAST MODIFIED = ACTIONS
TPM Deductions (open & res... » Details Analyze open AND resol... 21 Alex Ring E Transac.. 2020-05-2.. 2020-04-17... Fl
vl Expense Journal Entries > Details  Analyze iPTM Journal ent... 27 Alex Ring D Transac... 2024 Create Workbook
. Share
TPM Off-invoice allowances ) Details Analyze discounts applie. 39 Alex Ring K -iTPM ... 2020-05-2... z202p
Delete
TPM Open Deduction Analysis ) Details Use this to analyze open ... 41 Alex Ring H Transac.. 2020-05-2... 202C-wwrvr
© 2025 CG Squared, Inc. www.i-tpm.com Page 9 of 180
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1.4 NetSuite data sources for analysis

You can create datasets from any type of data record within NetSuite. Below is a picture of data sources that you
may use to analyze trade promotion spending:

Event

Base
Plans

Monthly
Forecast

I

NetSuite
Budget

JPM PROMOTION

Header records: customer, dates.
etc. 50+ Summary "Stored KPIs" in
the promation header record

[ Planning Records J

[ Allowances by item ]

[ Estimated Quantity by item ]

KPls by PROMOTION
and ITEM records

Key:

Green: NetSuite Financial impact
Yellow: Non-posting
Blue & Purple: No financial impact

Data sources for NetSuite real-time workbooks

{ Sales Orders J TPM Ol

-

Actual sales:
Product Fulfillments

e

Actual sales:

Discount
Logs

-~

A

KPls by KPls by Customer Invoices
PROMOTION PROMOTION,
& Period ITEM & Period
SILTIEL (EBHETE, Customer Payments
( ) ( Credit M
Event-based Financial e
that create ;TPM
Accrual Log {JPM Accrual Deductions

JPM

SETTLEMENTs

|

J

p

Non-Trade ;TPM
Journal Entrys

J |\.:TPM Deductions

Statement Charges

Re-paid Deductions J

When creating a new dataset, consider what data you need for your analysis, and how you want to link different

datasets together.

Example: The green boxes are all NetSuite financial transactions, so you can include or example them in a single
dataset using the dataset criteria filter.

Helpful hint: Select the KPI data source that best meets your needs:

® -

One KPI record per promotion. This is visible under the KPI subtab in the promotion.
One KPI record per promotion per period. This is under the Reports subtab, first sublist.

[}

e One KPI record per promotion per period and item. This is under the Reports subtab, 2nd sublist.
e If you don't have KPIs by period, these map-reduce scripts that create the KPIs may not be

scheduled. Contact support@cgsquared.com.

e Schedule the 2 'period share' scripts for KPis by promotion and period.

o -iTPM - MR Promotion Period Share

o -iTPM - MR Update promotion Period Share

o -iTPM - MR Update item Period Share
o -iTPM - MR By Item Period Share

Schedule the 'ltem period share' scripts for KPIs by promotions, period and item

© 2025 CG Squared, Inc.
All Rights Reserved

www.i-tpm.com
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Below is a list of data that's visible in the PROMOTION form. The first column identifies where you see the data,
the second column is the NetSuite record name, and the third column is a short description.

Where is it?

Promotion header

Link in the
Promotion header

Subtab: Planning
Sublist: - iTPM
Promotion Planning

Subtab: Planning
Sublist: Monthly
Forecast

Subtab: Allowances

Subtab: Estimated
Quantity

Subtab: Settlements

Subtab: KPI's

Subtab: Reports
Sublist: Promotion
Period Share

Subtab: Reports
Sublist: - Item Period
Share

Subtab: Accrual,
Sublist: Log

Subtab: Accrual
Sublist: Financial
Accrual

Name

Custom record:
- iTPM Promotion

Custom record:
-iTPM Plan

Custom record:
- iTPM Promotion Planning

Custom record:
- iTPM Monthly Base
Forecast

Custom record:
- iTPM Allowances

Custom record:
- iTPM Estimated Quantity

Custom transaction:
- iTPM Settlement

Custom record:
-iTPM KPls

Custom record:
- iTPM Promotion Period
Share

Custom record:
- iTPM ltem Period Share

Custom record:
- iTPM Accrual Log

Custom transaction:
-iTPM Accrual

Short Description of the data source

iTPM -> Promotions -> List Stores customer, promotion type,
and promotion dates. Includes Lump Sum.

Optional: Promotion can be created by an upload using an Excel
planner. iTPM -> Annual Plan -> Event Plans

Stores the planned information for the promotion.
Optional: Could be auto-created from data in your Excel Planner.
iTPM -> Annual Plan -> Event Plans

Optional: Visibility to Monthly Forecast and third party data.
Can be imported from the Excel planner, or entered through the
browser.

Created by the 'Process Plan' button from planning records.
Allowances by item

Created by the 'Process Plan' button from planning records.
Estimated quantity by item

Includes settlements that resolve deductions, and settlements
w/o financial impact that only adjust the KPIs

KPIs by for this promotion by item

KPIs for the promotion allocated to all the periods that the
promotion overlaps. No item detail.
One record per promotion per overlapping period.

KPIs for the promotion and item allocated to all the periods that
the promotion overlaps.
One record per promotion and item for each overlapping period.

Optional: If configured, Event-based accrual log shows you what
your accrual should be by day by promotion, and why the accrual
changed. The Event-Accrual log has no financial impact.

Optional: If configured, these financial transactions in NetSuite
are automatically created by iTPM overnight by promotion and for
each activity that impacts the accrual.

© 2025 CG Squared, Inc.
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Below is a list of data that's visible in the DEDUCTION form. The first column identifies where you see the data,
the second column is the NetSuite record name, and the third column is a short description.

Where is it?

Deduction header

Link in the
Deduction header

Subtab: iTPM
Sublist: Related
Deductions

Subtab: Applied
Transactions

Subtab: iTPM
Sublist: Splits

Subtab: Related
Applied
Transactions

Name

Custom transaction:
- iTPM Deduction

Credit memo

Custom transaction:
- iTPM Deduction

Custom transaction:
- iTPM Settlement

NetSuite transaction:

Journal Entry

NetSuite transaction:

Statement Charge

NetSuite transaction:

Credit memo

- iTPM Deduction Split

- iTPM Deduction Split Line

Same as Applied

Transactions subtab, but
for the parent deduction.

Short Description of the data source

The iTPM deduction is a NetSuite financial transaction.

The iTPM deduction was created from this credit memo.

When you split a deduction, all deductions split-off from the original
parent deduction will be visible under this subtab.

Shows all transactions related to the deduction you are viewing.

iTPM Settlements:
e Regular with financial impact.
e Adjust Spend Settlements have NO financial impact.
e VOIDING Settlement: Voids a regular or adjust-spend
settlement.

NetSuite journal entry created by iTPM to resolve a deduction.
NetSuite journal entry REVERSAL, created by iTPM to UNDO the
deduction resolution.

NetSuite Statement Charge, created by iTPM to return the deduction
amount to A/R

This is the credit memo used to create the original iTPM parent
deduction

Optional: If you split deductions, this custom record and related
records are used to split a deduction.
Note: Does not include Quick Split deductions.

Shows all transactions related to the original PARENT of the deduction
you are viewing.

© 2025 CG Squared, Inc.
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2.0 Deductions

Decide how you want to analyze deductions in NetSuite workbooks:

OPEN deductions: These only include deductions that have an open balance. Use this workbook to
analyze what you need to resolve.

ALL deductions: This includes both open and resolved deductions for an overall perspective.

For OPEN deductions, important metrics include:

Open Amount: This is how much needs to be resolved.

Assigned-to: Who is responsible for researching and resolving the open deduction?

Aging: How old is the deduction? The older it is, the less likely you will get repayment if it is invalid.
Disputed? These are deductions you think are not valid.

Customer agrees to repay? Did the customer agree to repay the invalid deduction?

Posting date vs deduction date: The posting date is based on the NetSuite financial transaction date,
but the deduction can have a different date.

For ALL deductions, here are additional metrics to consider in your analysis:

Total Original Amount: While this measure is available for open deductions, it is most useful when
analyzing all of your deductions. This provides a perspective of how many deductions have been
successfully researched and resolved.

Compare open balance to resolved amounts for perspective
Date previously resolved, date resolved, and date last reopened are available after ;TPM 24.1.2..
Filter based on deduction date or posting date to view a specific time period.

o Example: Look at deductions posted last year: How much is still open by customer? Compare
this to total resolved deductions for perspective on magnitude for that customer.

o Example: What is the total of all deductions disputed this year? How much of the disputed
deductions were repaid, written-off, and/or still open?

Helpful hint: You can also create aging brackets based on different dates.
e Deduction transaction date (i..e when the deduction was created or split.)
e NetSuite financial posting date, which can be different from the deduction transaction date.
e The reference date you enter. (i.e., date of a transaction last year, identified in a post audit that
was deducted and claimed today).

Helpful hint: Reason codes may not be the best way to analyze resolutions. Reason codes are only
used to set the default GL account on journal entries. Settlements have the GL accounts associated
with the promotion linked to the settlement. You can use a separate workbook to analyze settlements,
journal entries, and statement charges, or analyze all ;TPM resolutions in one workbook.

Helpful hint: The split deduction feature is powerful, but it means you can not just sum measures like
original deduction amount. Use the formula in section 4.2 to get the correct value.

Helpful hint: You can decide if you want to include or exclude Deductions that are in PROCESSING
status from your NetSuite workbooks.
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2.1iTPM 210 OPEN Deduction Analysis

Create a DATASET for open deductions (one-time task). Suggested name: iTPM 210 Open Deduction Analysis

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

Here are the steps to create your DATASET to analyze OPEN deductions:
MNew Dataset
1. Create a new Dataset: (Name: - iTPM 210 Open Deduction Analysis)

2. Select a Record Type: Transaction

New Dataset

Search for a record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYPES

transaction

Showing 7 Record Types

RECORD TYPE

Transaction Numbering Audit Log
Transaction Audit Trail

Transaction

3. Criteria: TYPE = iTPM Deduction AND STATUS = iTPM Deduction: OPEN and iTPM Deduction: Processing;
DATE on or after start of fiscal year before last

~ Criteria summary Show details

Type = AND = Status = AND = Date
12 Typeis-iTPM Deduction
AND - iz Status any of - iTPM Deduction : Open, - iTPM Deduction : Processing

12 Date on or after start of fiscal year before last

Note: If you have ‘bad’ deduction data with NO link to transactions, depending on how you
corrected the data, you may need to exclude these deductions if the split-off amount is not
correct.
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date

€ Dataset | _iTpM 210 Open Deduction Analysis (25DF)

() This dataset is used in 3 Workbooks. Making a change here will affect these

o Cc C
Date Q,

~ Records

Field [Deductions to Update] on [- iTPM MonGL MassUpdate Queue]

~ Fields
Transaction Date [1]
Transaction Reference Date ‘% [I]

: Sh hs )
Note: You may need to click to find your measure.

Use the table on the next page to add these fields: Note: You'll create Aging Brackets in step 5.)

=iTFM 210 Open Deduction An

Aging Brackets f; T

Aging Brackets (refe.. B T

Assigned On < [T || Memo T
Assigned To X T Mext Steps X T
Customer Approves ... 9§ & Open Balance X #
Date [1] || Posting Period [1]
Days Open # || Reason Code X T
Deduction Status T Reference Date % [T
Disputed? ¢ 2 || Research Status X T
Document Number/1D T Sales Rep T
iTPM Amount % # || split Off X H
iTPM Customer X T Transaction T
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Field Name Source Field ID Description (210 Open Deductions)

Aging Brackets Formula See step 5 Use this to group your deductions based on how old
they are based on deduction date

Aging Brackets Formula See step 5 Use this to group your deductions based on how old

(reference date) they are based on reference date

Assigned On Transaction custbody_itpm_ddn_assignedon Assigned On date

Assigned To Transaction custbody_itpm_ddn_assignedto This is the person assigned to the deduction

Customer Transaction custbody_itpm_ddn_customerappro | Customer Approves Repay

Approves Repay ves

Date Transaction trandate This is the NetSuite transaction date

Days Open Transaction daysopen This is how many days the deduction has been open
status

Deduction Status | Transaction status Deduction status: Criteria filtered to show only
OPEN deductions in this workbook.

Disputed? Transaction custbody_itpm_ddn_disputed Is this deduction disputed? This is based on the
Disputed? checkbox.

Document Transaction tranid This is the NetSuite transaction ID.

Number/ID

iTPM Amount Transaction custbody_itpm_amount This is the full amount of the deduction. Compare
this amount to how much is still open.
You can’t add this up because of split deductions.
Use the TOTAL (resolved + open) that you calculate
in a formula.

iTPM Customer Transaction custbody_itpm_customer NetSuite customer that took the deduction

Memo Transaction memo Memo on the deduction

Next Steps Transaction custbody_itpm_ddn_nextsteps Next steps drop-down menu selection (optional)

Open Balance Transaction custbody_itpm_ddn_openbal Open balance of the deduction

Posting Period Transaction postingperiod NetSuite posting period for the deduction

Reason Code Transaction custbody_itpm_ddn_reasoncode Deduction’s reason code

Reference Date Transaction custbody_itpm_ddn_referencedate | Optional reference date of the deduction

Research Status | Transaction custbody_itpm_ddn_researchstatus | Research status drop-down menu selection
(optional)

Split Off Transaction custbody_itpm_ddn_splitoff How much was split off from the deduction amount.

Transaction Transaction trandisplayname This is the name of the deduction
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These fields will turn blue after you drag them into your data set:

Formulas 2 Assigned On % [1]
Transaction 19 > Assigned To <§$ T
» Transaction Line
Customer Approve&..‘% e
» Accrual ID
) ) _ Date [1]
» Accruing Transaction Transaction
» Assigned To Days Open #
» Billing Address Disputed? X 2
> Competitors Document Mumber/ID T
» Controller TPM Amount X #
» Copy Employees ,
Py EmPIoY iTPM Customer X T
» Created By
Memo T
» Created By Customer
» Created By Employee Next Steps T
Y Created By Entity Open Balance X #
? Created By Partner Posting Period [3]
» Created By Vendor Reason Code & T
» Credits Applied
PP Reference Date % [1]
» Currency
o Research Status X T
Customer Priority
» Deduction Transaction Split Off X #
Destination Location Status T
Entity Transaction T
Transaction 19 > Sales Rep T
> iTPM Customer 1 Email T
» ITPM Deduction Group 3rd Party Billing Account... T
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5. Formulas: Create a new Formula called Aging Bracket, Output Type = STRING

Formula Field »

FORMULA FIELD NAME* CHOOSE OUTPUT TYPE*
‘Ag'ng Bracket | STRING -
FORMULAF

1 case

2 When (current_date <= ({trandate} +38)) then "1: @-38 days'

3 When (current_date > ({trandate} +38) AND current_date <= ({trandate} +6@)) then "2: 31-60 days’
4 When (current_date > ({trandate} +68) AND current_date <= ({trandate} +98)) then "3: £1-90 days’
5 else '4: 90+ days' End

Copy the following into the FORMULA field in the page above for Aging Bracket: (transaction date)

case
When current_date <= ({trandate} +30) then '1: 0-30 days'

When (current_date > ({trandate} +30) AND current_date <= ({trandate} +60)) then '2: 31-60 days'
When (current_date > ({trandate} +60) AND current_date <= ({trandate} +90)) then '3: 61-90 days'
else '4: 91+ days' end

Create a new Formula called Aging Bracket (reference date), Output Type = STRING

FORMULA FIELD NAME* CHOOSE OUTPUT TYPE*
‘Ag'ng Brackets (reference ‘ STRING -
FORMULAF

1 case

2 When current_date < ({custbody_itpm ddn_referencedate} +38) then "@-3@ days'

3 When (current_date >= ({custbody_itpm_ddn_referencedate} 4+3@) AND current_date <
({custbody_itpm_ddn_referencedate} +60@)) then '31-68 days’

4 When (current_date »>= ({custbody_itpm ddn_referencedate} +6@) AND current_date <
({custbody_itpm_ddn_referencedate} +9@)) then '61-98 days’

5 else '91+ days' end

case
When current_date < ({custbody_itpm_ddn_referencedate} +30) then '0-30 days'
When (current_date > ({custbody_itpm_ddn_referencedate} +30) AND current_date <=
({custbody_itpm_ddn_referencedate} +60)) then '31-60 days'

When (current_date > ({custbody_itpm_ddn_referencedate} +60) AND current_date <=
({custbody_itpm_ddn_referencedate} +90)) then '61-90 days'

else '91+ days' end
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Your Formulas will change to blue when you drag them to your data set:

Formulas 2 Aging Brackets £ T

Sreeeoos 0 @ Aging Brackets (refere... 5 T

» Transaction Line
¥ Accrual ID
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2.2 iTPM 220 Deductions (Open & Resolved)

This NetSuite workbook will enable you to analyze all of your deductions, including deduction status of open,
resolved, and pending. (Processing status is typically excluded from workbook analysis.)

Note: The split deduction feature is powerful, but it also means you can not just sum measures like the
original amount. Use the formula in this section to get the correct data for your analysis.

Create the DATASET to analyze ALL deductions (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

1. Create a new Dataset: . (Name: - iTPM 220 Deductions (Open & Resolved))

2. Select a Record Type: Transaction

New Dataset
Search for a record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYFES

‘ transaction

Showing 7 Record Types

RECORD TYPE

Transaction Numbering Audit Log
Transaction Audit Trail

Transaction

3. Criteria: Type = - iTPM Deduction AND Status none of “iTPM Deduction: Processing” AND DATE on or after
start of fiscal year before last

~ Criteria summary Show detsils
Type * AND = Status = AND » Date
i1 Typeis - iTPM Deduction

AND = z: Status none of - iTPM Deduction : Processing

iz Date on or after start of fiscal year before last
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4. Data Fields: For each field in the list below, a) enter it into the search, b) find it in the list below, and c) drag it
to your data set. Example: Date

€ Dataset _iTpM 220 Deductions (Open & Resol

(i) This dataset is used in 2 other Workbooks. Making a change here

o ¢ C
Date Q

w Records

Field [Deductions to Update] on [- iTPM NonGL MassUpdate Queue]

~ Fields
Transaction Date [1]
Transaction Date Last Resolved < [

: Sh Is !
Note: You may need to click to find your measure.

Use the table on the next page to add these fields: (Note: You'll create RESOLVED in step 5)

- iTPM 220 Deductions (Open
Assigned To X T
Created By Quicksplit ¢ 2
Customer Approves ... ‘% 2
Date 5 Memo T
Date Last Resolved ¢ [1] Open Balance X #
Date Previous Resal... $¢ [1] Posting Period [1]
Date Reopened % [ (| reason code XT
Disputed? X 2 Resolved i #
Document Number/ID T || sales Rep T
iTPM Amount X # Split Off X #
iTPM Customer X T || transaction T
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Field Name Source Field ID Description (220 ALL Deductions)

Assigned To Transaction custbody_itpm_ddn_assignedto | This is the person assigned to the deduction

Created by Quick Transaction custbody_itpm_createdbyquicks | Created by Quick Split

Split plit

Customer Approved Transaction custbody_itpm_ddn_customerap | Did the customer agree to repay this disputed

Repay? proves deduction? This is based on the Customer
Approved Repay? checkbox.

Date Transaction trandate This is the NetSuite transaction date

Date last Resolved Transaction custbody_itpm_date_last_resolv | Date last Resolved

ed

Date previously Transaction custbody_itpm_date_previous_r | Date previously Resolved

Resolved esolved

Date reopened Transaction custbody_itpm_date_reopened Date reopened

Disputed? Transaction custbody_itpm_ddn_disputed Is this deduction disputed? This is based on
the Disputed? checkbox.

Document Transaction tranid This is the NetSuite transaction ID.

Number/ID

iTPM Amount Transaction custbody_itpm_amount This is the full amount of the deduction.
Compare this amount to how much is still
open.
You can’t add this up because of split
deductions. Use the TOTAL (resolved + open)
that you calculate in a formula.

iTPM Customer Transaction custbody_itpm_customer NetSuite customer that took the deduction

Memo Transaction memo Memo on the deduction

Open Balance Transaction custbody_itpm_ddn_openbal Open balance of the deduction

Posting Period Transaction postingperiod NetSuite posting period for the deduction

Reason Code Transaction custbody_itpm_ddn_reasoncode | Reason Code

Resolved Formula See step 5 This is the amount of the deduction that is
resolved.
Resolved = Amount - Split-off - Open

Sales ,Rep custbody_itpm_customer.salesr | Sales Rep

ep

Split Off Transaction custbody_itpm_ddn_splitoff How much was split off from the deduction
amount.

Transaction Transaction trandisplayname This is the name of the deduction
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These fields will turn blue after you drag them into your data set:

q
%S Dataset _jTpM 220 Deductions (Open & Reso
o c C
Q «
Formulas 1 Assigned To X T
Transaction 17 Created By QuickSp... 5§ 2
T ction Li
LT Customer Approves... % e
» Accrual ID
i ) Date (1]
» Accruing Transaction Transa...
> Assigned To Date Last Resolved % [1]
» Billing Address Date Previous Resol... §¢ [1]
» Competitors Date Reopened * [T
» Controller Disputed? X 2
C Empl
» Copy Employees Document Number/ID T
» Created By
iTPM A t
» Created By Customer | modn X #
» Created By Employee iTPM Customer % T
) Created By Entity Memo T
» Created By Partner Open Balance X #
» Created By Vendor Posting Period 11
Credits Applied
» Credits Applie Reason Code % T
» Currency
Split Off
» Customer Priority P X #
¥ Deodirtion Trancartinm Transaction T
Transaction 17 O Sales Rep T
» iTPM Cust 1
i ustomer Ernail T
» ITPM Deduction Group
3rd P Billing A ..
? ITPM Promotion rd Party Biling Account... T
» iTPM Promotion Type 3rd Party Billing Carrier T
> Last Modified By Customer 3rd Party Billing Country T
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NetSuite 2025.1

Formula Field
FORMULA FIELD NAME* CHOOSE OUTPUT TYPE*
Reszolved FLOAT hd
FORMULA*

1 {custbody itpm amount}-{custbody_itpm ddn_splitoff}-{custbody itpm_ddn_openbal}

Copy this into your formula box for the RESOLVED measure, and drag the measure to your data set:
Output type = FLOAT

{custbody_itpm_amount}-{custbody itpm_ddn_splitoff}-{custbody_itpm_ddn_openbal}

Formulas Resolved Fx
[P = =

Note: You can create a new TOTAL field that is the total of OPEN and RESOLVED. If you
create a total, be careful your workbook does NOT sum up open, resolved AND total. If you
do this, the workbook auto-total will be double your deduction amount.

FORMULA FIELD NAME* CHOOSE QUTPUT TYPE*
Total (Resolved + Open) FLOAT v
FORMULAF

1 {custbody_ itpm_amount}-{custbody itpm ddn_splitoff}

Copy this into your formula box for the TOTAL measure, and drag the measure to your data set:

{custbody_itpm_amount}-{custbody itpm_ddn_splitoff}

Your Formulas will change to blue when you drag them to your data set:

Formulas 1 Resolved i #

Transaction 17 =
» Transaction Line

© 2025 CG Squared, Inc. www.i-tpm.com Page 24 of 180
All Rights Reserved Quick Reference Link: Analytics



http://www.i-tpm.com/

User Guide: Datasets

i{IPM

NetSuite 2025.1

2.3 iTPM 230 Deduction Aging by Month/Last Year

Create a DATASET for open deductions (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

Here are the steps to create your DATASET to analyze OPEN deductions:

1. Create a new Dataset: . (Name: - iTPM 230 Deduction Aging by Month/Last Yr)

2. Select a Record Type: Transaction

New Dataset

Search for a record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYPES

transaction

Showing 7 Record Types

RECORD TYPE

Transaction Numbering Audit Log
Transaction Audit Trail

Transaction

3. Criteria: TYPE = iTPM Deduction AND STATUS = iTPM Deduction: OPEN, iTPM Deduction: Processing
AND DATE on or after start of last fiscal year

» Criteria summary Show details
Type * AND = Status = AND - Date
:: Typeis - iTPM Deduction

AND = i1 Status any of - iTPM Deduction : Open, - ITPM Deduction : Processing

11 Date on or after start of last fiscal year

Note: If you have ‘bad’ deduction data with NO link to transactions, depending on how you
corrected the data, you may need to exclude these deductions if the split-off amount is not
correct.
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. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date
& Dataset _{TpM 230 Deduction Aging by Month/Last Y]
o Cc C
Date Q
 Records
Field [Deductions to Update] on [- iTPM NonGL MassUpdate Queug]
~ Fields
Transaction Date 1]
Transaction Date Last Resolved * [
Note: You may need to click to find your measure.
Use the table on the next page to add these fields: Note: You'll create Aging Brackets in step 5.)
- iTPM 230 Deduction Aging b
1: Aging Current S T || entity ax
2: Aging Last Month % T || iTPM Amount X #
3: Aging Prior Month % T || iTPM Customer X T
4: Aging Last Year ¢ T || Last Month End A [1]
s: Amount (for Rollu... % # || Last Month start 5 [1
6: Resolved Amount .f';; # || Last vear End .J";; [T
Assigned To XK T || Memo T
Current Age 5 T Open Balance X #
iCurrent Date £ [1 Fosting Period (1
Current Month Start .f';; [Z1 || prior Month End .J";; [T
Customer Appraves ... % @ || Prior Month Start £ [T
Date Last Resolved  9¢ [11]] sales Rep T
Date Reopened X [1|| splitoff X #
Deduction Date [ || status T
Disputed? % 2 || Total Amount (Trans Cur... £
Document Number/ID T || Transaction T
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Field Name Source Field ID Description (230 Open Deductions as of a date)

1: Aging Current | Formula See step 5 Open deduction aging based on today's date

2: AgingLast Formula See step 5 Open deduction aging as of the last day in the last

Period period

3: Aging Prior Formula See step 5 Open deduction aging as of the last day in the month

Period before last month. (two periods ago)

4: Aging Last Formula See step 5 Open deduction aging as of the last day of last year

Year

5: Amount (for Formula See step 5 Amount for rollups to prevent double counting of

Rollups) amounts involved with splits. Calculated as Original
Amount less Split Amount

6: Resolved Formula See step 5 This is the amount of the deduction that is resolved.

Amount Resolved = Amount - Split-off - Open

Assigned To Transaction custbody_itpm_ddn_assignedt | This is the person assigned to the deduction

o]

Current Age Formula See step 5 Use this to group your deductions based on how old
they are

Current Date Formula See step 5 Use this to group your deductions based on how old
they are

Current Month Formula See step 5 Current Month Start

Start

Customer Transaction custbody_itpm_ddn_customer | Did the customer agree to repay this disputed

Approves approves deduction? This is based on the Customer

Repay? Approved Repay? checkbox.

Deduction Date | Transaction trandate This is the NetSuite transaction date

Disputed? Transaction custbody_itpm_ddn_disputed Is this deduction disputed? This is based on the
Disputed? checkbox.

Document Transaction tranid This is the NetSuite transaction ID.

Number/ID

Date Last Transaction custbody_itpm_date_last_reso | This is when the deduction was resolved

Resolved Ived

Date Last Transaction custbody_itpm_date_reopene | If the deduction was resolved and then reopened, this

Reopened is when the deduction went back to open status.

iTPM Amount Transaction custbody_itpm_amount This is the full amount of the deduction. Compare

(Transaction) this amount to how much is still open.

You can’t add this up because of split deductions.
Use the TOTAL (resolved + open) that you calculate
in a formula.
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Field Name Source Field ID Description (230 Open Deductions as of a date)
iTPM Customer | Transaction custbody_itpm_customer NetSuite customer that took the deduction
Last Month End | Formula See step 5 Calculates this date
Last Month Start | Formula See step 5 Calculates this date
Last Year End Formula See step 5 Calculates this date
Memo Transaction memo Memo on the deduction
Open Balance Transaction custbody_itpm_ddn_openbal | Open balance of the deduction
Posting Period Transaction postingperiod NetSuite posting period for the deduction
Prior Month End | Formula See step 5 Calculates this date
Prior Month Formula See step 5 Calculates this date
Start
Reason Code Transaction custbody_itpm_ddn_reasonc | Deduction’s reason code
ode
Reference Date | Transaction custbody_itpm_ddn_referenc | Optional reference date of the deduction
edate
Split Off Transaction custbody_itpm_ddn_splitoff How much was split off from the deduction amount.
Status Transaction status Shows deduction status as of now, today.
Transaction Transaction trandisplayname This is the name of the deduction
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These fields will turn blue after you drag them into your data set:

Formulas 14 Assigned To X T
Selesdbed i o Customer Approve&..‘% &
» Transaction Line
Date [1]
» Accrual ID
) ) Date Last Resolved ¢ [1]
» Accruing Transaction Transact...
> Assigned To Date Reopened % [1]
» Billing Address Disputed? X 2
> Competitors Document Number/ID T
» Controller Entity LE
» Copy Employees ,
Py EmPIoY iTPM Amount X #
» Created By %
iTPM Customer T
» Created By Customer
» Created By Employee Memo T
) Created By Entity Open Balance X #
? Created By Partner Posting Period [1]
» Created By Vendor split OFf X #
» Credits Applied
PP Status T
» Currency
- Total Amount (Transact... #
Customer Priority
2 Deduction Transaction Transaction T
Transaction 7 > Sales Rep T
» iTPM Customer 1 Email T
2 ITPM Deduction Group 3rd Party Billing Account... T
AR 3rd Party Billing Carrier T
¥ TPM Promotinn Tvne
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5. Formulas:
1: Aging Bracket CURRENT, Output Type = STRING

Copy the following into the FORMULA field in the page above for Aging Bracket: (transaction date)

case when {status#display} = - iTPM Deduction : Open' then

case when CAST_TO_DATE(current_date) <= ({trandate} +30) then '0-30 days'

When (CAST_TO_DATE(current_date) > ({trandate} +30) AND current_date <= ({trandate} +60))
then '31-60 days'

When (CAST_TO_DATE(current_date) > ({trandate} +60) AND current_date <= ({trandate} +90))
then '61-90 days'

else '90+ days' end

else " end

Below are formulas for last month, prior month, and prior year aging.
Notes related to the formulas below:

e In each formula, the outer case determines deductions to include in the aging, while the inner
case determines the aging bracket.
e Limitations/questions/further review required:

o Formulas don't work in some cases for deductions where
{custbody _itpm_date last_resolved}, {custbody itpm_date previous_resolved}, and
{custbody_itpm_date reopened} are not populated but should be (deductions resolved
and/or reopened prior to the addition of those fields.

o Current_Date is datetime, however {trandate} and new fields
{custbody_itpm_date_last_resolved}, {custbody itpm_date previous_resolved}, and
{custbody_itpm_date _reopened} appear to be date, not date time. Does that matter for
certainty regarding the sequence of events on the same day?

Used CAST_TO_DATE with current_date to avoid mixed date/datetime in comparisons.
Is {custbody itpm_date reopened} always set when a deduction moves from resolved to
any other status regardless of how that occurs and regardless to which other status it
moves?

o Calculation of last day of last year:

m CAST_TO_DATE(ROUND_DATE(CURRENT_DATE,'YEAR')-1)
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case when

-- Deduction Date is prior to end of last month

({trandate} <= ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-1))
--And has never been resolved based on {custbody_itpm_date last _resolved}
--and is not currently resolved.

AND

(({custbody_itpm_date_last_resolved} is empty and {status#display} <> '- iTPM Deduction :
Resolved')

--or resolved after the end of last month and was never previously resolved.

or

({custbody_itpm_date last_resolved} >
ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-1) and

{custbody _itpm_date previous_resolved} is empty)

-- or was last resolved before the end of last month but then reopened before end of last month
-- but after last resolved

or

({custbody_itpm_date_last_resolved} <
ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-1) and

{custbody itpm_date reopened} <=
ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-1) and

{custbody_itpm_date reopened} > {custbody_itpm_date last_resolved})

--or was previously resolved before the end of last month but then reopened before end of last
--month and was resolved after end of last month

or ({custbody_itpm_date_previous_resolved} <
ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-1) and
{custbody_itpm_date_reopened} <=
ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-1) and

{custbody itpm_date last resolved} >
ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-1)))

then

case

when ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-1) <= ({trandate} +30) then
'0-30 days'

When (ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-1) > ({trandate} +30) AND
ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-1) <= ({trandate} +60)) then '31-60
days'

When (ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-1) > ({trandate} +60) AND
ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-1) <= ({trandate} +90)) then '61-90

days'
else '90+ days' end
else " end
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case when

-- Deduction Date is prior to end of last month

({trandate} <= ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-2))
--And has never been resolved

AND

(({custbody_itpm_date last resolved} is empty and {status#display} <> '- iTPM Deduction :
Resolved')

--or resolved after the end of last month and was never previously resolved.

or

({custbody_itpm_date_last_resolved} >
ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-2) and

{custbody _itpm_date previous_resolved} is empty)

-- or was last resolved before end of last month but then reopened before end of last month

-- but after last resolved

or

({custbody_itpm_date_last_resolved} <
ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-2) and
{custbody_itpm_date_reopened} <=
ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-2) and

{custbody itpm_date reopened} > {custbody_itpm_date last_resolved})

--or was previously resolved before the end of last month but then reopened before end of last
--month and was resolved after end of last month

or ({custbody_itpm_date_previous_resolved} <
ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-2) and
{custbody_itpm_date_reopened} <=
ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-2) and

{custbody_itpm_date last resolved} >
ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-2)))

then

case

when ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-2) <= ({trandate} +30) then
'0-30 days'

When (ADD_MONTHS(LAST_DAY(CAST_TO_DATE(current_date)),-2) > ({trandate} +30) AND
current_date <= ({trandate} +60)) then '31-60 days'

When (ADD_MONTHS(LAST DAY(CAST_TO_DATE(current_date)),-2) > ({trandate} +60) AND
current_date <= ({trandate} +90)) then '61-90 days'

else '90+ days' end

else " end
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case when

-- Deduction Date is prior to end of last month

({trandate} <= CAST_TO_DATE(ROUND_DATE(CURRENT_DATE,'YEAR')-1))

--And has never been resolved based on {custbody_itpm_date last_resolved}

--and is not currently resolved.

AND

(({custbody_itpm_date_last_resolved} is empty and {status#display} <> '- iTPM Deduction :
Resolved')

--or resolved after end of last month and was never previously resolved.

or

({custbody_itpm_date _last_resolved} >
CAST_TO_DATE(ROUND_DATE(CURRENT_DATE,'"YEAR')-1) and
{custbody _itpm_date previous_resolved} is empty)

-- or was last resolved before end of last month but then reopened before end of last month

-- but after last resolved

or

({custbody_itpm_date_last_resolved} <
CAST_TO_DATE(ROUND_DATE(CURRENT_DATE,'YEAR')-1) and

{custbody_itpm_date reopened} <=
CAST_TO_DATE(ROUND_DATE(CURRENT_DATE,'YEAR')-1) and

{custbody_itpm_date reopened} > {custbody_itpm_date last_resolved})

--or was previously resolved before the end of last month but then reopened before end of last
--month and was resolved after end of last month

or ({custbody_itpm_date_previous_resolved} <
CAST_TO_DATE(ROUND_DATE(CURRENT_DATE,'YEAR')-1) and
{custbody_itpm_date_reopened} <=
CAST_TO_DATE(ROUND_DATE(CURRENT_DATE,'YEAR')-1) and

{custbody itpm_date last resolved} >
CAST_TO_DATE(ROUND_DATE(CURRENT_DATE,'"YEAR')-1)))

then

case

when CAST_TO_DATE(ROUND_DATE(CURRENT_DATE,'YEAR')-1) <= ({trandate} +30) then
'0-30 days'

When (CAST_TO_DATE(ROUND_DATE(CURRENT_DATE,'YEAR')-1) > ({trandate} +30) AND
CAST_TO_DATE(ROUND_DATE(CURRENT_DATE,'YEAR')-1) <= ({trandate} +60)) then '31-60
days'

When (CAST_TO_DATE(ROUND_DATE(CURRENT_DATE,'YEAR')-1) > ({trandate} +60) AND
CAST_TO_DATE(ROUND_DATE(CURRENT_DATE,'YEAR')-1) <= ({trandate} +90)) then '61-90
days'

else '90+ days' end

else " end

5: Amount (for Rollups) Output Type = Float

{custbody_itpm_amount}-{custbody itpm_ddn_splitoff}-{custbody itpm_ddn_openbal}
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6: Resolved Output Type = Float

{custbody_itpm_amount}-{custbody itpm_ddn_splitoff}-{custbody_itpm_ddn_openbal}

Current Age Output Type = String

case
when CAST_TO_DATE(current_date) <= ({trandate} +30) then '0-30 days'

When (CAST_TO_DATE(current_date) > ({trandate} +30) AND current_date <= ({trandate} +60))
then '31-60 days'

When (CAST_TO_DATE(current_date) > ({trandate} +60) AND current_date <= ({trandate} +90))
then '61-90 days'

else '90+ days' end

Current Date Output Type = Date

CAST_TO_DATE(CURRENT_DATE)

Current Month Start Output Type = Date

CAST_TO_DATE(ADD_MONTHS(LAST DAY (current_date),-1)+1)

Last Month End, Output Type = Date

CAST_TO_DATE(ADD_MONTHS(LAST_DAY(current_date),-1))

Last Month Start Output Type = Date

CAST_TO_DATE(ADD_MONTHS(LAST DAY (current_date),-2)+1)

Last Year End Output Type = Date

CAST_TO_DATE(ROUND_DATE(CURRENT_DATE,'"YEAR')-1)

Prior Month End, Output Type = Date

CAST_TO_DATE(ADD_MONTHS(LAST_DAY/(current_date),-2))

Prior Month Start, Output Type = Date

CAST_TO_DATE(ADD_MONTHS(LAST_DAY(current_date),-3)+1)
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These fields will turn blue after you drag them into your data set:

. L . . . . T L . .

Formulas
Transaction
Transaction Line

Accrual ID

Accruing Transaction Transa...

Assigned To

Billing Address
Competitors
Controller

Copy Employees
Created By

Created By Customer
Created By Employee
Created By Entity
Created By Partner
Created By Vendor

17

14
>

1 Aging Current

2 Aging Last Month
3 Aging Prior Month
4 Aging Last Year

5 Amount (for Rollups)
6 Resolved Amount
Current Age
Current Date
Current Month Start
Last Month End
Last Month Start
Last Year End

Prior Month End

Prior Month Start

xh xh xh o xh xh o Y XY o B xh xh X
B EEEEEEEEA##HAAAA
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3.0 Resolutions

Use NetSuite workbooks to analyze each of the three ways .TPM deductions can be resolved:

{TPM Settlements:
e Settlements: All of these settlements have financial impact:
o Regular: Settlements resolve deductions by matching them to a promotion. You can analyze
these by customer, item, date, and other attributes.
o Voiding and Voided: When you void a settlement, a ‘voiding’ settlement is created. Both voided
and voiding settlements are excluded in these settlement workbooks.

e Settlement Adjustments:
o ltis important to note that Settlement Adjustments have NO GL-impact. These are created to
show trade spending in the KPIs for specific promotions.
o You decide if you should include or exclude Settlement Adjustments in your analysis.

m Example when to include: You pay some promotional expenses directly to the customer
through NetSuite vendor bills. Each spending adjustment represents spending you want
to analyze along with ;TPM regular settlements.

m  Example when NOT to include: You use the EXPENSE buttons to create journal entries
for some promotional expenses. You created a settlement adjustment so your sales
team can see the spending in the KPIs. You analyze your trade spend through the .TPM
journal entries, so you don’'t want to ‘double count’ these when you add up settlements
and JEs in your workbook analysis..

{qTPM Journal Entries:

e If JEs do not require approval in NetSuite: Deductions associated with these JEs are resolved status.
The workbook can be used to analyze deduction expenses by customer, NetSuite accounting period,
GL-account, and other attributes.

e If you require JEs to be approved: In addition to the above, use the NetSuite workbook to review and
analyze JEs pending approval.

e JEs that are reversed: Typically you will reverse only a few, if any ;TPM JEs. However, it is important to
confirm the deduction associated with reversed ;TPM JEs have the correct open balances and statuses.
Use this workbook information for data validation.

{JTPM Statement Charges:

e /[TPM Statement Charges: The workbook in this section will only contain statement charges created by
{TPM to resolve deductions.

e Open status: These invalid deductions were reinvoiced through a statement charge, but the customer’s
re-payment hasn’'t been applied to the statement charge. The NetSuite workbook can help you identify
which customers need follow-up communication to secure the repayment. If the customer already repaid
the amount, it wasn’t applied correctly to the statement charge.

e Applied status: These invalid deductions have been repaid by the customer. Use this information to
show the value of your team’s effort to recover invalid deduction amounts. You can show what’s been
recovered by customer and by date.
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3.1 iTPM 310 Settlements

Use this NetSuite workbook to analyze two types of ;TPM settlements, those with financial impact resolving open
deduction amounts, and settlement adjustments that only impact promotion KPls.

Helpful hint: If you do NOT use the .TPM promotion planning module, you don’t create .;TPM
promotions. Without ;TPM promotions, there are no .TPM settlements to analyze. Skip ahead to the
next section and analyze .TPM Journal Entries.

Create the DATASET for Settlements (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

New Dataset .
1. Create a new Dataset: . (Name: - iTPM 310 Settlements)

2. Select a Record Type: Transaction

New Dataset

Search for a record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYPES

‘ transaction

Showing 7 Record Types

RECORD TYPE

Transaction Numbering Audit Log
Transaction Audit Trail

Transaction

3. Criteria: TYPE = iTPM Settlement AND STATUS is NONE OF iTPM Settlement: VOIDED AND iTPM Applied
To: Status none of - iTPM Settlement: Voided

~ Criteria summary Show detsils
Type = AND - Status - AND » iTPM Applied To (Transaction): Status » AND - Date
iz Typeis - iTPM Settlement

2r Status none of - ITPM Settlement : Voided, - iTPM Settlement : Voided

AND =
i1 iTPM Applied To (Transaction): Status none of - iTPM Settlement : Voided, - iTPM Settlement : Voided
=z Date on or after start of fiscal year before last
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@ Helpful hint: The 2nd and 3rd criteria in the filter eliminate the voided and voiding settlements
from the result set.

O Helpful hint: To add the third criteria,

e enter “i'TPM Applied to Status” in the search,
e Click “SHOW MORE RESULTS in the lower left corner and wait.
e When you see more results, drag that into the criteria
e Then set “NONE OF’ iTPM Settlement = Voided.
e There are two of these VOIDED Settlement statuses. Add both to the filter.
Settlements @
S ¢ o | B <D
4 Dataset +
iTPM applied to status| X | «
~ Records
No records found.
~ Fields
... iTPM Applied To Transaction  Acknowledgement Status X T
... iTPM Applied To Transaction  Approval Status T
... iTPM Applied To Transaction Billing Status s
... iTPM Applied To Transaction Integration Status KT
... iTPM Applied To Transaction iTPM |E Applied Status KT
... iTPM Applied To Transaction Research Status K T
... iTPM Applied To Transaction Status T
... iTPM Applied To Transaction Status (Customer) T
... iTPM Applied To Transaction Status Code KT
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date

Add fields in this section to your data set: (Note: You'll create Settlement Adjustment in step 5)
Note: You may need to click

Note: Important: Be sure to add “Line Number” to get the lines of the settlement, not just the
transaction total, and use Amount DEBIT instead of iTPM amount. iTPM Amount is the total of
all the lines of the settlement.

to find your measure.

O Helpful hint: Fields in the settlement workbook have many duplicates. The next few pages will
show you ways to search for these fields. To confirm you have the correct field, click on the

information icon next to the field, and confirm you have the field you want by matching
the Field ID in the pop-up box to the one in the table that follows. (After you drag the field to
your worksheet, the field name will be blue.)

Fields o
Reset Criteria
.../ Transaction Accounting Line | Account @
Transaction Account Based Mumber
.../ Assigned To Employes Account Account

Default Account for Corpor...
FIELD ID

./ Controller Employee Account transactionlines.accountingimpact.account
../ Controller Employee Default Account for Corpor...
PROPERTIES
../ Copy Employees Employee Account 696 Hierarchy field
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TRANSACTION ACCOUNTING LINE: ACCOUNT

To add Account.

, search for ‘account line”

E Dataset  _iTpM 310 Settlements (25DF) @ st

() This dataset is used in 3 other Workbooks. Making a change here will affect the:

o c C

account line

“ Records

nsaction Line / Transaction Accounting Line

Transaction Accounting Line
~ Fields

“tion Line /Transaction Accounting Line Account
Transaction Line Accounting Line Type
Transaction Line Expense Account

“tion Line /Transaction Accounting Line Account Type

“fion Line /Transaction Accounting Line Transaction Line
Transaction Accounting Line Accounting Book
Transaction Accounting Line Transaction Accounting Line

Transaction Accounting Line Transaction Line

Q 4

tH H A D
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TRANSACTION LINE: AMOUNT (DEBIT) (TRAMSACTION CURRENCY) . ) .
To add CREDIT: , search “trans line credit

€ Dataset  _jTpM 310 Settlements (2SDF) @ sha

(i) This dataset is used in 3 other Workbooks. Making a change here will affect these

O cCc C
trans line credit Q <«
+ Records
w Fields
Transaction Line Amount (Credit) (Transaction Curr... #
ction Line /Transaction Accounting Lime Amount (Credit) #

TRANSACTION LINE: AMOUMNT (CREDIT) (TRANSACTION CURRENCY)
To add Class: , search for class and use the

(i) information to find the one with the field ID = transactionlines.class

e
+E Dataset | _jTpM 310 Settlements (2SDF) @
(D) This dataset is used in 3 other Workbooks. Making a change here will affect these workbooks.
O ¢ C
line class Q <« ~ Criteria summary Show details
Type + AND » Status = AND = iTPM Applig
~ Records
2 Type is-iTPM Settlement
i1 Status none of - iTPM Settleme
~ Fields AND *
=z iTPM Applied To (Transaction)
Transaction Line Class 0]
B S S—
Class
Field ID
transactionlines.class
PROPERTIES
& Hierarchy field
FIELD LEVEL HELF
Classes are categories that you can create to track recor
and expenses separately for househald and commercial
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To add the company name field, look for this:
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Q « ~ Criteria summary Show details
Type - AND - Status - AND - iTPM Applied To
Transaction 7 Company Name .l
¥ Entity Email X
» Entity Project 3rd Party Billing Accou... Compa ny Name
» Entity Employee 3rd Party Billing Carrier
: FIELD ID
Entity Cust - fai
> En fty Hstomer | 3rd Party Billing Country | custbody_itpm_appliedtortransaction.custbody_itpm_cus |
% Entity Other Name 3rd Party Billing Zip tomer.companyname Ls
» Entity Vendor )
s Accept Trading Par... X = PROPERTIES
Entity Partner
- Account T Text
» Field [Accrual Journal Entry] ... )
» Field [Accruing Transaction] ... Alcohol Reclplent Type FIELD LEVEL HELP
% Field [Bill.com Transaction] ... Alt. Email Enter the legal name of the customer.

" Alt. Phone ol
) [Eperae fouml Enig. ) ) If you use Auto-Generated Numbering, it is important |
» Field [ITPM Deduction] on [- ... Assigned Web Site that you enter the customer's name here, as the
% Eield [ITPM Deduction] on [- ... Balance Customer Name field fills with the number or code for

this record.
» Field [iTPM Deduction] on [- ... Bill.com Customer ... ¥
» Field [iTPM Settlement] on [-... Bill.com Last Updat... ¥ e
» Field [Split Deduction] on [- i. Bill com ShortName % T [ 5/20/2019
Use the table on the next page to add these fields to your settlements workbook:
- iTPM 310 Settlements (2SDF)
1: Debit Amount (Trans C... F
2: Credit Amount (Trans C... 3F
Account GL &
Class &
Date [1]
Document Number/ID T
iTPM AppliedTo A2 K T
iTPM Customer X T
iTPM Item ar ® T
Line Mumber i#
Memo T
Posting Period [1]
Sales Rep T
Settlement Adjustment %, T
Status T
Transaction T
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Field Name | Source Field ID Description (310 Settlements)
1: Amount Transaction -> transactionlines.creditf | The credit is the amount that will reduce the open
(Credit) Transaction Line | oreignamount deduction balance. This amount is posted to the
Open Deduction GL account
2: Amount Transaction -> transactionlines.debitfo | The debit is the amount that is expensed to the
(Debit) Transaction Line | reignamount GL account for the allowance in the promotion.
(Settlement Adjustments have no net GL impact.)
Account GL | Transaction -> transactionlines.accoun | This is the NetSuite GL account in the settlement
Transaction tingimpact.account transactions line. (This is a debit or credit GL
Accounting Line account depending on the line.)
Class Transaction -> transactionlines.class This is the class identified on each transaction
Transaction Line line of the settlement.
Date Transaction trandate Settlement transaction date
Document Transaction tranid NetSuite transaction ID for the settlement
Number/ID
iTPM Transaction custbody_itpm_applied | Settlements can be applied to deductions, or a
Applied To to voiding settlement. Settlement adjustments (no
GL impact) can be applied to nothing or to a
vendor bill.
iTPM Transaction custbody_itpm_custom | This is the NetSuite customer on the settlement.
Customer er (Same as on the deduction, but this can be
different from the customer on the promotion.)
iTPM Item Transaction -> transactionlines.custcol | This is the item on the settlement transaction line.
Transaction Line | _itpm_set_item
Line Transaction -> transactionlines.lineseq | Line number of the settlement. (The “0” line
Number Transaction Line | uencenumber number is the header)
Memo Transaction memo Settlement memo field
Posting Transaction postingperiod NetSuite posting period of the settlement
Period
Sales Rep Customer custbody_itpm_custom | Sales Rep
er.salesrep
Settlement Formula See step 5 If GL-impact, then “Standard” If NO GL-impact,
Adjustment then “Adjustment”
Status Transaction custbody_itpm_applied | This is the settlement status.
->{TPM Applied toMransaction.status
To Transaction
Transaction | Transaction trandisplayname This is the name of the settlement.
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Your fields will turn blue after you drag them into your data set:
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Formulas 1 Date (1
Transaction » > Document Number/ID T
» Transaction Line 5 ,
iTPM Applied To 329 T
» Accrual D
) ) _ iTPM Customer X T
» Accruing Transaction Transaction
» Assigned To Memo T
» Billing Address Posting Period [x]
» Competitors Transaction T
» Controller abbrev. Type T
» Copy Employees
Py Employ Account Based Number T
» Created By & T
Accrual ID
» Created By Customer
» Created By Emplovee Accrual Qualifying A 6% #
Formulas 1 Amount (Credit) (Trans... #
Transaction e Amount (Debit) (Transa... #
# Transaction Line 5
Class &
» Accrual D s g T
iTPM ltem
? Accruing Transaction Transaction H
» Assigned To Line Number #
» Billing Address Accounting Line Type T
» Competitors Actual Ship/Receipt/Pick... [I]
Transaction > Status T
2 iTPM Applied To Transaction 1 Abbrev. Type T
iTPM Created From Transaction
’ Account Based Number T
> ITPM Customer 1
_ accrual 1D X T
» iTPM Deduction Group
S ITPM Promotion Accrual Qualifying A... 9 #
Transaction i Sales Rep T
» iTPM Customer 1 )
Email T
» iTPM Deduction Group
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5. Formulas: Calculate this field: Settlement Adjustment

Formula Field X

FORMULA FIELD NAME*

CHOOSE OUTPUT TYPE*
|SE1LIemenLAd_|uslm » 29 |

5TRING
FORMULA*

Case

when {custbody_itpm_appliedto#display} is Null then "Adjustment’
else 'Standard

end

Copy this text into your formula, and drag the field into your data set:

case

when {custbody_itpm_appliedto#display} is Null then 'Adjustment’
else 'Standard'

end

These fields will turn blue after you drag them into your data set:

Formulas 1 Settlement Adjustment % T
Transaction 7 O
» Transaction Line 5
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3.2 iTPM 320 Expensed by Journal Entry

Use this NetSuite workbook to analyze journal entries created by .TPM to expense open deduction amounts.

Create the DATASET for JEs created by .TPM (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

New Dataset
1. Create a new Dataset: . (Name: - iTPM 320 Expense Journal Entries)

2. Select a record type: Transaction

New Dataset

Search for a record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYFES

transaction

Showing 7 Record Typas

RECORD TYPE

Transaction Numbering Audit Log
Transaction Audit Trail

Transaction

3. Criteria: Type = Journal AND iTPM Applied To is NONE of <NO VALUE> AND Date on or after start of
fiscal year before last

~ Criteria summary Show detsils
Type * AND » iTPM Applied To « AND « Date
iz Type is Journal
AND = iz iTPM Applied To none of <NO VALUE=

1z Date on or after start of fiscal year before last

Note: If you were an .TPM client before 2018.2.5, add a filter to exclude journal entries before
January 1, 2019. If you implemented :TPM after December 2018, then you do not need this filter.
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set.

: Sh Is )
Note: You may need to click to find your measure.

TERAMTACTIOR | IS AR 1T (TER T (TRAMTArTIOM ] IBEEN Y
IANSACTION LINE: AMOUNT [DEBIT) [TRAMSACTION CURRENC

To find the Debit field, search for ‘amount(deb’
amount (deb Q «
~ Records
~ Fields
Transaction Line Amount (Debit) (Transaction Curr... &
Transaction Accounting Line Amount (Debit) #

To find the Credit field, search for ‘amount(cre’

TRANSACTION LINE: ENTITY
To find the Transaction Line: Entity field , search for ‘trans line entity’

(Note: This is not the same as Entity )

. X ACCOUNT: NUMEBER ACCOUNT: FULL MAME ,
To find the Number field, , and Full name , you'll need to look

for fields at Transaction> Transaction Line> Account>

Use the table on the next page to add these fields to your .TPM journal entry workbook:

- iTPM 320 Expense Journal Ent.
1 Debit Amount (Trans Cu...
2 Credit Amount (Trans Cu... 3
Customer Name 5T
Date
Department
Document Number/ID
Entity Customer ov
GL Account Full Name
GL Account Mame

GL Account Type

b
8 H HH P H I H

Is Reversal
Memo
Number
Posting Period
Reazon Code %«
Status

Trans Line Number

H#HHABEAHAH

Transaction
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Field Name

Source

Field ID

Description (320 .TPM Journal
Entries)

1: Debit Amount

Transaction ->
Transaction Line

transactionlines.debitforeign
amount

The debit is the amount that is
expensed to the GL which is
typically the GL account
associated with the deduction’s
reason code.

2: Credit Amount

Transaction ->
Transaction Line

transactionlines.creditforeig
namount

The credit is the amount that will
reduce the open deduction
balance. This amount is posted to
the Open Deduction GL account

Transaction Line

Customer Name Formula See step 5 Customer Name for display in
workbooks

Date Transaction trandate NetSuite transaction date of the
journal entry

Department Transaction -> transactionlines.department | Department on the journal entry

Transaction Line

Document Transaction tranid NetSuite transaction ID for the

Number/ID journal entry

Entity Transaction -> transactionlines.entity Customer on the iTPM journal

entry, same as customer on the
deduction.

GL Account Full
Name

Transaction ->
Transaction
Accounting Line ->
Account

transactionlines.accountingi
mpact.account.fullname

This is the name of the GL account
on the journal entry transaction
lines.

GL Account Name

Transaction ->
Transaction
Accounting Line ->
Account

transactionlines.accountingi
mpact.account.accountsear
chdisplaynamecopy

GL Account Name

GL Account Type Transaction -> transactionlines.accountingi | GL Account Type
Transaction mpact.account.accttype
Accounting Line ->
Account
Is Reversal Transaction isreversal Is this a reversing journal entry? Y
orN
Line Number Transaction -> transactionlines.linesequenc | Line number of the journal entry
Transaction Line enumber (“0” is the journal entry header)
Memo Transaction memo Memo field on the journal entry
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Transaction
Accounting Line ->
Account

mpact.account.acctnumber

Field Name Source Field ID Description (320 .;TPM Journal
Entries)
Number Transaction -> transactionlines.accountingi | This is the NetSuite external

number of the GL account on the
journal entry transaction lines.

Posting Period

Transaction

postingperiod

Journal entry financial posting
period

Reason Code

Transaction ->
iTPM Applied To

custbody_itpm_appliedto?r
ansaction.custbody _itpm_d
dn_reasoncode

Reason Code

Status Transaction status Journal entry status
Transaction Transaction trandisplayname This is the name of the journal
entry
Your fields will turn blue after you drag them into your data set:
Formulas 1 Date [1]
el o Document Number/ID T
# Transaction Line 5
Is Reversal =
» Accrual ID
. : ; Memo T
» Accruing Transaction Transaction
R Posting Period (]
> Billing Address Status T
» Competitors Transaction T
¥ Controller Abbrev. Type T
» Copy Employees
AT Account Based Number T

P

W =

Formulas

L R Y

Transaction
Transaction Line
Accrual 1D
Accruing Transaction Transaction
Aszsigned To
Billing Address

Competitors

1 Amount (Credit) (Trans...
= Amount (Debit) (Transa...
. Department

Entity e

Line Number
Accounting Line Type

Actual Ship/Receipt/Pick...

H
#
&
&
H
T
[
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Formulas 1 Full Name T
Transaction 7 Name T
' Transaction Line 5
Mumber T
w Transaction Accounting Line
Type T
¢ Account 4 yp
% Cost Components 1098-MISC Category T
# Material Overhead Parent lte... Bank MName T
Transaction 7 O Reason Code X T
» iTPM Applied To Transacti... 11
- Abbrev. Type T
» iTPM Created From Transaction
account Based Number T
» iTPM Customer
> iTPM Deduction Group Accrual ID KT

5. Formulas: Customer name - String

Formula Field

FORMULA FIELD NAME* CHOOSE QUTPUT TYPE*
|CI._|5t|:|rr1Er Mame ‘ S5TRING -
FORMULA*

Case

when {type#display} = 'Journal’ THENM

{custbody itpm appliedto”transaction.custbody itpm customer#display}
Else

{custbody_itpm_customer#display]}

End

Wopa

¥ =

o

Copy this into your formula box for Customer Name, and drag the measure to your data set:

Case

when {type#display} = 'Journal' THEN
{custbody_itpm_appliedto*transaction.custbody_itpm_customer#display}
Else

{custbody_itpm_customer#display}

End

These fields will turn blue after you drag them into your data set:

Formulas Customer Name i T

1
Transaction 7 O
» Transaction Line 5
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3.3 iTPM 330 Re-invoiced Deductions (by Statement Charge)

Use this NetSuite workbook to analyze statement charges created by .TPM to recover and reinvoice invalid
deduction amounts.

Create the DATASET for Statement charges created by .TPM (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

1. Create a new Dataset: . (Name: - iTPM 330 Re-invoiced Deductions)

You will save this as: “/TPM Reinvoiced Deductions” or similar name.

2. Select a Record Type: Transaction

New Dataset

Search for a record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYFES

‘ transaction

Showing 7 Record Types

RECORD TYPE

Transaction Numbering Audit Log
Transaction Audit Trail

Transaction

3. Criteria: TYPE = Statement Charge AND iTPM Applied to none of <NO VALUE> AND Posting Period on or
after Fiscal Year Before Last.

w Criteria summary Show details
Type - AND « iTPM Applied To + AND - Posting Period
11 Type is Statement Charge
AND w iz iTPM Applied To none of <NO VALUE=

iz Posting Period on or after Fiscal Year Before Last
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date

Date Q,

+ Records

Field [Deductions to Update] on [- iTPM MonGL MassUpdate Queue]

“+ Fields
Transaction Date [1]
Transaction Actual Production End Date [1]

Use the table on the next page to add these fields to your ;TPM Statement charge workbook:

-iTPM 330 Re-invoiced Deducti..

Date [1]
Document Number/ID T
Entity Customear e

iTPM Applied To e T
Memo T
Posting Period

Sales Rep

Status

Total Amount (Trans Curr...

Transaction

HH#HAABRB

Type
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Field Name Source Field ID Description (330 ;TPM Statement Charges)
Date Transaction trandate NetSuite transaction date
Document Transaction tranid NetSuite transaction ID for the statement
Number/ID charge
Entity Transaction entity This is the customer on the statement
charge. This is the same as the
customer on the deduction.
iTPM Applied To Transaction custbody_itpm_applie | iTPM Applied To
dto
Memo Transaction memo This is the memo field on the statement
charge
Posting Period Transaction postingperiod Posting period of the Statement charge
Sales Rep Customer entity"customer.sales | Sales Rep
rep
Status Transaction status Statement charge status
Total Amount Transaction foreigntotal Total amount of the statement charge
Transaction Transaction trandisplayname Name of the transaction.
Type Transaction type In this workbook, transaction type =
Statement Charge
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Fields will change to blue after you drag them into your data set:

Q «

Formulas Date [x] l
Transaction 10 Document Number/ID T
» Transaction Line Entity 24
» Accrual ID
? Accruing Transaction Transa... ITPM Applied To g % B
» Assigned To Memo T
» Billing Address Posting Period 5
» Competitors Status T
> Controller Total Amount (Transact...
AL Transaction T
» Created By
N roabod D ot e e T}"IJE T
Transaction 0 o Sales Rep T
> Entity Customer 1 Email T

R 3rd Party Billing Account... T

Eotify ot s Bloea s

5. Formulas: None
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Use this NetSuite workbook to analyze deduction resolutions created by ;TPM.

Create the DATASET that includes all resolutions created by ;TPM (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

1. Create a new Dataset: . (Name: - iTPM 340 All iTPM Resolutions)

2. Select a Record Type: Transaction

New Dataset

Search for a record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYFES

transaction

Showing 7 Record Types

RECORD TYPE

Transaction Numbering Audit Log
Transaction Audit Trail

Transaction
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3. Criteria: TYPE = Journal, Statement Charge AND Posting Period on or after Fiscal Year Before Last AND
iTPM Applied to none of <NO VALUE> AND Line Amount (Debit) is not empty

OR

TYPE = iTPM Settlement AND Posting Period on or after Fiscal Year Before Last AND Line Amount (Debit) is
not empty

~ Criteria summary Show details

( Type + AND + Posting Period + AND = iTPM Applied To + AND » Transaction Line: Amount {Debit) (Transaction Curren

11 Type any of Journal, Statement Charge

:: Posting Period on or after Fiscal Year Before Last

AND = i1 iTPM Applied To none of <NO VALUE>
:: Transaction Line: Amount (Debit) (Transaction Currency) (not consclidated) is not empty
OR ~ 6 Drop fields here to add ¢
= Typeis - ITPM Settlement
AND * :: Posting Period on or after Fiscal Year Before Last
:: Transaction Line: Amount (Debit) (Transaction Currency) (not consolidated) is not empty
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set.

Data Fields: Enter each field, find it in the list below, and drag it to your data set.

Example: Date

Date

“ Records

Field [Deductions to Update] on [- iTPM MonGL MassUpdate Queue]

~+ Fields

Transaction

Transaction

Date

Actual Production End Date [1]

Q,

@

Use the table on the next page to add these fields to your .TPM Resolutions workbook:

-iTPM 340 All iTPM Resolution|

All Rights Reserved

Quick Reference Link: Analytics

1: Debit Amount (Trans ... #F Entity for SC e

2: Credit Amount (Trans ... # Is Reversal (JE) a8
Applied-to Doc #/ID T iTPM Applied To T
Created By T iTPM Customer X T
Created By (Hybrid) % T Memo T
Customer (for pivots) f; T Memao (Trans ling) T
Customer (w/o #) 5 T Posting Period [1]
Date [z Reversal Date % (1]
Date Created [f] || status T
Debit Expense (Adj ... fx # || Transaction T
Document Mumber/ID T || Type T
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(Transaction
Currency)

Field Name Source Field ID Description (340 ;TPM Statement
Charges)

1: Debit Amount Transaction transactionlines.debitf | Debit amount of the resolution

(Transaction oreignamount

Currency)

2: Credit Amount Transaction transactionlines.credit | Credit amount of the resolution

foreignamount

Applied-to Doc #/ID

iTPM Applied To

custbody_itpm_applie
dto*transaction.tranid

This is the document # of the applied-to
transaction. It could be the deduction
that's resolved. For a voiding
settlement, it could be the settlement
that's voided.

Created By Transaction createdby Created By

Created By (Hybrid) | Formula See step 5 This is the user that initiated the
creation, even if it was done by a script

Customer (use for Formula See step 5 Customer (use for pivots)

pivots)

Customer (w/o #) Formula See step 5 Customer (w/o #)

Date Transaction trandate NetSuite transaction date

Date created Transaction createddate Date the transaction was created

Debit Expense (Adj | Formula See step 5 Debit Expense of the resolution (Adj for

for voids) voids)

Document Transaction tranid NetSuite transaction ID for the

Number/ID statement charge

Entity for SC Transaction entity This is the customer on the statement
charge. This is the same as the
customer on the deduction.

Is Reversal (JE) Transaction isreversal For Journals, False = the journal, True
= the reversal

iTPM Applied To Transaction custbody_itpm_applie | This is the transaction that's applied to

dto

the resolution.
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Field Name Source Field ID Description (340 ;TPM Statement
Charges)
iTPM Customer Transaction custbody_itpm_custo | iTPM Customer
mer
Memo Transaction memo This is the memo field on the
transaction
Memo (Trans line) Transaction transactionlines.mem | Memo associated with transaction line
o}
Posting Period Transaction postingperiod Posting period of the transaction
Reversal Date Transaction custbody_itpm_acc_f [ This is the date the journal was
areversaldate reversed using the UNDO button on the
iTPM JE.
Status Transaction status Transaction status
Transaction Transaction trandisplayname Name of the transaction.
Type Transaction type In this workbook, transaction type =
Statement Charge, Journal or iTPM
Settlement
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Fields will change to blue after you drag them into your data set:

Q <«
Formulas - Created By ae T
Transaction 14 @ Date 0|
» Transaction Line 3
Date Created [1]
¥ Accrual ID
_ ) Document Number/iD T
» Accruing Transaction Transa...
- b .Y
» Assigned To Entity O«
> Billing Address Is Reversal <
> Competitors iTPM AppliedTo 32K T
» Controller iTPM Customer X T
Copy Employees
. Py Employ Memo T
» Created By o
Posting Period
» Created By Customer 5
» Created By Employes Reversal Date x 1
> Created By Entity Status T
» Created By Partner Transaction T
» Created By Vendor Type T
Formulas 4 Amount (Credit) (Trans... #
Transaction 11 o Amount (Debit) (Transa... &
? Transaction Line 3
Memo T
» Accrual ID -
Accounting Line Type
» Accruing Transaction Transa... £ P
Transaction 14 @ Document Number/ID T
2 iTPM Applied To Transa... [ 1 Abbrev. Type T
» iTPM Created From Transact... Account Based Number T
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5. Formulas:

Formula Field b4

FORMULA FIELD NAME* CHOOSE OUTPUT TYPE?*
‘Debit Expense (Adj for v| FLOAT -
FORMULAZ

1 Case

2 When {type#display} = "- iTPM Settlement’ and {custbody_itpm_wvoiding_settlement} = T Then

3 -1*{transactionlines.debitforeignamount}

- When {type#display} = '- iTPM Settlement' and {custbody_ itpm_wvoiding_settlement} = "F' Then

5

{transactionlines.debitforeignamount}

6 When {type#display} = "Journal' and {custbody itpm acc_fareversaldate} is not NULL Then
7 -1*{transactionlines.debitforeignamount}

8 When {type#display} = "Journal’ and {custbody itpm acc_fareversaldate} is MULL Then

9 {transactionlines.debitforeignamount}
1@ When {type#display} = "Statement Charge' Then
11 -1*{transactionlines.debitforeignamount}
12 End

Copy this into your formula box for 'Debit Expense (Adj for voids)' & drag the measure to your data set:

Case

When {type#display} ='- iTPM Settlement' and {custbody_itpm_voiding_settlement} = 'T' Then
-1*{transactionlines.debitforeignamount}

When {type#display} = '- iTPM Settlement' and {custbody_itpm_voiding_settlement} = 'F' Then
{transactionlines.debitforeignamount}

When {type#display} = 'Journal' and {custbody_itpm_acc_fareversaldate} is not NULL Then
-1*{transactionlines.debitforeignamount}

When {type#display} = 'Journal' and {custbody_itpm_acc_fareversaldate} is NULL Then
{transactionlines.debitforeignamount}

When {type#display} = 'Statement Charge' Then

-1*{transactionlines.debitforeignamount}

End
Formula Field
FORMULA FIELD NAME* CHOOSE OUTPUT TYPE
|Cu5t|:|mE' (for pivots) ‘ STRING
FORMULA*
1 Case
2 When {type#display]} = '- iTPM Settlement’
3 or {type#display} = '- iTPM Deduction’
4 Then
] {custbody_itpm_customer#display}
B When {type#display} = '- iTPM Accrual’
7 Then
8 {custbody_itpm_acc_facustomer.companyname}
] When {type#display} = "Journal®
1@ and NVL({custbody itpm_appliedto”transaction.custbody itpm_custemer#display},’ ") <» " '
hen {custbodv itpm sppliedtottransaction. custbody jtom customers#displav?

Continued on the next page....
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Copy this into your formula box for 'Customer (use for pivots)' and drag the measure to your data set:

Case

When {type#display} = '- iTPM Settlement'

or {type#display} = '- iTPM Deduction'

Then

{custbody_itpm_customer#display}

When {type#display} = - iTPM Accrual'

Then

{custbody_itpm_acc_facustomer.companyname}

When {type#display} = 'Journal’

and NVL({custbody_itpm_appliedto*ransaction.custbody_itpm_customer#display},' ') <> "'
Then {custbody_itpm_appliedto*transaction.custbody_itpm_customer#display}

When {type#display} = 'Journal’

and NVL({custbody_itpm_appliedto*transaction.custbody_itpm_customer.companyname},'') <> "'
Then {custbody_itpm_appliedto*transaction.custbody_itpm_customer.companyname}
When {type#display} = 'Journal' and NVL({entity#display},' ') <>""

Then {entity#display}

When {type#display} = 'Journal' and NVL({transactionlines.entity#display},' ') <>""
Then {transactionlines.entity#display}

When {type#display} = 'Journal'

and NVL({transactionlines.entity#display},' ') <> "'

Then {transactionlines.entity#display}

When {type#display} = 'Statement Charge' Then

{entity#display}

ELSE

{entity#display}

End

FORMULA FIELD NAME* CHOOSE OUTPUT TYPE*

|Cu5tom9f{w.a'o #) ‘ STRING -

FORMULA*

1 Case
2 When {type#display} = "- iTPM Settlement' Then
3 {custbody_itpm customer.companyname}
When {type#display} = 'Journal’' Then
{custbody_itpm appliedto*transaction.custbody_itpm_customer.companyname}

When {type#display} = 'Statement Charge' Then
g {entity~entity.altname}
18 End
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Copy this into your formula box for 'Customer (w/o #)' and drag the measure to your data set:

Case
When {type#display} ='- iTPM Settlement' Then
{custbody_itpm_customer.companyname}

When {type#display} = 'Journal' Then
{custbody_itpm_appliedto*ransaction.custbody_itpm_customer.companyname}

When {type#display} = 'Statement Charge' Then
{entity*entity.altname}
End

FORMULA FIELD NAME* CHOOSE OUTPUT TYPE®*
‘Cfeated By (Hybrid) | STRING
FORMULAZ

1 Case when {custbody itpm createdby#display} is null then

2 {createdby#display}

3 Else

4 {custbody_itpm_createdby#display}

5 End

Copy this into your formula box for 'Created By (Hybrid)' and drag the measure to your data set:

Case when {custbody_itpm_createdby#display} is null then
{createdby#display}

Else

{custbody_itpm_createdby#display}

End

These fields will turn blue after you drag them into your data set:

Formulas 4 Created By (Hybrid) A T

Transaction 1 o Customer (for pivots) % T

» Transaction Line
Customer (w/o #) 5 T

» Accrual ID

Debit Expense (Adj for... £ #

3 Arrrning Trancgrtinm Troncg

© 2025 CG Squared, Inc. www.i-tpm.com Page 63 of 180

All Rights Reserved Quick Reference Link: Analytics



http://www.i-tpm.com/

User Guide: Datasets

i{IPM

NetSuite 2025.1

4.0 .;TPM Promotions

There are three ways to analyze your ;TPM promotions:

e KPIs by promotion
o Data: One record per promotion: One customer, one set of promotion dates, and all the item
details summarized into one total amount for the promotion.
o When to use: You want to analyze just promotion events.

e KPIs by promotion AND item:
o Data: Each KPI record defines a customer, promotion, and one item. If you have multiple
allowances for an item in the same promotion, they will be combined for workbook analysis.
o When to use: Use this workbook when you don’t need to analyze spending by period. Example:
you want to compare all promotions that start and end in 2020.

e KPIs by promotion AND NetSuite Period
o Data: There is a KPI record for a promotion and every NetSuite period that is impacted by the
promotion. Example: An EDLP promotion for Q1 will have KPI records for January, February
and March that add up to the total of the KPI for the entire EDLP event.
o When to use: Use this to analyze your trade spending by NetSuite period.

These ESTIMATED KPIs are useful BEFORE the planning period starts.

e Unless you change estimated quantities, estimated spending is the same value as your
promotion moves from future to active to completed condition. Estimated KPIs are based on
what the user estimated will happen, and represents what was approved.

e Estimated Spend is available in total, and by method of payment (Ol, BB, NB, and LS).
Estimated Quantity is available as promoted units, base and incremental.

Estimated Revenue is only available if your promotions include estimated quantities. Without a
forecasted volume, estimated revenue will be zero.

e Original Estimated Spend stores the estimated spend the first time the promotion is approved.

These additional KPIs are helpful AFTER the planning period starts:

e LE Spend: Latest Estimate is a ‘best guess’ calculation of what the promotion’s total spending
will be when all claims are processed.

e ACTUAL Spend: This is the total of all deductions matched to the promotion. This also includes
Spend Adjustments, which are non-financial settlements used to incorporate non-deduction
transactions into promotional KPIls. Example: A spend adjustment is created for a claim that was
not deducted but paid by check.

e Net Liability: This is Expected Liability minus Actual spending, and represents how much you
owe but hasn’t been deducted or paid yet for a promotion.

e Overpay: This is the amount paid or claimed that is in excess of the Expected Liability for a
promotion. This represents how much the promotion’s spend was under forecasted, and/or how
much the customer claimed that was above :TPM calculated liability for the promotion.

e Go to section 6.3 in the ;TPM Administrator User Guide for more KPI calculation details.

Limitations and Challenges: All of the KPIs have these limitations:
e There can be no KPlIs if the promotion isn’t created in NetSuite
e Only the ESTIMATED KPI is available for promotions that aren’t approved and in DRAFT status.
e UOM conversions for per-unit spending
e If the promotion doesn’'t have an estimated volume, then estimated revenue and estimated
spending for per-unit allowances will be zero.
e Estimated KPIs measures are dependent on the accuracy of the estimated base and lift.
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4.1iTPM 410 Promotion KPlIs

Note: :TPM version 20.1.2 is enhanced to provide more KPI data measures for NetSuite workbooks
based on the promotion. Only promotions that have the KPIs refreshed in 20.1.2 will have these new
KPI fields available in this workbook. New or updated fields include Actual Revenue, Estimated
Revenue, and Overpay.

Use these NetSuite workbooks to analyze and roll-up promotion KPIs:
Create the DATASET to analyze KPIs by promotion (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

New Dataset
1. Create a new Dataset: . (Name: “-iTPM 410 Promotion KPIs")

2. Record Type: - iTPM Promotion

New Dataset
Search for a record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYPES

iTPM pro X

Showing 6 Record Types

RECORD TYPE

- iTPM Promotion

- iTPM Promotion Activity

3. Criteria: iTPM Promotion: Status is none of Rejected, Voided AND

Inactive is false AND Ship date - Start on or after start of fiscal year before last

~ Criteria summary =how detzils
Status » AND - Inactive - AND - Ship date - Start
21 Status none of Rejected, Voided

AND = == Inactive is false

iz Ship date - Start on or after start of fiscal year before last
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date

Date Q <«

+w Records

Field [Promotions] on [- iTPM Promo Status Update Queueg]

~ Fields
- iTPM Promotion Ship date - End N
- iTPM Promotion Ship date - Start N

. 5h Its )
Note: You may need to click to find your measure.

Use the table on the next page to add these fields to your promotion KPIs worksheet:
(Note: You'll create additional measures in step 5)

=-iTPM 410 Promotion KPIs (25...

1: Estimated Spend % #

2: LE Spend X H#

3: Actual Spend <§=$ H

4: Expected Liability ﬁ H#

5: Net Liability X H#

6: Overpay % #

Actual Revenue (if li.. 9 #

Condition X T

Customer ﬁﬁ T Promaotion # ‘3‘:5 H#
Deal in days 5 H# Promotion Name /T.. ¢ T
Est Inc Revenue X # Promotion Type X T
Est Revenue X # Sales Rep T
Estimated Spend fx H# Ship date - End x [
Estimated Spend as % £ # Ship date - Start N
Owner X T Status X T
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Field Name

Source

Field ID

Description (410 Promotion KPls)

1: Estimated Spend

- iTPM Promotion

custrecord_itpm_p_sve
stimatedspend

Estimated spending includes lump-sum,
bill-back, off-invoice and net-bill
allowances

2: LE Spend

- iTPM Promotion

custrecord_itpm_p_svl
espend

Latest Estimate (LE) includes
lump-sum, bill-back, off-invoice and
net-bill allowances

3: Actual Spend

- iTPM Promotion

custrecord_itpm_p_svp
rmtionalactualspend

Actual spending includes lump-sum,

bill-back, off-invoice and net-bill
allowances

4: Stored Expected
Liability

- iTPM Promotion

custrecord_itpm_p_sve
xpliabilitypromo

Expected liability includes lump-sum,
bill-back, off-invoice and net-bill
allowances

5: Net Liability

- iTPM Promotion

custrecord_itpm_p_svn
etpromotionalle

Net Liability includes lump-sum,
bill-back, off-invoice and net-bill
allowances

6: Stored Overpay :

- iTPM Promotion

custrecord_itpm_p_svp
romtionaloverpayamt

Overpay includes lump-sum, bill-back,
off-invoice and net-bill allowances

Actual Revenue (if
linked to Sales)

- iTPM Promotion

custrecord_itpm_p_sva
ctualrevenue

Actual Revenue (if linked to Sales)

Company Name

- iTPM Promotion

custrecord_itpm_p_cus

Customer Name on the promotion

tomer.companyname getting the allowances

Condition - iTPM Promotion custrecord_itpm_p_con | Promotion condition. This is either
dition Future, Active or Completed.

Customer - iTPM Promotion custrecord_itpm_p_cus | Customer on the promotion getting the
tomer allowances

Deal in Days Formula See step 5 Deal in Days

Estimated Revenue

- iTPM Promotion

custrecord_itpm_p_sve
stimatedrevenue

This is the estimated revenue of the
promotion for the promoted units: list
price times estimated quantity

Estimated spend Formula See step 5 Estimated spending, which is a total of
lump-sum, bill-back, off-invoice and
net-bill allowances

Estimated Spend as | Formula See step 5 Estimated Spending as a percent of

% Estimated Revenue.

Owner - iTPM Promotion owner Owner of promotion
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Field Name Source Field ID Description (Promotion KPIs)
Promotion - iTPM Promotion name Promotion title / reference code
Name/Title

Promotion # - iTPM Promotion id This is the promotion number, same as

the external ID.

Promotion Type

- iTPM Promotion

custrecord_itpm_p_typ

e

Promotion type

Ship Date - End

- iTPM Promotion

custrecord_itpm_p_shi

End ship date of the promotion

pend

Ship Date - Start - iTPM Promotion custrecord_itpm_p_shi [ Start ship date of the promotion
pstart

Sales Rep - iTPM Promotion custrecord_itpm_p_cus | Sales Rep
tomer.salesrep

Status - iTPM Promotion custrecord_itpm_p_stat | Promotion status. Draft, Submitted,

us Approved, and Closed. (Voided and
Rejected are filtered out of the data
set.)
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Fields will change blue when you drag them to your data set:

Q <«
Formulas 3 Condition XT
- iTPM Promotion 18 Customer X T
T Internal ID X H#
» Allocation Type
» Condition Name RT
» Copied From Owner RT
Y Customer Promotion Type X T
» Field [Copied From] on [- iTP... ship date - End % [1
» Field [iTPM Promotion] on [- ... Ship date - Start & M
» Field [iTPM Promotion] on [- ... Status KT
¥ Field [iTPM Promotion] on [- ...
» Field [iTPM Promaotion] on [- ... Stored Actual Reve... & #
> Field [TPM Promotion] on [- .. [ Stored Actual spen... 5% #
Y Field [ITPM Promotion] on [- .. l| Stored Estimated In... ¥ #
> Field [ITPMc Promotion] on [... @ Stored Estimated R... 9§ #
» Field [Promotion / Deal] on [-... Stored Estimated s... 6 #
» Field [Promotion / Deal] on [-... Stored Expected Lia...‘% #
¥ Field [Promotion name#] on ...
» Field [Promotion] on [- iTFM ... Stored LESpend : P... &% #
> Field [Promotion on [-ITPM ..  Stored Net Liability .. % #
} Field [Promotion] on [-iTPM ..  Stored Overpay:Pr... X #
-1TPM Promotion 12 @ Company Mame T
» Customer 2 sales Rep T
» Field [Copied From] on [- iTP... Email T
L% Eigld TP Peamatinn] oo [ '
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5. Formulas:

Formula Field X

FORMULA FIELD NAME* CHOOSE QOUTPUT TYPE*
|Estirnated 5pend| X 35 | FLOAT
FORMULA*

{custrecord_itpm_p_svestimatedspendbb}+{custrecord_itprm_p_svestimatedspend|s}+
{custrecord_itpm_p_svestimatedspendnb}+{custrecord_itpm_p_svestimatedspendoi}

Copy this into your formula box for Estimated Spend, and drag the measure to your data set:

{custrecord_itpm_p_svestimatedspendbb}+{custrecord_itpm_p_svestimatedspendis}+
{custrecord_itpm_p_svestimatedspendnb}+{custrecord_itpm_p_svestimatedspendoi}

FORMULA FIELD NAME* CHOOSE OUTPUT TYPE*

Estimated Spend 25 % ‘ ‘FLOP.T - ‘

FORMULA*

1 CASE ( {custrecord_itpm p svestimatedrevenue}/1.8) WHEN 8.2

2 THEN @.@

ELSE

({custrecord_itpm_p svestimatedspendbbl}+{custrecord_itpm p svestimatedspendls}
+{custrecord_itpm p svestimatedspendnb}+{custrecord itpm_p svestimatedspendoi})
/{custrecord_itpm_p_svestimatedrevenue}

END

o

Copy this into your formula box for the Estimated Spend as % measure, and drag the measure to your data set:

CASE ( {custrecord_itpm_p_svestimatedrevenue}/1.0) WHEN 0.0

THEN 0.0

ELSE
({custrecord_itpm_p_svestimatedspendbb}+{custrecord_itpm_p_svestimatedspendis}
+{custrecord_itpm_p_svestimatedspendnb}+{custrecord_itpm_p_svestimatedspendoi})
Hcustrecord_itpm_p_svestimatedrevenue}

END

Formula Field b4
FORMULA HIEELD NAME* CHOOSE OUTPUT TYPE*
‘Deal in days | FLOAT -
FORMULA*

1 {custrecord_itpm_p shipend}-{custrecord_itpm_p_shipstart}
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Copy this into your formula box for the Deal in days measure, and drag the measure to your data set:

({custrecord_itpm_p_shipend}-{custrecord_itpm_p_shipstart})+1

These fields will turn blue after you drag them into your data set:

Formulas 3 Deal in days

- iTPM Promotion 18 O Estimated Spend

»  Account

*

Estimated Spend as %
» Allocation Type
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4.2 iTPM 420 Promotion KPIs by Item

Note: .TPM version 20.1.2 is enhanced to provide more KPl data measures, and measures by
NetSuite period. Some of the following data may not be available if your account is not yet updated to
({TPM version 20.1.2.

Use these NetSuite workbooks to analyze and roll-up promotion KPIs:
Create the DATASET to analyze KPIs by promotion AND item (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

New Dataset
1. Create a new Dataset: . (Name: - iTPM 420 Promotion KPIs by Item)

2. Select a Record Type: - iTPM KPIs (Search for KPI)

New Dataset

Search for a record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYPES

| e X

Showing 3 Record Types
RECORD TYPE
- iTPM KPI Queue
- iTPM KPI Queue Detail

- iTPM KPIs

3. Criteria: iTPM Promotion: Status is none of Rejected, Voided AND Inactive is false AND Ship date - Start
on or after start of fiscal year before last

~ Criteria summary Show detsils
iTPM Promotion: Status - AND = Inactive = AND « iTPM Promotion: Ship date - Start
i1 iTPM Promotion: Status none of Rejected, Voided
AND = :: Inactive is false

iz iTPM Promotion: Ship date - Start on or after start of fiscal year before last
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set.

UOM: Search for Units Type, and drag it into your data set.

. Sh ls )
Note: You may need to click to find your measure.

Date Q «

+ Records

Field [Promotions] on [- iTPM Promo Status Update Queueg]

~ Fields
- iTPM Promation Ship date - End N
- iTPM Promotion Ship date - Start * [
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Use the table on the next page to add these fields to your promotion KPI by Promotion and Item workbook:
(Note: You'll create many Formulas in step 5)
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-iTPM 420 Promotion KPIs by I...

1: Estimated Spendi... 5 #

2: LE Spend i #

3: Actual Spending % # Est Spend Total 4 Pr... $¢ #
4: Expected Liability % # Item o T
5: Net Liability £ # Item Class 2
6: Overpay 5 H# Item Description X T
Actual Qty X H# KPI record Name X T
Actual Revenue X # Owner X T
Base Price H# Price Level X T
Company Name T Primary Units Type T
Condition X T Promoted Qty X H#
Customer X T Promotion # K #
Est Base Quantity % H# Promotion Mame / ... ‘% T
Est COGS $ i # Promation Type X T
Est Inc Quantity X # Ship date - End % 11
Est Revenue 5 # Ship date - Start % [1]
Est Spend as % 5 # Status X T
EstSpendas % (2)  Jfx # UoM T
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Field Name Source Field ID Description (420 Promotions by item)
1: Estimated Formula See step 5 Estimated spending, which is a total of
Spending lump-sum, bill-back, off-invoice and
net-bill allowances
2: LE Spend Formula See step 5 LE spend includes lump-sum, bill-back,
off-invoice and net-bill allowances
3: Actual Spending | Formula See step 5 Actual spending includes lump-sum,
bill-back, off-invoice and net-bill
allowances
4: Expected Liability | Formula See step 5 Expected liability includes lump-sum,
bill-back, off-invoice and net-bill
allowances
5: Net Liability Formula See step 5 Net Liability includes lump-sum,
bill-back, off-invoice and net-bill
allowances
6: Overpay Formula See step 5 Overpay includes lump-sum, bill-back,
off-invoice and net-bill allowances
Actual Qty -iTPM KPlIs custrecord_itpm_kpi_a | This is actual shipments in units
ctualtotalqty between the start and end ship dates.
Actual Revenue -iTPM KPlIs custrecord_itpm_kpi_a | This is actual sales in dollars between
ctualrevenue the start and end ship dates.
efbaseprice
Company Name -iTPM KPlIs -> custrecord_itpm_kpi_pr | This is the full customer name.
iTPM Promotion - omotiondeal.custrecord
iTPM Promotion _itpm_p_customer.com
panyname
Condition -iTPM KPlIs -> custrecord_itpm_kpi_pr | Promotion condition. This is either
iTPM Promotion - omotiondeal.custrecord | Future, Active or Completed.
iTPM Promotion _itpm_p_condition
Customer -iTPM KPlIs -> custrecord_itpm_kpi_pr | Customer on the promotion getting the
iTPM Promotion - omotiondeal.custrecord | allowances
iTPM Promotion _itpm_p_customer
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Field Name

Source

Field ID

Description (420 Promotions by item)

Estimated Base

-iTPM KPIs / Item /

custrecord_itpm_kpi_it

This is the estimated base in units (See

add formula.)

Quantity Field [ltem] on [- em?item.custrecord_itp | Units Type)
iTPM Estimated m_estqty_item<custom
Quantity] record_itpm_estquantit
y.custrecord_itpm_estq
ty_baseqty
Est COGS $ Formula See step 5 Est COGS $
Est COGS % Formula See step 5 (Need to Est COGS % (Not yet in iTPM Demo)

Est Inc Quantity

-iTPM KPIs / Item /
Field [Item] on [-
iTPM Estimated

custrecord_itpm_kpi_it
em?item.custrecord_itp
m_estqty_item<custom

This is the estimated incremental
quantity for this item in units (see Units

Type)

Quantity] record_itpm_estquantit
y.custrecord_itpm_estq
ty_incrementalqty

Est Profit $ Formula See step 5 (Need to Est Profit $ (Not yet in iTPM Demo)

add formula.)

Est Revenue Formula See step 5 This is the estimated revenue, which is
the NetSuite price times the total
estimated units in the promotion (see
Units Type)

Est Spend as % Formula See step 5 Est Spend as % based on KPls

Est Spend as % (2) | Formula See step 5 Est Spend as % (2) based on

promotion

Est Spend Total 4

- iTPM Promotion

custrecord_itpm_kpi_pr

Stored Estimated Revenue

em?item.class

Promotion omotiondeal.custrecord
_itpm_p_svestimateds
pend

ltem -iTPM KPlIs custrecord_itpm_kpi_it | NetSuite item in the promotion
em

Item Class - iTPM KPIs -> Item | custrecord_itpm_kpi_it | This is the Class of the item.

Item Description

- iTPM KPIs

custrecord_itpm_kpi_it
emdescription

Description of the NetSuite item in the
promotion

KPI Record Name - iTPM Promotion Name Promotion title / reference code
Owner - iTPM Promotion owner Owner of promotion
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Field Name

Source

Field ID

Description (420 Promotions by item)

Price Level

-iTPM KPlIs ->
iTPM Promotion

custrecord_itpm_kpi_pr
omotiondeal.custrecord
_itpm_p_itempricelevel

Price Level

Primary Units Type

- iTPM KPIs -> Item

custrecord_itpm_kpi_ite
mAitem.unitstype

UOM on the KPI item records

iTPM Promotion -
iTPM Promotion

omotiondeal.custrecord
_itom_p_type

Promoted Qty -iTPM KPlIs custrecord_itpm_kpi_es | Promoted quantity is in units, and is
ttotalqty equal to (base plus incremental units),
multiplied by the percent redemption
rate. These are the units that are
expected to qualify for the discounts.
Promotion # - iTPM KPIs custrecord_itpm_kpi_pr | This is the iTPM promotion number
omotiondeal.id
Promotion -iTPM KPlIs custrecord_itpm_kpi_pr | Promotion Name/Title
Name/Title omotiondeal
Promotion Type -iTPM KPlIs -> custrecord_itpm_kpi_pr | Promotion type

Ship date - End

-iTPM KPls ->
iTPM Promotion -
iTPM Promotion

custrecord_itpm_Kkpi_pr
omotiondeal.custrecord
_itpm_p_shipend

End ship date of the promotion

Ship date - Start

-iTPM KPls ->
iTPM Promotion -
iTPM Promotion

custrecord_itpm_Kkpi_pr
omotiondeal.custrecord
_itpm_p_shipstart

Start ship date of the promotion

om.unitname

Status -iTPM KPIs -> custrecord_itpm_kpi_pr | Promotion status. Draft, Submitted,
iTPM Promotion - omotiondeal.custrecord | Approved, and Closed. (Voided and
iTPM Promotion _itpm_p_status Rejected are filtered out of the data set.

UoOM - iTPM KPIs custrecord_itpm_kpi_u | UOM Name on the KPI records

Helpful hint: iTPM KPI fields with “Stored” in the name are values for the entire promotion, and should
be considered a promotion ‘header’ value. If you use these values, you either need to use only one

unique record from the promotion, or select “average” to show the value.

Example: A promotion has 3 items with $100 in total Estimated spending. Estimated spending field for
all three KPI records will total $100, but the Stored Estimated Spending field will total $300, with an
average of $100.
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Fields will change blue when you drag them to your dataset:

Formulas 100 Actual Qty X #

- iTPM KPIs 7" @ Actual Revenue X #
Field [Related Kpi] on [- iTPM ltem ...

’ [ pilent ltemn e T
» Item 2

Iltem Description

» iTPM Promotion 10 P % T

» Last modified by Contact iTPM Promotion XT

> Last modified by Customer Name X T

» Last modified by Employee Promoted Qty \‘% H

» Last modified by Entity Abbreviation K T
» Last modified by Generic Resource

y Actual COGS N H

Formulas 10 Class 5?3,

Il ling 7 P primary Units Type T

» Field [Related Kpi] on [- iTPM Item ...

Alternate Source Item 3% T

All Rights Reserved
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+ ltem 2
e 4u Pmortization Period #H#
Formulas 10 cCondition X T
- ITPM KPls T customer X T
» Field [Related Kpi] on [- iTPM Item Period Sh... Internal ID % #
> ltem 2
(#]
» iTPM Promotion 10 wner % T
¥ Last modified by Contact Price Level XT
» Last madified by Customer Promotion Type XT
» Last madified by Employee Ship date - End < 1
» Last modified by Entity Ship date - Start % M
Last dified by G ic R
> modified by Generic Resource Status & T
» Last modified by Group .
N 1 oot mndifigd b Oidhgr Blomng Stored Estimated S... % #
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Formulas 10 Name T
- ITPM KPls 7" @  pbbreviation T
» Field [Related Kpil on [- iTPM Item ... Base Unit 3
> ltem 2
y iTPM Promotion 10 Conversion Rate (/base) H#
» Last modified by Contact internal ID #
¥ Last modified by Customer Plural Abbreviation T
» Last modified by Employes Plural Name T
» Last modified by Entity Units Type T
» Last modified by Generic Resource Used 3
» Last modified by Group
» Last modified by Other Name
» Last modified by Partner
» Last modified by Project Template
» Last modified by Project
» Last modified by Resource Group
» Last modified by Vendor
> Owner
# Planning ID
> UOM 1
5. Formulas:

Copy this into your formula box for the 1: Estimated Spending measure, and drag the measure to your data set:
Output type = FLOAT

{custrecord_itpm_kpi_estimatedspendbb}+
{custrecord_itpm_kpi_estimatedspendIs}+
{custrecord_itpm_kpi_estimatedspendnb}+
{custrecord_itpm_kpi_estimatedspendoi}

Copy this into your formula box for the 2: LE Spend measure, and drag the measure to your data set:
Output type = FLOAT

{custrecord_itpm_kpi_lespendbb}+
{custrecord_itpm_kpi_lespendIis}+
{custrecord_itpm_kpi_lespendnb}+
{custrecord_itpm_kpi_lespendoi}
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Copy this into your formula box for the 3: Actual Spending measure, and drag the measure to your data set:
Output type = FLOAT

{custrecord_itpm_kpi_actualspendis}+
{custrecord_itpm_kpi_actualspendbb}+
{custrecord_itpm_kpi_actualspendoi}+
{custrecord_itpm_kpi_actualspendnb}

Copy this into your formula box for the 4: Expected Liability measure, and drag the measure to your data set:
Output type = FLOAT

{custrecord_itpm_kpi_expectedliabilitybb}+
{custrecord_itpm_kpi_expectedliabilityls}+
{custrecord_itpm_kpi_expectedliabilitynb}+
{custrecord_itpm_kpi_expectedliabilityoi}

Copy this into your formula box for the 5: Net Liability measure, and drag the measure to your data set: Output
type = FLOAT

{custrecord_itpm_kpi_netliabilitybb}+
{custrecord_itpm_kpi_netliabilityls}+
{custrecord_itpm_kpi_netliabilitynb}+
{custrecord_itpm_kpi_netliabilityoi}

Copy this into your formula box for the 6: Overpay: Promotion measure, and drag the measure to your data set:
Output type = FLOAT

{custrecord_itpm_kpi_overpaybb}+
{custrecord_itpm_kpi_overpayls}+
{custrecord_itpm_kpi_overpaynb}+
{custrecord_itpm_kpi_overpayoi}

Copy this into your formula box for the Est COGS $ measure, and drag the measure to your data set: Output type
= FLOAT

TO_number({custrecord_itpm_kpi_item”item.costestimate})

Copy this into your formula box for the Estimated Revenue measure, and drag the measure to your data set:
Output type = FLOAT

NVL(TO_NUMBER({custrecord_itpm_kpi_estimatedrevenue}),0.00)
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Copy this into your formula box for the Estimated Spend as % measure, and drag the measure to your data set:

CASE ({custrecord_itpm_kpi_estimatedrevenue}/1.0) WHEN 0.0

THEN 0.0

ELSE

( ({custrecord_itpm_kpi_estimatedspendIs}+
{custrecord_itpm_kpi_estimatedspendbb}+

{custrecord_itpm_kpi_estimatedspendnb}+

{custrecord_itpm_kpi_estimatedspendoi} )/ {custrecord_itpm_kpi_estimatedrevenue} )
END

Copy this into your formula box for the Estimated Spend as % (2) measure, and drag the measure to your data

set:

CASE ( {custrecord_itpm_kpi_promotiondeal.custrecord_itpm_p_svestimatedrevenue} /1.0) WHEN
0.0

THEN 0.0

ELSE

(' ({custrecord_itpm_kpi_estimatedspendIs}+

{custrecord_itpm_kpi_estimatedspendbb}+

{custrecord_itpm_kpi_estimatedspendnb}+

{custrecord_itpm_kpi_estimatedspendoi} ) /
{custrecord_itpm_kpi_promotiondeal.custrecord_itpm_p_svestimatedrevenue} )

END

Note: Need to add formulas for Est COGS %, Profit $

Note: Suite Analytics in NetSuite 2020.1 does not have the option to show a weighted average.
The above formulas will show an average of the transactions, which is NOT the same as how Excel
would calculate this measure.
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Your Formulas will change to blue when you drag them to your data set:

Formulas 10 1:Estimated Spending fx #
- ITPM KPIs 7 @ 5 LEspend f H#
» Field [Related Kpil on [- iTPM If... 3: Actual Spending £ #
» Item 2
y TTPM Promotion — Expected Liability £ #
» Last modified by Contact 5: Net Liability i #
> Last modified by Customer 6: Qverpay A H
> Last madified by Employee Est COGS $ i #
» Last modified by Entity Est Spend as % £ #
» Last modified by Generic Reso... Est Spend as % (2) £ #
» Last modified by Group
S | et et s s e Estimated Revenue £ #
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4.3 iTPM 430 Promotion Period Share (by NetSuite Period)

Note: .TPM version 20.1.2 is enhanced to provide more KPI data measures, and measures by
NetSuite period. Promotions by NetSuite Period may not be available if your account is not yet
updated to :;TPM version 20.1.2.

Create the DATASET to analyze KPIs by promotion AND NetSuite period (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

Mew Dataset
1. Create a new Dataset: . (Name: “-iTPM 430 Promotion Period Share”)

2. Select Record Type: - iTPM Promotion Period Share

New Dataset
Search for a record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYPES

Period

Showing 3 Record Types
RECORD TYPE
- iTPM Promotion Period Share

Accounting Period

3. Criteria: iTPM Promotion: Status is none of Rejected, Voided AND Inactive is false AND Ship date - Start
on or after start of fiscal year before last

~ Criteria summary Show details

—

Promotion: Status « AND + Inactive » AND » Promotion: Ship date - Start
i1 Promotion: Status none of Rejected, Voided
AND = 2 Inactive is false

:: Promotion: Ship date - Start on or after start of fiscal year before last
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date

Date Q «

+ Records

Field [Promotions] on [- iTPM Promao Status Update Queue]

»~ Fields
- iTPM Pramation Ship date - End N
- iTPM Promotion Ship date - Start N

: Sh Is )
Note: You may need to click to find your measure.

Use the table on the next page to add these fields to your worksheet:

-iTPM 430 Promeotion Period J
1: ESTIMATED SPEND 9 #
2: LE SPEND X H#

3:ACTUAL SPEND & #

4: EXPECTED LIABILI... 9 # || Month Start Date

5 MET LIABILITY % H Month Start Date (Q...

6: OVERPAY % # || Month Start Date (Y...
Actual Revenue 9% # || owner

Condition 4 T || Posting Period
Customer 4 T || Promotion #

Estimated Base Qua.. 9¢ # || Promotion Title / Na...
Estimated Incremen... 9§ # || Promation Type
Estimated Incremen... 9% # || Sales Rep

Estimated Incremen... 9§ # || Ship date - End

Estimated Revenue (.. 9 # || Ship date - Start

RNARARN RNARARRAD >R
HEBBHAAA®AAAAH

KPI record name % T || Status
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Example KPIs by NetSuite period, by customer and by promotion. (Over 50 available)

Field Name Source Field ID Description
430 iTPM Period Share
1: Estimated iTPM Promotion | custrecord_itpm_ps_str | This is the amount of the Estimated Spend
Spend Period Share destspndmop_pr_ps that's been allocated to this period
2: LE Spend iTPM Promotion | custrecord_itpm_ps st | This is the amount of the LE Spend that's

Period Share

oredlespnd_prom_tot

been allocated to this period

3: Actual Spend

iTPM Promotion
Period Share

custrecord_itpm_ps_str
dactspnd_prom_ps

This is the amount of the Actual Spend
that's been allocated to this period

4: Expected iTPM Promotion | custrecord_itpm_ps_str | This is the amount of the Expected Liability

Liability Period Share dexptdliblt_pr ps that's been allocated to this period

5: Net Liability iTPM Promotion | custrecord_itpm_ps_st | This is the amount of the Net Liability that's
Period Share ordnetliablt_pr_ps been allocated to this period

6: Overpay iTPM Promotion | custrecord_itpm_ps_st | This is the amount of the overpay that's

Period Share

oredoverpay_pr_ps

been allocated to this period

Actual Revenue
(Period Share)

iTPM Promotion
Period Share

custrecord_itpm_ps_ac
tualrev_total

This is the amount of the Actual Revenue
that's been allocated to this period

Amount

Condition iTPM Promotion | custrecord_itpm_ps pr | Condition
omotion.custrecord_itp
m_p_condition

Customer iTPM Promotion | custrecord_itpm_ps pr | Customer

omotion.custrecord_itp
m_p_customer

Estimated Base

iTPM Promotion

custrecord_itpm_ps_str

This is the amount of the Estimated Base

Quantity (Period | Period Share destbaseqntity_tot Quantity that's been allocated to this period
Share) Stored

Estimated iTPM Promotion | custrecord_itpm_ps_str | This is the amount of the Incremental
Incremental Period Share destdincrecogs_ps COGS that's been allocated to this period
COGS (Period

Share) Stored
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Revenue (Period
Share) Stored

Field Name Source Field ID Description

430 iTPM Period Share
Estimated iTPM Promotion | custrecord_itpm_ps_str | This is the amount of the Incremental
Incremental Period Share destdincremtrev_ps Revenue that's been allocated to this

period

(Period Share)
Stored

Estimated iTPM Promotion | custrecord_itpm_ps_str | This is the amount of the Estimated
Incremental Period Share destincreqntity_ps Incremental Quantity that's been allocated
Quantity (Period to this period

Share) Stored

Estimated iTPM Promotion | custrecord itpm_ps_str | This is the amount of the Estimated
Revenue: Period Share destdrev_ps Revenue that's been allocated to this

period

KPI record name

iTPM Promotion
Period Share

name

This is the name of the KPI record, which
includes the promotion #, period and year.

Month Start Date

iTPM Promotion
Period Share

custrecord_itpm_ps_m
onth_start_date

Date on which period starts

omotion.owner

Month Start Date | Formula See step 5 Year in which period starts.
(Year)

Month Start Date | Formula See step 5 Quarter in which period starts.
(Quarter)

Owner iTPM Promotion | custrecord_itpm_ps _pr | Owner

Posting Period

iTPM Promotion
Period Share

custrecord_itpm_ps_i_
postingperiod

This is the NetSuite period of this record's
data

Promotion # iTPM Promotion | custrecord_itpm_ps_pr | This is the Title/Reference Code of the
omotion.id promotion.

Promotion iTPM Promotion | custrecord_itpm_ps_pr | This is the Title/Reference Code of the

Title/Name omotion promotion.

Promotion Type

iTPM Promotion

custrecord_itpm_ps_pr
omotion.custrecord _itp

m_p_type

Promotion Type

Sales Rep

iTPM Promotion

custrecord_itpm_ps_pr
omotion.custrecord_itp
m_p_customer.salesre

p

Sales Rep
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Field Name

Source

Field ID

Description
430 iTPM Period Share

Ship-Date Start

iTPM Promotion

custrecord_itpm_ps_pr
omotion.custrecord_itp
m_p_shipstart

Ship-Date Start

Ship-Date End

iTPM Promotion

custrecord_itpm_ps_pr
omotion.custrecord_itp

Ship-Date End

m_p_shipend
Status iTPM Promotion | custrecord_itpm_ps pr | Status
omotion.custrecord_itp
m_p_status
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The fields will change to blue after you drag them into your dataset:

Formulas 2 Actual Revenue Per... ¢ #
- iTPM Promotion Period Sh... (160 @, 4 Spend: Prom... X #
Last modified by Contact
4 modimed Dy Larts Estimated Base Qu... 9% #
» Last modified by Customer
Estimated I
» Last modified by Employee stimated Increme... ¥ #
% Last modified by Entity Estimated Increme... $¢ #
» Last modified by Generic Resource Estimated Increme... 9 #
» Last modified by Group Estimated Revenue ... 5¢ #
» Last modified by Other Name Estimated Spend: P... §¢ #
Last modified by Partner
> modinied by Fartne Expected Liability: ... $¢ #
> Last modified by Project Template
LES d:P tio...
» Last modified by Project pend: Promotio... 3% #
» Last modified by Resource Group Month Start Date x o
» Last modified by Vendor Name X T
¥ Owner Met Liability: Ol (Pe... % H#
> Posting Period Overpay: Ol (Period... $¥ #
P ti 8
 BETTETE Posting Period X T
Promotion X T
- iTPM Promotion Per... 16 @ Condition X T
» Promotion g Custamer % T
A t
szl Internal ID X #
» Allocation Type
Owner T
> Condition =
> Copied From Promotion Type X T
Y Customer 1 Ship date - End N
> Field [Copied From] on [-iT... @ Ship date - Start % [T
» Field [iTPM Promotion] on [... Status X T
- iTPM Promotion Per... 16 @ Sales Rep T
» Customer
Email T
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5. Formulas: Your Formulas will change to blue when you drag them to your data set.

Copy this into your formula box for the Month Start Date (Quarter) measure, and drag the measure to your data
set: Output type = STRING

CASE WHEN EXTRACT(MONTH FROM {custrecord_itpm_ps_month_start_date}) BETWEEN 1 and 3
THEN 'Q1'

WHEN EXTRACT(MONTH FROM {custrecord_itpm_ps_month_start_date}) BETWEEN 4 and 6
THEN 'Q2'

WHEN EXTRACT(MONTH FROM {custrecord_itpm_ps_month_start_date}) BETWEEN 7 and 9
THEN 'Q3'

WHEN EXTRACT(MONTH FROM {custrecord_itpm_ps_month_start_date}) BETWEEN 10 and 12
THEN 'Q4'

ELSE " END

Copy this into your formula box for the Month Start Date (Year) measure, and drag the measure to your data
set: Output type = STRING

TO_CHAR(EXTRACT(YEAR FROM {custrecord_itpm_ps_month_start_date}))

The fields will change to blue after you add them into your dataset:

Formulas 2 Month Start Date (Qu... f;; T

- ITPM Promotion Peri... 16 O Month Start Date (Year}) %5 T

» Last modified by Contact
2 _Last modified by Customer
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4.4 iTPM 440 Promotion KPIs by Item and Period (by NetSuite Period)

Note: .TPM version 20.1.2 and newer is enhanced to provide more KPI data measures, and measures
by NetSuite period. Promotions by NetSuite Period may not be available if your account is not yet
updated to .TPM version 20.1.2 and configured to calculate KPIs by period.

Create the DATASET to analyze KPIs by promotion AND NetSuite period (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

Mew Dataset
1. Create a new Dataset: . Name: “-ITPM 440 Promotion KPIs by Item & Period”

2. Select Record Type: - iTPM Item Period Share

New Dataset

Search for a record type that indudes fields that you would like to show in your dataset.

SEARCH RECORD TYPES

Pericdl *

Showing 3 Record Types
RECORD TYPE
Accounting Peried
- [TPM Item Period Shars

- iTPM Promation Period Share

3. Criteria: iTPM Promotion: Status is none of Rejected, Voided AND Inactive is false AND Ship date - Start on
or after start of fiscal year before last

~ Criteria summary Show details
Promotion: Status + AND = Inactive = AND = Promotion: Ship date - Start
i1 Promotion: Status none of Rejected, Voided

AND = == Inactive is false

=2 Promotion: Ship date - Start on or after start of fiscal year before last
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date

Date Q <«

w Records

Field [Promotions] on [- iTPM Promo Status Update Queue]

~ Fields
- iTPM Promaotion Ship date - End % [1
- iTPM Promotion Ship date - Start % [1

Sh Its
Note: You may need to click

to find your measure.

Use the table on the next page to add these fields to your worksheet:

- iTPM 440 Promotion KPIs by| | Est inc Quantity K # P11 Est Incr Revenue S #

1: Estimated Spend % # || Est Inc Revenue % #|| P11 Estimated Spend i H#

2: LE Spend K #|| Est promoted Quant.. §¢ #|| P12 EstIncr Revenue I #

3: Actual Spend X #|| est revenue % #|| P12Estimated Spend A #

4: Expected Liability 9 # || gstimated ROI % #|| P2EstincrRevenue A #

5: Net Liability % # || estimated Total Qua... 4% # || P2Estimated Spend % # 8 Estimated Spend % #
6. Overpay & #/| item 5% % T|(| P3EstincrRevenue H # P9 Est Incr Revenue £y, #
actual Inc Quantity 9% # || 1tem Class & || P3Estimated Spend S # Po Estimated Spend S #
Actual Inc Revenue %X # || Month start Date [7]|| P4EstincrRevenue A #|| ooriog Name T
Actual Quantity % #|| Month start Date (Q.. % T|| PAEstimatedspend  fi #|| ooioqecortthisy A T
Actual Revenue % # || Month Start Date (v.. £, T || PSEstincrRevenue  Fx #|[ pociing periog 5 T
Actual Revenue Total 4% # || Name 9% T'|| PSEstimated Spend % #|| promotion # X #
Actual ROI K #|| owner 4¢ T|| PeEstincrRevenue A #|| promotion kPl Period 4 T
Company Name T || p1EstincrRevenue % #f|| PeEstimated Spend A #|| promotion Title / Na.. % T
Customer % T || p1Estimated spend S5 ##|| P7 Estincr Revenue Fx #|| promotion Type X T
Customer for Pivots T || P10 EstIncr Revenue  f;, # || P7 Estimated Spend % #|| sales Rep T
Est Base Quantity % # || P10 Estimated spend £ #|| PBEstincrRevenue A #|| Status X T
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Field Name

Source

Field ID

Description:
440 iTPM Item & Period Share
Dataset

1: Estimated Spend

-iTPM ltem Period
Share

custrecord_itpm_ps_i_sume
stdspnd_tot

This is the amount of the
Estimated Spend that's been
allocated to this period & item.

2: LE Spend

-iTPM Item Period
Share

custrecord_itpm_ps_i_latste
stdspnd_tot

This is the amount of the Latest
Estimate that's been allocated to
this period & item.

3: Actual Spend

-iTPM ltem Period
Share

custrecord_itpm_ps_i_totactl
spnd_tot

This is the amount of the Actual
Spend that's been allocated to
this period & item.

4: Expected Liability

-iTPM Item Period
Share

custrecord_itpm_ps_i_exptd|
iability_tot

This is the amount of the
Expected Liability that's been
allocated to this period & item.

5: Net Liability

-iTPM Item Period
Share

custrecord_itpm_ps_i_netlia
bilty_tot

This is the amount of the Net
Liability that's been allocated to
this period & item.

6: Overpay: Total

-iTPM ltem Period
Share

custrecord_itpm_ps_i_overp
ay_tot

This is the amount of the
Overpay that's been allocated to
this period & item.

Actual Inc Quantity

-iTPM ltem Period
Share

custrecord_itpm_ps_i_actlin
cre_qty

Actual Inc Quantity

Actual Inc Revenue

-iTPM ltem Period
Share

custrecord_itpm_ps_i_actlin
cre_rev

Actual Inc Revenue

Actual Revenue

-iTPM ltem Period
Share

custrecord_itpm_ps_i_actl_r
ev

Actual Revenue

Actual Revenue
Total

-iTPM Item Period
Share

custrecord_itpm_ps_i_actl_r
ev_total

Actual Revenue Total

Actual Quantity

-iTPM ltem Period
Share

custrecord_itpm_ps_i_actl_q
ty

This is the amount of the Actual
Quantity that's been allocated to
this period & item.

Actual ROI - iTPM Item Period custrecord_itpm_ps_i_actl_r | This is the Actual ROI for the
Share oi promotion.
Customer - iTPM Item Period custrecord_itpm_ps_i_custo | This is the promotion customer

Share

mer
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Field Name Source Field ID Description:
440 iTPM Item & Period Share
Dataset

Customer for Pivots | Formula See step 5 Customer for Pivots

Est Base Quantity

-iTPM ltem Period
Share

custrecord_itpm_ps_i_estdb
aseqty

This is the amount of the
Estimated Base Quantity that's
been allocated to this period &
item.

Estimated Inc
Revenue

-iTPM Item Period
Share

custrecord_itpm_ps_i_estdin
cre_rev

Estimated Incremental Revenue

Est Promoted
Quantity

-iTPM ltem Period
Share

custrecord_itpm_ps_i_prom
o_qty

Estimated Promoted Quantity

Est Revenue

-iTPM Item Period
Share

custrecord_itpm_ps_i_estre
v_tot

Estimated Revenue

Estimated
Incremental Quantity

-iTPM Item Period
Share

custrecord_itpm_ps_i_estdin
cre_qty

This is the amount of the
Estimated Incremental Quantity
that's been allocated to this
period & item.

Estimated ROI

-iTPM ltem Period
Share

custrecord_itpm_ps_i_estd
roi

This is the Estimated ROI for the
promotion.

Estimated Total

-iTPM ltem Period

custrecord_itpm_ps_i_estdq

This is the amount of the

Share

Quantity Share ty_tot Estimated total Quantity that's
been allocated to this period &
item.

ltem -iTPM Item Period custrecord_itpm_ps_i_item This is the amount of the ? that's

Share been allocated to this period &
item.

Item Class ltem custrecord_itpm_ps_i_item?i | ltem Class

tem.class

Month Start Date Period custrecord_itpm_ps_i_postin | Month Start Date

gperiod.startdate

Month Start Date Formula See step 5 Year in which period starts.

(Year)

Month Start Date Formula See step 5 Quarter in which period starts.

(Quarter)

Name - iTPM Item Period custrecord_itpm_ps_i_name | This is the name of the KPI

record, which includes the
promotion #, period, year, item.
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Field Name Source Field ID Description: 440 iTPM Item &
Period Share Dataset
Owner Promotion custrecord_itpm_ps_i_prom | This is the owner of the
otion.owner promotion
Period Name Period custrecord_itpm_ps_i_postin | This is the NetSuite period
gperiod.periodname
Periods (Sort this) Formula See step 5 Periods for sorting
Posting Period FormuLa See step 5 Posting Period
P1 Est Incr Revenue | Formula See step 5 P1 Est Incr Revenue
P2 Est Incr Revenue | Formula See step 5 P2 Est Incr Revenue
P3 Est Incr Revenue | Formula See step 5 P3 Est Incr Revenue
P4 Est Incr Revenue | Formula See step 5 P4 Est Incr Revenue
P5 Est Incr Revenue | Formula See step 5 P5 Est Incr Revenue
P6 Est Incr Revenue | Formula See step 5 P6 Est Incr Revenue
P7 Est Incr Revenue | Formula See step 5 P7 Est Incr Revenue
P8 Est Incr Revenue | Formula See step 5 P8 Est Incr Revenue
P9 Est Incr Revenue | Formula See step 5 P9 Est Incr Revenue
P10 Est Incr Formula See step 5 P10 Est Incr Revenue
Revenue
P11 Est Incr Formula See step 5 P11 Est Incr Revenue
Revenue
P12 Est Incr Formula See step 5 P12 Est Incr Revenue
Revenue
P1 Estimated Spend | Formula See step 5 P1 Estimated Spend
P2 Estimated Spend | Formula See step 5 P2 Estimated Spend
P3 Estimated Spend | Formula See step 5 P3 Estimated Spend
P4 Estimated Spend | Formula See step 5 P4 Estimated Spend
P5 Estimated Spend | Formula See step 5 P5 Estimated Spend
P6 Estimated Spend | Formula See step 5 P6 Estimated Spend
P7 Estimated Spend | Formula See step 5 P7 Estimated Spend
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P8 Estimated Spend | Formula See step 5 P8 Estimated Spend
Field Name Source Field ID Description: 440 iTPM ltem &
Period Share Dataset

P9 Estimated Spend | Formula See step 5 P9 Estimated Spend

P10 Estimated Formula See step 5 P10 Estimated Spend

Spend

P11 Estimated Formula See step 5 P11 Estimated Spend

Spend

P12 Estimated Formula See step 5 P12 Estimated Spend

Spend

Promotion # Promotion custrecord_itpm_ps_i_prom | Promotion #
otion.id

Promotion KPI - iTPM Item Period custrecord_itpm_ps_i_postin | Promotion KPI Period

Period Share gperiod

Promotion Name / -iTPM Item Period custrecord_itpm_ps_i_prom | This is the Title/Reference Code

Title Share otion of the promotion.

Promotion Type Promotion custrecord_itpm_ps_i_prom | Promotion Type
otion.custrecord_itpm_p_typ
e

Sales Rep Customer custrecord_itpm_ps_i_custo | Sales Rep
mer.salesrep

Status Promotion custrecord_itpm_ps_i_prom | Status
otion.custrecord_itpm_p_sta
tus
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The fields will change to blue after you drag them into your data set:

Formulas

17 Actual Incremental __. "% &

- iTPM ltem Period Share

» Customer

- iTPM ltem Period Share 28, tual Incremental .. X #
- SEETE Actual Quantity ‘é% #
¥ Item
¥ Last modified by Contact Actual Revenue ® #
¥ Last modified by Customer Actual Revenue Total 5 #
% Lszt modified by Employes Actual RO x® #
¥ Last modified by Entity Actual Spend :Total '(g H#
¥ Last modified by Generic Resource Customer % T
» Lastmadified by Group Estimated Base Qu.. 9 ##
» Last modified by Other Mame
> Last modified by Partner Estimated Increme... % #
} Last modified by Froject Template Estimated Increme.. % #
¥ Last modified by Froject Estimated Promote.. % H#
» Last modified by Resource Group Estimated Revenue ___ % E- 4
# Last modified by Vendor Estimated ROI % #
» Ommer Estimated Spend T... ‘& #
¥ Period
5 Planming ID Estimated Total Qu... % B
3 Prometion Expected Liability -T... 9 3
3 Related Kpi Itemn B2k T
¥ uom Latest Estimated Sp... 9 #

Name "% T

Met Liability Total 9% #

Owerpay Total 9% f#

Period % T

Promotion % T

Formulas 17 Company Name T

- iTPM Item Period Share 24 coles Rep T

» Customer Ermail T
Formulas 17 Class &

24 plternate Source Item 3% T

Amortization Period H#
» Item
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Formulas 17 Period Name T
- iTPM Item Period Share 24 cio it Date 7]
SIS A/P Locked =
» ltem -
A/R Locked
» Last modified by Contact ocke ©
» Last modified by Customer All Locked <
» Last modified by Employee Allow Non-G/L Changes a
» Last modified by Entity Closed S
# Last modified by Generic Resource Date Closed 7]
Last modified by G
> modified by Group End Date 7]
» Last modified by Other Name
) Inactive -
» Last modified by Partner
» Last modified by Project Template Internal ID #
? Last modified by Project Is Posting 2
2 Last modified by Resource Group Last Modified Date [1]
» Last modified by Vendor Period is a Quarter @
Ow
’ ner Period is a Year >
» Period _
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L . . R L L L . . . . L . L

Formulas 17
- iTPM Item Period Share

Customer

Itemn

Last modified by Contact

Last modified by Customer

Last modified by Employee

Last modified by Entity

Last modified by Generic Resource

Last modified by Group

Last modified by Other Name

Last modified by Partner

Last modified by Project Template

Last modified by Project

Last modified by Resource Group

Last modified by Vendor

Owner

Period

Planning ID

Promotion

Internal ID
Owner
Fromotion Type
Status
Abbreviation
Account

All ltern Promotion

All items get this dis...

Allocation Contributi...

Allocation Type
Condition

Copied From

Copy all allowances, ...

Copy In Progress?
Created
Customer

Day count since co...

RNARARRARRARRRRRRRRR

#+ A s % 4 H A s oo e dHd A H 3
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5. Formulas:
Formula Field »
FORMULA FIELD NAME* CHOOSE OUTPUT TYPE*
‘Customer for Pivots ‘ STRING -
FORMULAF

1 {custrecord_itpm_ps_i_customer.companyname }

Copy this into your formula box for the Customer for Pivots measure, and drag the measure to your data set:
Output type = STRING

{custrecord_itpm_ps_i_customer.companyname}

Formula Field

FORMULA FIELD NAME* CHOOSE QUTPUT TYPE*
|Month Start Date {Quar‘t9|| STRING -
FORMULA*

1 CASE WHEN EXTRACT(MONTH FROM {custrecord_itpm_ps_i postingperiod.startdate}) BETWEEN 1 and 3
2 THEN "Q1°

3 WHEN EXTRACT (MONTH FROM {custrecord_itpm ps i postingperiod.startdate}) BETWEEN 4 and &

- THEN "Q2°

5 WHEN EXTRACT(MONTH FROM {custrecord_itpm_ps_i_ postingperiod.startdate}) BETWEEN 7 and 9

] THEN "Q3°

7 WHEN EXTRACT (MONTH FROM {custrecord_itpm ps i postingperiod.startdate}) BETWEEN 12 and 12

% THEN 'Q4'

9 ELSE "' END

Copy this into your formula box for the Month Start Date (Quarter) measure, and drag the measure to your data
set: Output type = STRING

CASE WHEN EXTRACT(MONTH FROM {custrecord_itpm_ps_i_postingperiod.startdate}) BETWEEN
1and 3
THEN 'Q1'
WHEN EXTRACT(MONTH FROM {custrecord_itpm_ps_i_postingperiod.startdate}) BETWEEN 4 and 6
THEN 'Q2'
WHEN EXTRACT(MONTH FROM {custrecord_itpm_ps_i_postingperiod.startdate}) BETWEEN 7 and 9
THEN 'Q3'
WHEN EXTRACT(MONTH FROM {custrecord_itpm_ps_i postingperiod.startdate}) BETWEEN 10 and
12
THEN 'Q4'
ELSE " END
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FORMULA FIELD NAME* CHOOSE OUTPUT TYPE*
|Month Start Date (Year) ‘ STRING -
FORMULA*

1 TO CHAR(EXTRACT(YEAR FROM {custrecord itpm ps i postingperiod.startdate}))

Copy this into your formula box for the Month Start Date (Year) measure, and drag the measure to your data
set: Output type = STRING

TO_CHAR(EXTRACT(YEAR FROM {custrecord_itpm_ps_i postingperiod.startdate}))

Formula Field

FORMULA FIELD NAME* CHOOQSE QUTPUT TYPE*
‘P1 Est Incr Revenue ‘ FLOAT -
FORMULA*

1 CASE WHEN SUBSTR({custrecord_itpm_ps_i_postingperiod#display},1,3) = "Jan’
2 and INSTR({custrecord_itpm_ps i postingperiod#display},TO_CHAR(current_date, "¥¥Y¥')) <> @
then
{custrecord_itpm_ps i estdincre_rev}
ELSE
a.e9
END

wf oW s

Copy this into your formula box for the P1 Est Incr Revenue measure, and drag the measure to your data set:
Output type = STRING. Repeat similar formulas for P2 Est Incr Revenue through P12 Est Incr Revenue.

CASE WHEN SUBSTR({custrecord_itpm_ps_i_postingperiod#display},1,3) = 'Jan’
and INSTR({custrecord_itpm_ps_i_postingperiod#display},TO_CHAR(current_date,'YYYY")) <> 0
then
{custrecord_itpm_ps_i_estdincre_rev}
ELSE
0.00
END
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Copy this into your formula box for the P1 Estimated Spend measure, and drag the measure to your data set:
Output type = STRING. Repeat similar formulas for P2 Estimated Spend through P12 Estimated Spend.

and

<>0
then

ELSE
0.00
END

{custrecord_itpm_ps_i_estdincre_rev}

CASE WHEN SUBSTR({custrecord_itpm_ps_i_postingperiod#display},1,3) = 'Jan’

INSTR({custrecord_itpm_ps_i_postingperiod#display}, TO_CHAR(current_date,'YYYY"))

Note: Some roles do not have access to use the period date. Unlike the posting period, this is a date and it sorts
better in workbooks. You can also expand it to include year, quarter and months.

FORMULA FIELD NAME*

‘ Periods (sort thisi

631‘

FORMULA*

Case

L B e

when
when
when
when
when
when
when
when
when
when

oo

=
Do o oo

{custrecord_itpm ps i postingperiod#display}
{custrecord_itpm ps i postingperiod#display}

{custrecord_itpm_ps_i postingperiod#display} =

{custrecord_itpm_ps_i_ postingperiod#display}
{custrecord_itpm ps i postingperiod#display}
{custrecord_itpm ps i postingperiod#display}

{custrecord_itpm_ps_i postingperiod#display} =
{custrecord_itpm_ps_i postingperiod#display} =

{custrecord_itpm_ps_i postingperiod#display}
{custrecord_itpm ps i postingperiod#display}

"Jan
"Feb
"Mar
"Apr
'May
"Jun
"Jul
'Aug
'Sep
"Oct

2827
2827°
2827
2827°
2827
2827
2827
2827
2827
2827

then
then
then
then
then
then
then
then
then
then

CHOOSE QUTPUT TYPE*

STRING -

‘2827
‘2827
‘2827
‘20827
‘2827
‘2827
‘2827
‘2827
‘2827
‘2827

a1
a2
a3
a4
as
a6
a7
a8
a9
18

Jan’
Feb’
Mar'
Apr'
May'
Jun’
Jul’
Aug
Sep’
Oct’
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Case

when {custrecord_itpm_ps_i_postingperiod#display} = 'Jan 2025' then '2025 01 Jan'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Feb 2025' then '2025 02 Feb'
when {custrecord_itpm_ps_i postingperiod#display} = 'Mar 2025' then '2025 03 Mar'
when {custrecord_itpm_ps_i postingperiod#display} = 'Apr 2025' then '2025 04 Apr'
when {custrecord_itpm_ps i postingperiod#display} = 'May 2025' then '2025 05 May'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Jun 2025' then '2025 06 Jun'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Jul 2025' then '2025 07 Jul'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Aug 2025' then '2025 08 Aug'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Sep 2025' then '2025 09 Sep'
when {custrecord_itpm_ps_i postingperiod#display} = 'Oct 2025' then 2025 10 Oct'
when {custrecord_itpm_ps_i postingperiod#display} = 'Nov 2025' then '2025 11 Nov'
when {custrecord_itpm_ps_i postingperiod#display} = 'Dec 2025' then '2025 12 Dec'

when {custrecord_itpm_ps_i_postingperiod#display} = 'Jan 2024' then '2024 01 Jan'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Feb 2024' then '2024 02 Feb'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Mar 2024' then '2024 03 Mar'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Apr 2024' then '2024 04 Apr'
when {custrecord_itpm_ps_i_postingperiod#display} = 'May 2024' then '2024 05 May'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Jun 2024' then '2024 06 Jun'
when {custrecord_itpm_ps_i postingperiod#display} = 'Jul 2024' then '2024 07 Jul'
when {custrecord_itpm_ps i postingperiod#display} = 'Aug 2024' then '2024 08 Aug'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Sep 2024' then '2024 09 Sep'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Oct 2024' then '2024 10 Oct'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Nov 2024' then '2024 11 Nov'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Dec 2024' then '2024 12 Dec'

when {custrecord_itpm_ps_i_postingperiod#display} = 'Jan 2023' then '2023 01 Jan3'
when {custrecord_itpm_ps_i postingperiod#display} = 'Feb 2023' then '2023 02 Feb'
when {custrecord_itpm_ps_i postingperiod#display} = 'Mar 2023' then '2023 03 Mar3'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Apr 2023 then '2023 04 Apr'
when {custrecord_itpm_ps_i_postingperiod#display} = 'May 2023' then '2023 05 May'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Jun 2023' then 2023 06 Jun'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Jul 2023' then '2023 07 Jul'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Aug 2023' then '2023 08 Aug'
when {custrecord_itpm_ps_i postingperiod#display} = 'Sep 2023' then '2023 09 Sep'
when {custrecord_itpm_ps_i postingperiod#display} = 'Oct 2023' then '2023 10 Oct'
when {custrecord_itpm_ps_i postingperiod#display} = 'Nov 2023' then '2023 11 Nov'
when {custrecord_itpm_ps_i_postingperiod#display} = 'Dec 2023’ then '2023 12 Dec'

END
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FORMULA FIELD NAME* CHOOSE OUTPUT TYPE*
| Posting Period | STRING -
FORMULAF

1 {custrecord_itpm_ps_i_ postingperiod#display]

Copy this into your formula box for the Posting Period measure, and drag the measure to your data set: Output
type = STRING

{custrecord_itpm_ps_i_postingperiod#display}

The fields will change to blue after you drag them into your data set:

Formulas 17 cCustomer for Pivots £ T

-iTPM Itemn Period Share 24 \ionth Start Date (Qu... _f; T
) Customer Month Start Date (Year) i T
> Item
> Last modified by Contact P1 Est Incr Revenue i #
> Last modified by Customer P10 Est Incr Revenue  f #
» Last modified by Employee P11 Est Incr Revenue % #
» Last modified by Entity P12 Est Incr Revenue  f5, #
? Last modified by Generic Resource P2 Est Incr Revenue £ #
- sl el S P3 Est Incr Revenue i #
» Last modified by Other Name
» Last modified by Partner P4 EstIncr Revenue A #
> Last modified by Project Template PS5 Estincr Revenue i #
> Last modified by Project P6 Est Incr Revenue A H#
» Last modified by Resource Group F7 Est Incr Revenue .f';; H#
» Last modified by Vendor P8 Est Incr Revenue £ #
- ST P9 Est Incr Revenue i #
> Period
> Planning ID Periods (sort this) i T
% Promotion Posting Period 5 T
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4.5 ;TPM 450 Off-Invoice Allowances

Use this workbook to find sales orders, invoices and/or RMAs where .TPM applied discounts.

Create the DATASET to analyze off-invoice allowances applied to invoices (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

1. Create a new Dataset: . (Name: “-iTPM 450 Off-Invoice Allowances”)

2. Select a Record Type: - iTPM Discount Log

New Dataset

Search for 2 record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYPES

disc| X

showing 2 Record Types
RECORD TYPE
- iTPM Discount Log

- iTPM Discount Log Lines

3. Criteria: INACTIVE is false AND iTPM Discount Applied is true AND Created on or after start of fiscal
year before last

~ Criteria summary Show detsils
Inactive » AND » Transaction: iTPM Discounts Applied » AND » Created
21 Inactive is false
AND = :: Transaction: iTPM Discounts Applied is true

iz Created on or after start of fiscal year before last
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date

Enter each field, find it in the list below, and drag it to your data set. Example: Date

Date Q «

+ Records

Field [Promotions] on [- iTPM Promo Status Update Queueg]

~ Fields
- iTPM Promation Ship date - End N
- iTPM Promotion Ship date - Start * [

Show more results

Note: You may need to click _ to find your measure.

Show more results

Note: You may need to click to find your measure.
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Use the table on the next page to add these fields: (Note: You'll create Discount $ in step 5)

- iTPM 450 Off-Invoice Allowan

Allowance X T

Allowance (Rate -4 ... 9 #

Allowance % X H#

Allowance MOP X T

Allowance Rate X H#

Allowance Type & T || orderdate-End % [T
Allowance UOM & T || Orderdate-start X [1]
Condition X T Owner X T
Created % I Price Level X T
Customer 4 T || Promotion # X #
Date [1] Promotion Name /T... 9§ T
Discount $ £ H# Promotion Status X T
Discount Line Name... 95 T || Promotion Type X T
Internal ID % # || Shipdate-End N
Itemn na T || Shipdate - Start % [1]
iTPM Discounts Appl.. §¢ @ || Transaction ae X T
Line Amount % H# Transaction Mumber T
Line Quantity % # Transaction Status T
Line Rate & H Transaction Type T
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Lines] - iTPM Discount
Log Lines

rd_itpm_sline_allrate_4
dec

Field Name Source Field ID Description Page 1 of 4
550 Off-invoice allowances
Allowance Transaction -> Field custrecord_itpm_sline_| | This is the external ID of the iTPM
[iTPM Log] on og<customrecord_itpm_ | allowance record that’s being applied to
[- iTPM Discount Log discountlogline.custreco | the sales order, invoice or RMA. Use
Lines] -iTPM Discount | rd_itpm_sline_allowanc | this link to view the allowance.
Log Lines e
Allowance Transaction -> Field custrecord_itpm_sline_| | For clients using iTPM Connector, this
(Rate - 4 [iTPM Log] on og<customrecord_itpm__ | field will be populated with an
digits) [- iTPM Discount Log discountlogline.custreco | allowance rate to four digits of

precision.

Allowance %

Transaction -> Field
[iTPM Log] on

[- iTPM Discount Log
Lines] - iTPM Discount
Log Lines

custrecord_itpm_sline_|

og<customrecord_itpm_
discountlogline.custreco
rd_itpm_sline_allpercen

t

If the allowance is a percent discount,
this is the actual percentage rate.

[- iITPM Discount Log
Lines] - iTPM Discount
Log Lines

discountlogline.custreco
rd_itpm_sline_allunit

Allowance Transaction -> Field custrecord_itpm_sline_| | This is the method-of-payment that was
MOP [iTPM Log] on og<customrecord_itpm_ | applied to the sales order invoice or
[- iTPM Discount Log discountlogline.custreco | RMA.
Lines] -iTPM Discount | rd_itpm_sline_allmop Off-invoice will be applied by NetSuite
Log Lines discount code. Net Bill and Fixed price
will change the item’s price.
Allowance Transaction -> Field custrecord_itpm_sline_| | This is the iTPM allowance rate. (Two
Rate [iTPM Log] on og<customrecord_itpm_ | digit precision)
[- iTPM Discount Log discountlogline.custreco
Lines] - iTPM Discount | rd_itpm_sline_allrate
Log Lines
Allowance Transaction -> Field custrecord_itpm_sline_| | Type of allowance on each line on the
Type [iTPM Log] on og<customrecord_itpm_ | sales order, invoice or RMA. This will
[- iTPM Discount Log discountlogline.custreco | be either Rate Per UOM or %
Lines] -iTPM Discount | rd_itpm_sline_alltype Discount.
Log Lines
Allowance Transaction -> Field custrecord_itpm_sline | | Allowance UOM
UOM [iTPM Log] on og<customrecord_itpm_
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Discount Log

mount

Field Name Source Field ID Description Page 2 of 4
550 Off-invoice allowances
Condition Transaction -> Field custrecord_itpm_sline_log< | Condition
[iTPM Log] on customrecord_itpm_discoun
[- iTPM Discount Log tlogline.custrecord_itpm_sli
Lines] - iTPM Discount | ne_allpromotion.custrecord
Log Lines _itpm_p_condition
Created Transaction -> - iTPM created Date the discount log was created
Discount Log
Customer Transaction -> - iTPM custrecord_itpm_slog_custo | Customer on the sales order, invoice,
Discount Log mer or RMA
Date Transaction custrecord_itpm_slog_trans | This is the NetSuite transaction date
actionransaction.trandate | of the sales order, invoice or RMA.
Discount $ Formula See step 5 This is the total amount of off-invoice
discounts applied to sales orders.
Discount Line Transaction -> - iTPM name This is the name of the iTPM discount
Name Discount Log log record.
Internal ID Transaction -> - iTPM id This is the NetSuite internal ID of the
Discount Log discount log record.
ltem Transaction -> - iTPM custrecord_itpm_slog_lineit | NetSuite item on the sales order,
Discount Log em invoice or RMA.
iTPM Transaction custrecord_itpm_slog_trans | Was this discount applied to the sales
Discounts action*ransaction.custbody | order, invoice or RMA? This is true /
Applied _itpm_discounts_applied false. Your workbook will only
analyze records where this value is
TRUE.
Line Amount Transaction -> - iTPM custrecord_itpm_slog_linea | This is the total amount of discount

that was applied to one line on the
sales order, invoice or RMA.

Line Quantity

Transaction -> - iTPM
Discount Log

custrecord_itpm_slog_lineq
uantity

This is the quantity on the line of the
sales order, invoice or RMA.

[- iTPM Discount Log
Lines] - iTPM Discount
Log Lines/Promotion

tlogline.custrecord_itpm_sli
ne_allpromotion.custrecord
_itpm_p_orderstart

Line Rate Transaction -> - iTPM custrecord_itpm_slog_linera | This is the item’s price on the sales
Discount Log te order, invoice or RMA BEFORE iTPM
discounts are applied.
Order date - Transaction -> Field custrecord_itpm_sline_log< | Order date - Start
Start [iTPM Log] on customrecord_itpm_discoun

© 2025 CG Squared, Inc.

All Rights Reserved

www.i-tpm.com

Quick Reference Link: Analytics

Page 108 of 180



http://www.i-tpm.com/

i{IPM

User Guide: Datasets

NetSuite 2025.1

Field Name Source Field ID Description Page 3 of 4
550 Off-invoice allowances

Order date - Transaction -> Field custrecord_itpm_sline_log< | Order date - End
End [iTPM Log] on customrecord_itpm_discoun

[- iITPM Discount Log tlogline.custrecord_itpm_sli

Lines] - iTPM Discount | ne_allpromotion.custrecord

Log Lines/Promotion _itpm_p_orderend
Owner - iTPM Discount Log / custrecord_itpm_sline_log<

Field [iTPM Log] on [- customrecord_itpm_discoun

iTPM Discount Log tlogline.custrecord_itpm_sli

Lines] / Promotion ne_allpromotion.owner
Price Level Transaction -> Field custrecord_itpm_sline_log<

[iTPM Log] on customrecord_itpm_discoun

[- iTPM Discount Log tlogline.custrecord_itpm_sli

Lines] - iTPM Discount | ne_allpromotion.custrecord

Log Lines/Promotion _itpm_p_itempricelevel
Promotion # Transaction -> Field custrecord_itpm_sline_log< | Promotion #

[iTPM Log] on customrecord_itpm_discoun

[- iTPM Discount Log tlogline.custrecord_itpm_sli

Lines] - iTPM Discount | ne_allpromotion.id

Log Lines/Promotion
Promotion Transaction -> Field custrecord_itpm_sline_log< | Promotion Name/Title
Name/Title [iTPM Log] on customrecord_itpm_discoun

[- iTPM Discount Log tlogline.custrecord_itpm_sli

Lines] - iTPM Discount | ne_allpromotion

Log Lines/Promotion
Promotion - iTPM Discount Log / custrecord_itpm_sline_log< | Promotion Status
Status Field [iTPM Log] on [- customrecord_itpm_discoun

iTPM Discount Log tlogline.custrecord_itpm_sli

Lines] / Promotion ne_allpromotion.custrecord

_itpm_p_status

Promotion Transaction -> Field custrecord_itpm_sline_log< | Promotion Type
Type [iTPM Log] on customrecord_itpm_discoun

[- iITPM Discount Log tlogline.custrecord_itpm_sli

Lines] - iTPM Discount | ne_allpromotion.custrecord

Log Lines/Promotion _itpm_p_type
Ship date - Transaction -> Field custrecord_itpm_sline_log< | Ship date - Start
Start [iTPM Log] on customrecord_itpm_discoun

[- iITPM Discount Log
Lines] - iTPM Discount
Log Lines/Promotion

tlogline.custrecord_itpm_sli
ne_allpromotion.custrecord
_itpm_p_shipend
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Field Name

Source

Field ID

Description Page 4 of 4
550 Off-invoice allowances

Ship date - End

Transaction -> Field
[iTPM Log] on

[- iITPM Discount Log
Lines] - iTPM Discount
Log Lines/Promotion

custrecord_itpm_sline_log<
customrecord_itpm_discoun
tlogline.custrecord_itpm_sli

ne_allpromotion.custrecord

_itpm_p_shipend

Ship date - End

Transaction Transaction -> - iTPM custrecord_itpm_slog_trans | This is the name of the NetSuite
Discount Log action sales order, invoice or RMA
transaction.
Transaction Transaction custrecord_itpm_slog_trans | Transaction number of the sales
Number action*ransaction.transacti | order, invoice or RMA.
onnumber
Transaction Transaction custrecord_itpm_slog_trans | Transaction Status
Status actionransaction.status
Type Transaction custrecord_itpm_slog_trans | Transaction type. This will be a sales

action*transaction.type

order, invoice or RMA.

© 2025 CG Squared, Inc.

All Rights Reserved

www.i-tpm.com

Quick Reference Link: Analytics

Page 110 of 180



http://www.i-tpm.com/

i{IPM

User Guide: Datasets

NetSuite 2025.1

Your fields will change to blue after you drag them into your data set:

Formulas Created ‘ﬁ [x]
- iTPM Discount Log Customer % T
o AT Internal ID X #
» Field [iTPM Log] on [- iTPM Discount ...
> Item ltem e T
» Last modified by Contact Line Amount ® #
» Last modified by Customer Line Quantity X #
» Last modified by Employee Line Rate X #
» Last modified by Entity Name X T
» Last modified by Generic Resource Transaction 28 & T
» Last modified by Group
e Abbreviation X T
Formulas 1 Allowance X T
S el 9" @ pllowance (Rate - 4 De... ¢ #
sz Allowance % X #
> Field [iTPM Log]l on [- iTPM... " 8
> Item Allowance MOP XT
» Last modified by Contact Allowance Rate K #
» Last modified by Customer Allowance Type X T
» Last modified by Employee Allowance Unit KT
> Last modified by Entity Promotion K T
R _—
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Formulas 1 Date [1]
- iTPM Discount Log 2° @ irpM Discounts App... & 2
Cust
S Status T
» Field [iTPM Loglon [- iTPM ... ' 8
Transaction Number T
» ltem
» Last modified by Contact Type T
> Last modified by Customer Abbrev. Type T
» Last modified by Employee Account Based Mumber T
» Last modified by Entity Accrual 1D Ay
Last modified by G ic Reso..
. e Accrual Qualifying A... ¢ #
» Last modified by Group -
Accrual Voided?
» Last modified by Other Mame X2
. AN
» Last modified by Partner Accruing Transa... o T
» Last modified by Project Templ... Accruing Transactio... 9 #
» Last modified by Project Action ltem T
> Last modified by Resource Gro.. 4 +51 Production End D... 5
Last modified by Vend
’ mosimee By veneor Actual Production Start ... [1]
» Line Price Level
Actual Shipping Date
» Line Unit PPINg B
Y Owner Alt. Sales Total H#
¥ Transaction 5 Amount Paid (Transactio... &
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5. Formulas: Discount$ (This is the total that was applied using NetSuite Discount items)

Output Type = FLOAT

Formula Field X

FORMULA FIELD NAME* CHOOSE OUTPUT TYPE*
‘Disccunt % ‘ FLOAT
FORMULAZ

{custrecord_itpm_slog_lineguantity}®
{custrecord_itpm_sline_log<customrecord_itpm_discountlogline.custrecord_itpm_sline_zllrate}

Copy this into the formula form above to calculate Discount $, and drag the field into your data set.

{custrecord_itpm_slog_linequantity}*{custrecord_itpm_sline log<customrecord_itpm_discountlogline.cu
strecord_itpm_sline_allrate}

The fields will change to blue after you drag them into your data set:

Formulas 1 Discount $ F #

- iTPM Discount Log 9
> _Customer
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5.0 .;TPM Accrual Log

The .TPM Event-based accrual log is only available if you create ;TPM promotions. It is NOT a financial accrual.
Use the ;TPM accrual log to true-up your actual financial accruals which you control.

If you do create .TPM promotions, this log is only available for promotion types that have the accrual log enabled
under iTPM-> Settings -> Accrual Log. For more details on the .TPM event-based accrual log, go to the Admin
User Guide at www.i-TPM.com/admin-training-resources.

We suggest you use this log as another data source to true-up your actual financial accrual, which is probably a
period-based accrual. (Period-based accruals are typically a % on everything you sell during a specific
time-period. Event-based accruals are based on promotion events and business rules.)

Here are ways to use gain insight from the accrual log:

Ending balance: Compare the log’s balance with your actual financial accrual.

Look at what’s changed over a specific period: For example, use a NetSuite workbook to view all the
accrual logs for Q1. The total of all the accrual logs will tell you if your actual financial accruals should
have gone UP or DOWN, and directionally by how much.

Recommended Hybrid approach: Filter your results to show ONLY promotions for a specific period, i.e.
2019. Filter out CLOSED promotions, because there should be no unpaid liability for closed promotions.
Use the workbook to see both what's changed over time AND the ending balance for those promotions.

Here’s how the event-based accrual log works:

At any point in time you begin with a starting balance....

New Promotion: When an approved promotion becomes active, an accrual log is created that records
the anticipated liability for bill-backs and lump-sums for the promotion.

Transaction: Every night, a script runs to record changes to the accrual log for each promotion:

o Shipments (fulfillments): If a promotion’s liability is linked to shipments, then shipments that
qualify for bill-backs are appropriately logged for the customer, promotion and item. These logs
INCREASE the accrual log amounts.

o Settlements: Settlements are recorded in the accrual log. Settlements DECREASE the accrual
log, and VOIDED settlements INCREASE the log.

Promotion Edit: A user may make changes to a promotion after it is approved. If any of these changes
impact the amount in the accrual log, the original accrual ‘new promotion’ accrual amount is eliminated
through a reversing log, and a new accrual log is created with the new and updated amount.

After these adjustments you have an ending balance of what you owe but hasn’t been paid or deducted.

Helpful hint: Consider these limitations in your analysis:
e The .TPM accrual only goes back to the date you turned on ;TPM and :TPM accrual log
e The .TPM accrual log only has data if the promotion is created and approved in NetSuite
e [or scan events and indirect customers, any accrual log is only as good as the estimated spend.

Note: The overnight script only updates the accrual log for the previous day’s transactions. If this script
does not run for some reason, the accrual log will be missing these transactions. The accrual log script
does not create back-dated log entries.

The current version of .;TPM does NOT adjust the accrual amount for overpays. Use a filter in your
workbook to exclude overpays for promotions with a status of CLOSED.
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5.1 iTPM 510 Accrual Log

Create the DATASET for the ;TPM Accrual Log (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

New Dataset
1. Create a new Dataset: (Name: “- iTPM 510 Accrual Log”)

2. Select Record Type: - iTPM Accrual Log:

New Dataset

Search for a record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYPES

ITPM Acd X

Showing 2 Record Types

RECORD TYPE

- iTPM Accrual Log

3. Criteria: Type Inactive = false AND Date Accrued on or after start of fiscal year before last

~ Criteria summary Show details
Inactive = AND » Date Accrued

== Inactive is false

AND = _ . .
s: Date Accrued on or after start of fiscal year before last

Helpful Hint: To see only changes for a specific NetSuite period, add date as a
criteria.
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date
Date Q
 Records
~ Fields

- iITPM Accrual Log
iTPM Promotion

iTPM Promotion

Date Accrued
Ship date - End
Ship date - Start

X
X
x

Sh Its
Note: You may need to click

Use the table on the next page to add these fields to your accrual log worksheet:

- iTPM 510 Accrual Log (SDF)

Accrual Amount

Accruing Transa..

Company Mame
Condition
Created
Customer

Date Accrued
Description
Event Trigger
D

[tem

ltem Class
iTPM Customer

MName

Ah
* Ow

X #
X

RNRNN RNNRNXN
HP HHHAAEAEA A

O
L=

xh

X

|_l

to find your measure.

owner

Posting Period
Promo #
Promotion Closed?
Promotion Name
Promaotion Type
Quantity

Sales Rep

Ship date - End
Ship date - Start

Status

RNRR RRR AR AR

HEEA#AA®8#F A

(Note: You'll create iTPM CUSTOMER and Promotion Closed? in step 5)
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-> {TPM Promotion

n.custrecord_itpm_p_customer

Field Name | Source Field ID Description (- iTPM 510 Accrual Log)
Accrual iTPM Accrual Log custrecord_itpm_acc_amount Amount of the accrual, which can be positive or
Amount negative.
Accruing iTPM Accrual Log custrecord_itpm_acc_transacti | Link the transaction associated with the accrual:
Transaction on Shipment, settlement.
Company iTPM Accrual Log custrecord_itpm_acc_promotio | This is the name of the customer
Name -> {TPM Promotion | n.custrecord_itpm_p_customer
.companyname

Condition iTPM Accrual Log / | custrecord_itpm_acc_promotio | Condition

iTPM Promotion n.custrecord_itpm_p_condition
Created iTPM Accrual Log created Created date
Customer iTPM Accrual Log custrecord_itpm_acc_promotio | This is the customer associated with the accrual

log.

Date Accrued

iTPM Accrual Log

custrecord_itpm_acc_dateaccr
ued

Date of the accrual log. (Date the record was
created)

Description iTPM Accrual Log custrecord_itpm_acc_item*ite Description of the item associated with the accrual
-> ltem m.description log entry. Note: Some log entries do not have the
item field populated.
Event Trigger | iTPM Accrual Log custrecord_itpm_acc_event New Promotion = Accrual created when an
approved promotion first becomes active.
Transaction = Shipment, invoice and/or settlement
Promotion Edited = Accrual log updated because
the promotion was edited.
ID iTPM Accrual Log name Accrual log transaction ID
ltem iTPM Accrual Log custrecord_itpm_acc_item Number of the item associated with the accrual log
entry. Note: Some log entries do not have the item
field populated.
Iltem Class custrecord_itpm_a | custrecord_itpm_acc_item*ite Item Class
cc_item?item.class | m.class
iTPM Formula See step 5 for formula This is the customer associated with the accrual
Customer log.
Name iTPM Accrual Log altname External name of the accrual log
Owner iTPM Accrual Log custrecord_itpm_acc_promotio | Owner
->iTPM Promotion | n.owner
Posting iTPM Accrual Log custrecord_itpm_acc_postingp | This is the NetSuite period related to the accrual
Period -> iTPM Promotion | eriod log record.
Promotion Formula See step 5 for formula Is the promotion associated with this log closed?

© 2025 CG Squared, Inc.
All Rights Reserved

www.i-tpm.com

Page 117 of 180

Quick Reference Link: Analytics



http://www.i-tpm.com/

i{IPM

User Guide: Datasets

NetSuite 2025.1

Closed?
Field Name | Source Field ID Description (- iTPM 510 Accrual Log)
Promotion iTPM Accrual Log custrecord_itpm_acc_promotio | This is the name of the promotion associated with
Name -> iTPM Promotion | n.name the accrual log. (We suggest you change this field
to ‘promotion name’)
Promo # iTPM Accrual Log / | custrecord_itpm_acc_promotio | Promotion Number
iTPM Promotion n.id
Promotion TPM Accrual Log custrecord_itpm_acc_promotio | Promotion Type
Type -> iTPM Promotion | n.custrecord_itpm_p_type
Quantity iTPM Accrual Log custrecord_itpm_acc_quantity | Quantity
Sales Rep iTPM Accrual Log custrecord_itpm_acc_promotio | Sales Rep
-> {TPM Promotion | n.custrecord_itpm_p_customer
-> Customer .salesrep
Ship date - iTPM Accrual Log custrecord_itpm_acc_promotio | End-ship date of the promotion associated with this
Start -> iTPM Promotion | n.custrecord_itpm_p_shipstart | accrual log.
Ship date - iTPM Accrual Log custrecord_itpm_acc_promotio | Start-ship date of the promotion associated with
End -> iTPM Promotion | n.custrecord_itpm_p_shipend this accrual log.
Status iTPM Accrual Log- | custrecord_itpm_acc_promotio | Promotion status
-> iTPM n.custrecord_itpm_p_status
Promotion

Your fields will change to blue after you drag them into your data set:

Formulas 2 Accrual Amount X H#
- iTPM Accrual Log = Accruing Trans... g2 & T
? Accrual Journal Entry Transa... Date Accrued <§g il
? Accruing Transaction Transa...

B Event Trigger X T
> Item 2 '° KT
» iTPM Allowance Item ae X T
» TPM Allowance Unit Name X T
‘v 1TFM Fromotion - Posting Period X T
? f:\fcuu?t ~ Quantity X #
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» Iltem 2
» iTPM Allowance

- iTPM Accrual Log 9 Condition X T
+ iTPM Promotion 8 Customer % T
Account
4 Mame % T
> Allocation Type %
Owner T
» Condition
> Copied From Promotion Type X T
% Customer Ship date - End * [
» Field [Copied From] on [- iT... Ship date - Start % [
» Field [iTPM Promotion] on [... Status X T
-iTPM Accrual Log 9 Class 593,
> Event Trigger Description T

Alternate Source Item 3% T

- iTPM Accrual Log 9 Company Name T
» Customer Sales Rep T
» Field [Copied From] on [-iT... Email T
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5. Formulas: Create a formula for Promotion Closed?

(Use this field to filter out closed promotion accruals from your pivot tables.)
CHOOSE QUTPUT TYPE*

Copy this into the form above for Promotion Closed? Output Type = Boolean

NAME*

(=B
ELD

FORMULA

o

|F'ror'mtior| Closed?

FORMULA® v

Case
When {custrecord_itpm_acc_promotion.custrecord_itpm_p_status#display} = "CLOSED" Then 'T'

Else 'F" End

Case
When {custrecord_itpm_acc_promotion.custrecord_itpm_p_status#display} = 'Closed' Then 'T

Else'F' End

OPTIONAL Create a formula to get the iTPM CUSTOMER name into your pivot tables.

If the standard NetSuite Customer field only has the customer number, use this to show the
customer name in your pivot tables: Output type = STRING.

Formula Field *
CHOOSE OUTPUT TYPE*

FORMULA FIELD NAME*
|i‘pm Customner] X 37 | STRING
FORMULA

MVL({custrecord_itpm_acc_transaction®transaction.entity#display},
NVL({custrecord_itpm_acc_transaction®transaction.custbody_itpm_customer#display},

{custrecord_itpm_acc_promotion.custrecord_itpm_p_customer#display})

Copy this into the form above to get the iTPM CUSTOMER name in your pivot view:

NVL({custrecord_itpm_acc_transaction*transaction.entity#display},
NVL({custrecord_itpm_acc_transaction*transaction.custbody_itpm_customer#display},

{custrecord_itpm_acc_promotion.custrecord_itpm_p_customer#display}))

The fields will change to blue after you drag them into your data set:

xh

Formulas iTPM Customer

2
-ITPM Accrual Log - Promotion Closed? £

# Accrual Journal Entry Transac... m

# Accruing Transaction Transa...

T
s
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5.2 iTPM 520 Financial PERIOD-based Accruals

Create the DATASET for .TPM Period-based Accruals (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

Mew Dataset
1. Create a new Dataset: (Name: - iTPM 520 Financial PERIOD-based Accruals)

2. Select Record Type: Transaction:

New Dataset

Search for a record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYPES

transaction

Showing 7 Record Types

RECORD TYPE

Transaction Mumbering Audit Log
Transaction Audit Trail

Transaction

3. Criteria Type is - iTPM Accrual AND Event Trigger is Period-Based AND Inactive = false AND Post Period
Start Date on or after start of fiscal year before last:

~ Criteria summary Show details
Type » AMD » Event Trigger = AND » Posting Period: Start Date
iz Type is - iTPM Accrual

AND - =z Event Trigger is Period-Based

iz Posting Period: Start Date on or after start of fiscal year before last

Helpful Hint: To see only changes for a specific NetSuite period, add date as a
criteria.
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set.

Example: Date

Date

+ Records

 Fields

Transaction

Transaction

Field [Deductions to Update] on [- iTPM MonGL MassUpdate Queue]

Date
&ctual Production End Date

Q

[
5

. 5h b
Note: You may need to click

Use the table on the next page to add these fields to your accrual log worksheet:

- iTPM 520 Financial PERIOD-H
Accruing Transactio... ¢ #

Company Name T
Customer T
Date (Accrual) [1]
Date Created [1]
Document Number/ID T
End Date [1]
Event Trigger X T

Financial Customer % T

to find your measure.

Invoice Create Date [1]

iTPM Amount ¢ ## || Posting Month £ T
Memo 4% T || Posting Period [1]
Parent T || 5tart Date [x]
Period Based Accrua.. 9§ T || Transaction T
Period Based Accru... ¢ T || Type T

(Note: You'll create Posting Month in step 5)
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Accrual Name

odname

Field Name Source Field ID Description (- iTPM 520
Financial PERIOD-based
Accruals)
Accrual % Transaction | Transaction->custbody_itpm_acc_per | Accrual %
cent
Accrual Name Transaction | Transaction->custbody_itpm_acc_peri | Accrual Name
odid.custrecord_itpm_periodbased_ac
crualname
Accruing Transaction | Transaction->custbody_itpm_acc_tran | Link the transaction
Transaction saction associated with the accrual:
invoice
Accruing Transaction | Transaction->custbody _itpm_acc_tota | Accruing Transaction Total
Transaction Total lamount Amount
Amount
Company Name Financial Transaction->Financial This is the company name of
Customer Customer->Company Name the customer associated with
the transaction
Customer Financial Transaction->Financial This is the customer
Customer Customer->Customer associated with the
transaction
Date (Accrual) Transaction | Transaction->trandate Date of the accrual log. (Date
the record was created)
Date Created Transaction | Transaction->createddate Date Created
Document Transaction | Transaction->tranid Document Number/ID
Number/ID
Event Trigger Transaction | Transaction->custbody_itpm_acc_eve | Event Trigger
nt
Financial Customer | Transaction | Transaction->custbody_itpm_acc_fac | Financial Customer
ustomer.altname
Invoice Create Date | Accruing Transaction->Accruing Transaction-> Invoice Create Date
Transaction | custbody_itpm_acc_transaction’trans
action.createddate
iTPM Amount Transaction | Transaction->custbody_itpom_amount | iTPM Amount
Memo Period Transaction->Period Based Accruals Memo
Based ID->custbody_itpm_acc_periodid.cust
Accruals ID | record_itpm_periodbased_memo
Parent Financial Transaction->Financial Customer-> Parent
Customer
Period Based Transaction | Transaction->custbody_itpm_acc_peri | Period Based Accrual Name
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Field Name Source Field ID Description (- iTPM 520
Financial PERIOD-based
Accruals)
Period Based Transaction | Transaction->custbody_itpm_acc_peri | Period Based Accrual ID
Accrual ID odid
Period Start Date Posting Transaction->Posting Period Start Date
Period Period->postingperiod.startdate
Period End Date Posting Transaction->Posting Period End Date
Period Period->postingperiod.enddate
Posting Month Formula See step 5 for formula Posting Month
Posting Period Transaction | Transaction->postingperiod Posting Period
Transaction Transaction | Transaction->trandisplayname Transaction
Type Transaction | Transaction->type Transaction Type

Your fields will change to blue after you drag them into your data set:

Formulas 1 Accruing Trans... p2 4 T
e srilon = 3 Accruing Transactio... §¢ #
» Transaction Line
Date [1]
» Accrual ID
_ ) _ Date Created [1]
» Accruing Transaction Transaction 1
» Assigned To Document Number/ID T
» Billing Address Event Trigger X T
> Competitors Financial Customer 4§ T
» Controller iTPM Amount X #
» Copy Employees
Py EmpIoy Percent X H#
» Created By %
Period Based Accru... T
» Created By Customer
» Created By Employee Period Based Accru... ¢ T
> Created By Entity Posting Period [1]
> Created By Partner Transaction T
» Created By Vendor Type T
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Transaction 11 O Date Created [

» Transaction Line Abbrev. Type T

» Accrual ID Account Based Number T

» Accruing Transaction Transaction 1 Accrual 1D % T

Transaction 14 O Company Name T

> Financial Customer 3 Customer T

» Financial Promotion Parent T

Incoterm

Email T

Transaction 14 Accrual Name X T

“ Period Based Accruals Id 2 Memo X T

? Exclude Customers Exclude Customers 49X T
Transaction 14 End Date [t
> Posting Period 2 Start Date [T

Promaotion / Deal
? AP Locked 3
| > Promotion Combinations
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5. Formulas:

Create a formula for Posting Month

FORMULA FIELD NAME* CHOOSE OUTPUT TYPE®*
‘F‘osting Month | STRING -
FORMULA®

1 --{postingperiod#display}

CASE

4 WHEN INSTR({postingperiod#display}, "Jan') <> @ then '81 - January’

5 WHEM INSTR{{postingperiod#display}, 'Feb') <> @ then '@2 - February’

= WHEN INSTR({postingperiod#display}, "Mar') <> @ then '@3 - March’

7 WHEMN INSTR{{postingperiod#display}, 'Apr') <> @ then "84 - April”

8 WHEN INSTR{{postingperiod#display}, 'May') <> @ then '@5 - May'

g WHEN INSTR({postingperiod#display}, "Jun') <> @ then '86 - June’

1e WHEN INSTR{{postingperiod#display}, 'Jul') <> @ then '@7 - July’

11 WHEN INSTR({postingperiocd#tdisplay}, "Aug') <> @ then '88 - August’

12 WHEM INSTR{{postingperiod#display}, 'Sep') <> @ then '@3 - September’

Copy this into the form above for Posting Month Output Type = String

CASE

WHEN INSTR({postingperiod#display}, 'Jan’) <> 0 then '01 - January'
WHEN INSTR({postingperiod#display}, 'Feb') <> 0 then '02 - February'
WHEN INSTR({postingperiod#display}, 'Mar') <> 0 then '03 - March'
WHEN INSTR({postingperiod#display}, 'Apr') <> 0 then '04 - April'
WHEN INSTR({postingperiod#display}, 'May') <> 0 then '05 - May'
WHEN INSTR({postingperiod#display}, 'Jun’) <> 0 then '06 - June'
WHEN INSTR({postingperiod#display}, 'Jul') <> 0 then '07 - July'
WHEN INSTR({postingperiod#display}, 'Aug') <> 0 then '08 - August'
WHEN INSTR({postingperiod#display}, 'Sep') <> 0 then '09 - September'
WHEN INSTR({postingperiod#display}, 'Oct') <> 0 then 10 - October'
WHEN INSTR({postingperiod#display}, 'Nov') <> 0 then '11 - November'
WHEN INSTR({postingperiod#display}, 'Dec') <> 0 then 12 - December'
END

The fields will change to blue after you drag them into your data set:

Formulas 1 Posting Month £ T

S - [ Now o |
.
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5.3 iTPM 530 Financial EVENT-based Accruals

Create the DATASET for the ;TPM 530 Event-based Accrual (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

New Dataset
1. Create a new Dataset: (Name:- iTPM 530 EVENT-based Accruals)

2. Select Record Type: Transaction:

New Dataset

Search for a record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYPES

transaction

Showing 7 Record Types

RECORD TYPE

Transaction Numbering Audit Log
Transaction Audit Trail

Transaction

3. Criteria: Type is - iTPM Accrual AND Event Trigger is NOT Period-Based AND Post Period Start Date on or
after start of fiscal year before last:

~ Criteria summary Show details

Type » AMD » Event Trigger » AMD » Posting Period: Start Date
i1 Typeis-iTPM Accrual
AND = =2 Event Trigger none of Period-Based

t: Posting Period: Start Date on or after start of fiscal year before last

Helpful Hint: To see only changes for a specific NetSuite period, add date as a
criteria.
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set.

Example: Date

Date

+ Records

 Fields

Transaction

Transaction

Field [Deductions to Update] on [- iTPM MonGL MassUpdate Queue]

Date
&ctual Production End Date

Q

[
5

. 5h b
Note: You may need to click

to find your measure.

Use the table on the next page to add these fields to your accrual log worksheet:

- iTPM 530 EVENT-based Accru...

Company Name T
Date [1]
Date Created [1]
Document Number/ID T
Event Trigger X T

Financial Customer X T
Financial Promaotion X T
Financial Promotion ID 9 #
iTPM Amount N H

Period Based Accruals 1d 9 T

Period End Date [1]
Period Start Date [x]
Posting Period [x]
Promaotion Type X T
stored Net Liability @ Pr.. 9% #
Transaction e T
Type T
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Field Name Source Field ID Description (- iTPM 520
Financial PERIOD-based
Accruals)
Company Name Financial Transaction->Financial This is the company name of
Customer Customer->Company Name the customer associated with
the transaction
Date Transaction | Transaction->trandate Date of the accrual log. (Date
the record was created)
Date Created Transaction | Transaction->createddate Date Created
Document Transaction | Transaction->tranid Document Number/ID
Number/ID
Event Trigger Transaction | Transaction->custbody_itpm_acc_eve | Event Trigger
nt
Financial Customer | Transaction | Transaction->custbody_itpm_acc_fac | Financial Customer
ustomer.althame
Financial Promotion | Transaction | Transaction->custbody_itpm_acc_fapr | Financial Promotion
omotion
Financial Promotion | Financial Transaction->Financial Financial Promotion ID
ID Promotion Promotion->custbody_itpm_acc_fapro
motion.id
iTPM Amount Transaction | Transaction->custbody_itpom_amount | iTPM Amount
Period Based Transaction | Transaction->custbody_itpm_acc_peri | Period Based Accrual ID
Accruals ID odid
Period Start Date Posting Transaction->Posting Period Start Date
Period Period->postingperiod.startdate
Period End Date Posting Transaction->Posting Period End Date
Period Period->postingperiod.enddate
Posting Period Transaction | Transaction->postingperiod Posting Period
Promotion Type Financial Transaction->Financial Promotion Type
Promotion Promotion->custbody_itpm_acc_fapro
motion.custrecord_itpm_p_type
Stored Net Liability: | Financial Transaction->Financial Stored Net Liability: Promotion
Promotion Promotion Promotion->custbody_itpm_acc_fapro
motion.custrecord_itpm_p_svnetprom
otionalle
Transaction Transaction | Transaction->trandisplayname Transaction
Type Transaction | Transaction->type Transaction Type
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Your fields will change to blue after you drag them into your data set:

Formulas Date [x]
Transaction 11 > Date Created [1]
» Transaction Line
Document Number/ID T
» Accrual ID ‘% =
Event Trigger
? Accruing Transaction Transaction B8
e Financial Customer 4 T
% Billing Address Financial Promotion ¢ T
» Competitors iTPM Amount X H
» Controller Period Based Accru... ¢ T
» Copy Employees . .
Py Employee Posting Period (1]
» Created By - =
Transaction
» Created By Customer [
» Created By Employee Type T
Transaction 1 > Company Name T
# Financial Customer 1 )
Email T
» Financial Promation 3
Transaction 11 @ Internal ID % #
? Financial Promotion 3 Promotion Type X T
| t -
neoterm Stored Net Liability ... 9 #
Transaction 1M1 @ End Date [x]
» Posting Period 2 Start Date 111
# Promotion / Deal
ASP Locked =
# Promotion Combinations
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6.0 Native NetSuite Budgets

If you use native NetSuite budgets, you can analyze them using NetSuite workbooks, and in your NetSuite

financial reports.

ORACLE NeTsulTE  iTPM

/ﬂ‘ Activities iTPM Payments BoxFiles Transactions Lists

Income Statement ] View Detail

iTPM Demo
Honeycomb Holdings Inc. (Consolidated)

Income Statement

i IPM

FY 2018

FINANCIAL RO'W
& Ordinary Income/Expense
= Income
& 4000 - Sales
4000 - Soles
4001 - Trade Promation {contra revenue)
Total - 4000 - Sales
Total - Income
= cost Of Sales
Cost of Goods Sold
Total - Cost Of Sales
Gross Profit
= Expense
6009 - Co-6p
& 6011 - Trade Prometion
5011 - Trade Promation
5023 - Open Deduction
Total - 6011 - Trade Promation
6018 - Freighs Expense
6220 . Repairs & Msintenance
Total - Expense
et Ordinary Income
Net Incame:

AMOUNT

516491.60

($200.00
$16,291.60
$16,291.60

SIS0
$15,804.00
S4ET.60

5356,654.77
($358,167.17)
($358,167.17)

Deductions and Promotional Payments in iTPM will
appear on the standard NetSuite P&L reports based
on what chart-of-accounts are mapped to the
promotion iTPM promotion type.

Examples:

Promotions where expense is contra-revenue account

can be a reduction to gross-revenue. (FASB)

- Promotions can also be a below-the-line expense.

Open deductions can be mapped to an expense
chart-of-account, or other asset account while they
are being researched. (Suspense account.)

These iTPM promotional settlements are allocated to
items based on actual sales, for more accurate
customer P&Ls by item.
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6.1 iTPM 610 Budget Analysis
Create the DATASET for native NetSuite Budgets (one-time task)

If a dataset is already created, use the .TPM Workbook User Guide to create pivot tables, lists and charts from
your dataset. In NetSuite, go to iTPM -> Help -> Analytics.

Mew Dataset
1. Create a new Dataset: (Name: “-iTPM 610 Budget Analysis”)

2. Select Record Type: Budget

New Dataset

Search for a record type that includes fields that you would like to show in your dataset.

SEARCH RECORD TYPES
| budg] X

Showing 3 Record Types

RECORD TYPE

Budget

3. Criteria: Year: Start Date on or after start of fiscal year before last.

s Criteria summary Show detzils

Year: 5tart Date

=1 Year: Start Date on or after start of fiscal year before |ast

4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date

Date Q «
+ Records
+ Fields
Accounting Period Start Date E]
Budget Last Modified Date [1]
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Use the table below to add these fields to your budget worksheet:

-iTPM 610 Budget Analysis (25...
BUDGET: ACCOUNT T
Budget: Class T
Budget: Customer o T
BUDGET: ITEM e &
Budget: Perinod T
Budget: Start date of period [1]
Budget: Trade Spend #
Budget: Year T
Field Name Source Field ID Description (NetSuite Budgets)
Budget: Account Budget Budget->account Amount budgeted by period. Total of all
the periods equals the amount for the
full budget year.
Budget: Class Budget Budget->class Budget: Class
Budget: Customer Budget Budget->customer Budget: Customer
Budget: Item Budget Budget->item Budget: Item
Budget: Period Budget by Period Budget->Budget by Budget: Period

Period->budgetmachine
.period

Budget: Period Start

Date

Accounting Period

Budget->Budget by
Period->Accounting
Period->budgetmachine
.amount

Budget: Period Start Date

Budget: Trade
Spend

Budget by Period

Budget->Budget by
Period->

Budget: Trade Spend

Budget: Year

Budget

Budget->year

Budget: Year
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The fields will change to blue after you drag them into your data set:

Formulas Account T
Budget 5 @ Class T
> Account
Customer/Project ax T
~ Budget by Period 2 25 3|
Item
»  Accounting Period 1 H
Budget Category Year T
Formulas Accounting Period T
Budget 5 @ ,mount #
» Account
Last Modified Date [1]
“~ Budget by Period 2
# Accounting Period 1
Formulas Start Date (1]
Budget 5 P /P Locked 3
» Account
AJR Locked =
~ Budget by Period 2
. . All Locked 2
» Accounting Period 1
5. Formulas: None
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7.0 iTPM Data Reconciliations

The NetSuite datasets and workbooks in this chapter are used to monitor and reconcile iTPM data. How to use
these workbooks is described in our online iTPM Reconciliation Worksheet User Guide available at
www.i-TPM.com/admin-training-resources.

71 iTPM 710 Reconcile Open Deduction GL suspense account

Create a DATASET to monitor your open deduction suspense account

If a dataset is already created, skip ahead and create your workbook. (one-time task)

New Dataset
1. Create a new Dataset: . (Name: “- iTPM 710 Deduction Resolutions for GL
Reconciliation”

2. Select Record Type: Transactions

New Dataset

Select a root record type with the fields you want to include in your dataser

traﬁsa::iu:r‘ © | Showing 8 Record Types

RECORD TYPE

Batch Transaction Information
Custom Transaction Definition
Manufacwuring Transaction [Beta]
Memarized Transaction Definition
MMemaorized Transaction Template

Transaction
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3. Criteria: See below: USE GL account that matches your suspense account

i1 Status none of - ITPM Deduction : Resclved
AND * i1 Type is - ITPM Deduction
iz Date on or after start of fiscal year before last

! Drop fields here to add criteria.

OR ~*

1 Transaction Accounting Line: Account is 6023 Open Deduction

:: Type none of - iTPM Deduction, - iTPM Settlement, Statement Charge
AND + . . :

=1 iTPM Applied To is <NO VALUE=

:1 Date on or after start of fiscal year before last

4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date

Date Q<

“+ Records

Field [Deductions to Update] on [- iTPM NonGL MassUpdate Queue]

+ Fields
Transaction Date [1]
Transaction Actual Production End Date [1]
Transaction Actual Production Start Date [1]
© 2025 CG Squared, Inc. www.i-tpm.com Page 136 of 180

All Rights Reserved Quick Reference Link: Analytics



http://www.i-tpm.com/

User Guide: Datasets

LTPM NetSuite 2025.1

Use the tables on the next pages to add these fields to your budget worksheet:

&8 - iTPM 710 Deduction ...

- iTPM 710 Deduction Resoluti...
1: Open Deduction Ba... 5 #

2: Net GL Impact fe #
Account 5?6
Created By ox

Date [1]
Document Number/ID T
Memao T
Posting Period [1]
Status T
Transaction T
Type T
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Field Name Source Field ID Description (NetSuite Budgets)
1: Open Deduction Formula See step 5 Open Deduction Balance
Balance
2: Net GL Impact Formula See step 5 Net GL Impact
Account Transaction -> transactionlines.account | GL Account

Transaction Line -> | ingimpact.account

Transaction

Accounting Line

Created By Transaction createdby Created By
Date Transaction trandate Date
Document Transaction tranid Document Number/ID
Number/ID
Memo Transaction memo Memo
Posting Period Transaction postingperiod Posting Period
Status Transaction status Status
Transaction Transaction trandisplayname Transaction
Type Transaction type Type
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The fields will change to blue after you drag them into your data set:
Formulas 2 Created By e T
Transaction g8 Date 1]
» Transaction Line
Document Number/ID T
¥ Accrual ID
i ; ) Memo T
2 Accruing Transaction Transaction
» Assigned To Posting Period [1]
> Billing Address Status T
> Competitors Transaction T
» Controller Type T
Formulas 2 Account 5?5
Transaction g O Account Type T
» Transaction Line
Amount #
? Transaction Accounting Li... {1
Amount (Credit
> Amortization Schedule ( ) #
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5. Formulas: Create a formula for 1: DDN Open Balance

(Use this field to filter out closed promotion accruals from your pivot tables.)

Formula Field X

FORMULA FIELD NAME* CHOQSE QUTPUT TYPE*
|1 DON Open Balancd @ 32 | FLOAT
FORMULA*

1 Case

2 When {type#display} = '- iTPM Deduction' and {transactionlines.debitforeignamount}> @ Then

3 TO_NUMBER({{custbody_itpm_ddm_openbal})

= End

Copy this into the form above for 1: DDN Open Balance Output Type = FLOAT

Case

When {type#display} ="'-iTPM Deduction' and {transactionlines.debitforeignamount}> 0 Then
TO_NUMBER({custbody_itpm_ddn_openbal})

End

Create a formula for 2: Net GL Impact

(Use this field to filter out closed promotion accruals from your pivot tables.)

Formula Field b4

FORMULA FIELD NAME* CHOQSE QUTPUT TYPE*
|2 Nez GL Impact | FLOAT
FORMULA=

1 Case

2 When {type#display} = '- iTPM Deducticn' and {transactionlines.debitforeignamount}> @ Then

TO_NUMBER( {custbody_itpm_ddn_openball})

When {type#display} <» '- iTPM Deduction® AND {transactionlines.debitforeignamount} > @ Then
[ {transactionlines.debitforeignamount}

7 When {type#display} <» '- iTPM Deduction® AND {transactionlines.creditforeignamount} > @ Then
8 -1*{transactionlines.creditforeignamount}

9 End

19 |

Copy this into the form above for 2: Net GL Impact Output Type = FLOAT

Case
When {type#display} ='-iTPM Deduction' and {transactionlines.debitforeignamount}> 0 Then

TO_NUMBER({custbody_itpm_ddn_openbal})

When {type#display} <> '- iTPM Deduction' AND {transactionlines.debitforeignamount} > 0 Then
{transactionlines.debitforeignamount}

When {type#display} <> '- iTPM Deduction' AND {transactionlines.creditforeignamount} > 0 Then
-1*{transactionlines.creditforeignamount}

End
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Optional: Create a formula for Customer (Use this for pivots)

(Use this field to show the customer in your pivot tables across all types of transactions.)

Formula Field X

FORMULA FIELD NAME* CHOOSE OUTPUT TYPE*
|Co"naary[usefcr piv 26 | STRING
FORMULA*

1 Case

2 kWhen {entity*entity.altname} is empty and {custbody_itpm_customer.companyname} is not empty then
l {custbody_itpm_customer.companyname}

When {entity*entity.altname} is empty and {custbody_itpm_customer.companyname} is empty then
{custbody_itpm_deduction"transaction.custbody_itpm appliedto#display}

_, Else

11 {entity*entity.altname}

172

13 End

Copy this into the form above for Customer (use this for pivots)  Output = String

Case

When {entity*entity.altname} is empty and {custbody_itpm_customer.companyname} is not empty
then

{custbody_itpm_customer.companyname}

When {entity*entity.althame} is empty and {custbody_itpm_customer.companyname} is empty
then

{custbody_itpm_deduction*transaction.custbody_itpm_appliedto#display}

Else

{entity”entity.altname}

End

The fields will change to blue after you drag them into your data set:

Q «

Formulas 2 1: Open Deduction Ba... fx #

Transaction 8 @ 2: Net GL Impact i #

» Transaction Line
» Accrual ID

© 2025 CG Squared, Inc. www.i-tpm.com Page 141 of 180
All Rights Reserved Quick Reference Link: Analytics



http://www.i-tpm.com/

User Guide: Datasets

i{IPM

NetSuite 2025.1

7.2a iTPM 720a Deduction Balance Reconciliation

Create dataset to compare open deduction balance to the linked transactions

This data set will allow you to compare the stored open balance in the deduction to the expected balance based
on all the NetSuite transactions linked to the deduction. Deductions with incorrect balances will have a difference
between your calculated open balance and the amount you calculate by adding up all the settlements, journal
entries and statement charges associated with each deduction.

Create a DATASET to monitor your open deduction balances

If a dataset is already created, skip ahead and create your workbook. (one-time task)

MNew Dataset
1. Create a new Dataset: . (Name: “- iTPM 720a Deduction Balance Reconciliation”)

2. Select Record Type: Transactions

New Dataset

Select a root record type with the fields you want to include in your dataset.

traﬁsa::iu:r‘ @ O | Showing 8 Record Types

RECORD TYPE

Batch Transaction Information
Custom Transaction Definition
Manufacwuring Transaction [Beta]
Memaorized Transaction Definition

Memaorized Transaction Template

Transaction
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3. Criteria: See below:

~ Criteria summary Show details
(Type » AND - Date ) - OR+ (Type - AND « iTPM Applied To - AND - Date ) - OR - (Type - AND - Transaction Line: Line Number - AN
1z Type is - iITPM Deduction
-
AND 1 Date on or after start of fiscal year before last
11 Typeis Journal
AND * : iTPM Applied To none of <NO VALUE=
: Date on or after start of fiscal year before last
OR *
i Type is Statement Charge
AND * :: Transaction Line: Line Number equal 0
:: Date on or after start of fiscal year before last
Drop fields here to add criteria
i Type s - iTPM Settlement
=1 Status none of - iTPM Settlement : Voided, - iTPM Settlement : Voided
AND *
2z iTPM Applied To (Transaction): Status none of - ITPM Settlement : Voided, - iTPM Settlement : Voided

4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date

Cate

w Records

+ Fields

Transaction

Transaction

Transaction

Field [Deductions to Update] on [- iTPM MNonGL MassUpdate Queue]

Q

Date
Actual Production End Date

[-§ [ [

Actual Production Start Date
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Use the tables on the next pages to add these fields to your budget worksheet:

S - iTPM 720a Deductio...

S - iTPM 720b Deductio...

-iTPM 720a Deduction Balana

0: DDN # for filtering % #
@

 0: DDN # for Piv... # T
0: DDM # text i T
1: DDN Orig Amt 5 #
2: DDN Split Off I #
3: JEs i #
3b: JE= Pending f; #
4 Settlements f'; H#
5:Statement Chgs  fx #
6: Open amt on DDN f, #
7: Calc Open using J... 5 #
8: Possible ERROR ~ fx #
Amount (Credit) (Transa... &
Amount (Debit) (Transac...
@e} Date (1]
DDN Date # [
Document Mumber/ID T
Entity 2t &

10

iTPM Amount
iTPM Applied To
iTPM Applied To

iTPM Applied To

iTPM Created Fr...

Memao

Cpen Balance
Parent Deduction
split Off

Start Date

Status

Status

x
ot
av K
ot
av K

x
ot
x

#
#
T
T
T
T
T
#
T
#
[
T
T

Total Amount (Transacti... 3

Transaction
Qo Type

ZeroForinner]oin

I

T

T
#
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Field Name Source Field ID Description (NetSuite Budgets)
0: DDN # for filtering | Formula See step 5 DDN # for filtering
0: DDN # for Pivots | Formula See step 5 DDN # for Pivots
0: DDN # text Formula See step 5 DDN # text
1: DDN Orig Amt Formula See step 5 DDN Orig Amt
2: DDN Split Off Formula See step 5 DDN Split Off amount
3: JEs Formula See step 5 JEs amount
3b: JEs Pending Formula See step 5 JEs Pending amount
4: Settlements Formula See step 5 Settlements amount
5: Statement Chgs Formula See step 5 Statement Chgs amount
6: Open amt on Formula See step 5 Open amt on DDN
DDN
7: Calc Open using | Formula See step 5 Calc Open using JE, SC, SET
JE, SC, SET
8: Possible ERROR | Formula See step 5 Possible ERROR
Date Transaction trandate Date
DDN Date Formula See step 5 Deduction Date
Document Transaction tranid Document Number/ID
Number/ID
Entity entity Entity associated with transaction
ID Transaction -> transactionlines.id Transaction ID
Transaction Line
iTPM Amount custbody_itpm_amount [ iTPM Amount
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Field Name

Source

Field ID

Description (NetSuite Budgets)

iTPM Applied To

custbody_itpm_appliedt
o}

iTPM Applied To (transaction)

iTPM Applied To

Transaction ->
Deduction

custbody_itpm_deductio
nransaction.custbody
itpm_appliedto

iTPM Applied To (deduction)

iTPM Applied To

Transaction ->
iTPM Applied To

custbody_itpm_appliedt
o*transaction.custbody_
itpm_appliedto

iTPM Applied To (resolution)

iTPM Created From

Transaction ->
iTPM Applied To

custbody_itpm_appliedt
o’Mransaction.custbody
itpom_createdfrom

iTPM Created From

Memo Transaction memo Memo
Open Balance Transaction custbody_itpm_ddn_op | Open Balance
enbal
Parent Deduction Transaction custbody_itpm_ddn_par | Parent Deduction
entddn
Split Off Transaction custbody_itpm_ddn_spli [ Amount Split Off deduction
toff
Start Date Transaction -> postingperiod.startdate | Start Date
Posting Period
Status Transaction status Transaction Status
Status Transaction -> custbody_itpm_appliedt [ iTPM status
iTPM Applied To o’Mransaction.status
(Transaction)
Total Amount Transaction foreigntotal Total Amount (transaction)
(transaction)
Transaction Transaction trandisplayname Transaction
Type Transaction type Type
ZeroForlnnerJoin Formula See step 5 Used to create inner join between
datasets
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The fields will change to blue after you drag them into your data set:

Formulas 14
Transaction 13
? Transaction Line 3
? Accrual ID

» Accruing Transaction Transa...

Amount (Credit) (Trans... #
Amount (Debit) (Transa... &

ID H#

Accounting Line Type T

All Rights Reserved

Quick Reference Link: Analytics

Transaction 13 O iTPM AppliedTo 22K T
# Deduction Transaction 1 Abbrev. Type T
» Destination Location P S T I ..
Transaction 13 @ Start Date (1]
> Posting Period 1 AP Locked a
# Promotion / Deal 2/ | acked > |
Formulas 14 Date (1]
Transaction - @ Document Number/iID T
? Transaction Line 3 Entity 5?
» Accrual ID
» Accruing Transaction Transa... TPM Amount % #
> Assigned To iTPM AppliedTo J2 K T
> Billing Address Memo T
» Competitors Open Balance X H#
> Controller Parent Deduction 3% 9 T
» Copy Employees split Off X #
» Created By
? Created By Customer Status B
e IR e Total Amount (Transact... &
Y Created By Entity Transaction T
> Created By Partner Type T
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5: Formulas:

Formula name Formula

0: DDN # for Case

filtering When {type#display} ='-iTPM Deduction' Then
TO_NUMBER(Replace ({trandisplayname},’- iTPM Deduction #," ))
Else
TO_NUMBER(Replace ({custbody_itpm_appliedto#display},- iTPM Deduction #',"))

Float End

0: DDN # for Case

Pivots When {type#display} ='-iTPM Deduction' Then {trandisplayname}
Else {custbody itpm_appliedto#display}

String End

0: DDN # text Case
When {type#display} ='-iTPM Deduction' Then
Replace ({trandisplayname},’- iTPM Deduction #," )

String Else

Replace ({custbody_itpm_appliedto#display},'- iTPM Deduction #',")
End

1: DDN Orig Amt

Case
When {type#display} ='-iTPM Deduction' Then {custbody_itpm_amount}
Else 0

Float End

2: DDN Split off Case
When {type#display} ='-iTPM Deduction' and {custbody_itpm_ddn_splitoff} is not Null
Then ({custbody itpm_ddn_splitoff})*-1

Float Else 0
End

3: JEs Case
When {type#display} ='Journal' and {status#display} = 'Journal : Approved for Posting'
and {isreversal} = 'F' Then ({transactionlines.creditforeignamount})*-1

Float

When {type#display} ='Journal' and {status#display} = 'Journal : Approved for Posting
and {isreversal} = 'T' Then ({transactionlines.creditforeignamount})

Else 0

End

3b: JEs pending

Float

Case

When {type#display} = 'Journal' and {status#display} = 'Journal : Pending Approval'
Then ({transactionlines.creditforeignamount})*-1

Else 0

© 2025 CG Squared, Inc.
All Rights Reserved

www.i-tpm.com
Quick Reference Link: Analytics

Page 148 of 180


http://www.i-tpm.com/

i{IPM

User Guide: Datasets

NetSuite 2025.1

End

4: Settlements

Case
When {type#display} ='-iTPM Settlement' Then ({custbody_itpm_amount})*-1
Else 0

DDN

Float

Float End

5: Statement Chg | Case
When {type#display} ='Statement Charge' Then ({foreigntotal})*-1
Else 0

Float End

6: Open amt on Case

When {type#display} ='-iTPM Deduction' Then {custbody itpm_ddn_openbal}/2
Else 0
End

7: Calc OPEN
using JE, SC, SET

Case
When {type#display} ='-iTPM Deduction' and {custbody_itpm_ddn_splitoff} is Null Then
{custbody_itpm_amount}

Float When {type#display} ='-iTPM Deduction' and {custbody_itpm_ddn_splitoff} is not Null

Then
{custbody_itpm_amount} - {custbody_itpm_ddn_splitoff}
When {type#display} ='Journal' and {status#display} = 'Journal : Approved for Posting'
and {isreversal} = 'F' Then ({transactionlines.creditforeignamount})*-1
When {type#display} ='Journal' and {status#display} = 'Journal : Approved for Posting'
and {isreversal} = 'T' Then ({transactionlines.creditforeignamount})
When {type#display} ='-iTPM Settlement' Then ({custbody_itpm_amount})*-1
When {type#display} = 'Statement Charge' Then ({foreigntotal})*-1
End
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8: Possible Case

ERROR When {type#tdisplay} ="'-iTPM Deduction' and {custbody_itpm_ddn_splitoff} is Null Then
{custbody_itpm_amount} - {custbody_itpm_ddn_openbal}

Float When {type#display} ="'-iTPM Deduction' and {custbody_itpm_ddn_splitoff} is not Null
Then

{custbody_itpm_amount} - {custbody_itpm_ddn_splitoff} -{custbody itpm_ddn_openbal}

When {type#display} ='Journal' and {status#display} = 'Journal : Approved for Posting'
and {isreversal} = 'F' Then ({transactionlines.creditforeignamount})*-1

When {type#display} ='Journal' and {status#display} = 'Journal : Approved for Posting'
and {isreversal} = 'T' Then ({transactionlines.creditforeignamount})

When {type#display} ='-iTPM Settlement' Then ({custbody_itpm_amount})*-1
When {type#display} = 'Statement Charge' Then ({foreigntotal})*-1

End
Action: If the field “Possible ERROR” is non-zero, then research the deduction

DDN Date Case
When {type#display} ='-iTPM Deduction' Then {trandate}
Date End

ZeroForlnnerJoin 0

Integer
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The fields will change to blue after you drag them into your data set:

L L . . . . . T

Formulas 14

Transaction 13 O

Transaction Line 3
Accrual ID

Accruing Transaction Transacti...
Assigned To

Billing Address

Competitors

Controller

Copy Employees

Created By

Created By Customer

Created By Employee

Created By Entity

Created By Fartner

Created By Vendor

0: DDN # for filtering
0: DDN # for Pivots
0: DDM # text

1: DDN Orig Amt

2: DDN Split Off

3: |Es

3b: |Es Pending

4: Settlements

5: Statement Chgs

6: Open amt on DDN
7: Calc Open using JE, ...
8: Possible ERROR

DDM Date

xh xh xh b xh xh o X xh b XN xh h XN

ZeroForlnner]oin

HEHEHHHFEHIFHEHRHEAAHE

© 2025 CG Squared, Inc.
All Rights Reserved

www.i-tpm.com
Quick Reference Link: Analytics

Page 151 of 180


http://www.i-tpm.com/

User Guide: Datasets

i{IPM

NetSuite 2025.1

7.2b iTPM 720b Deductions for Balance Reconciliation

Create dataset to compare open deduction balance to the linked transactions

This data set will allow you to compare the stored open balance in the deduction to the expected balance based
on all the NetSuite transactions linked to the deduction. Deductions with incorrect balances will have a difference
between your calculated open balance and the amount you calculate by adding up all the settlements, journal
entries and statement charges associated with each deduction.

Create a DATASET to monitor your open deduction balances

If a dataset is already created, skip ahead and create your workbook. (one-time task)

MNew Dataset
1. Create a new Dataset: . (Name: “- iTPM 720b Deductions for Balance Reconciliation”

2. Select Record Type: Transactions

New Dataset

Select a root record type with the fields you want to include in your dataset.

traﬁsa::iu:r‘ @ O | Showing 8 Record Types

RECORD TYPE

Batch Transaction Information
Custom Transaction Definition
Manufacwuring Transaction [Beta]
Memaorized Transaction Definition

Memaorized Transaction Template

Transaction
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3. Criteria: See below:

» Criteria summary Show details

Type = AND - Date

iz Typeis - iTPM Deduction

AND = i i )
i1 Date on or after start of fiscal year before last

4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date

Date Q<

“ Records

Field [Deductions to Update] on [- iTPM MonGL MassUpdate Queue]

“~ Fields
Transaction Date [1]
Transaction Actual Production End Date [1]
Transaction Actual Production Start Date [1]
Use the tables on the next pages to add these fields to your budget worksheet:
Qs - iTPM 720a Deductio...
S - iTPM 720b Deductio...
- iTPM 720b Deductions for Bal...
0 DDN For filtering iy #
S5 0 DDN for pivots 5 T
% Date [1]
OneForlnner]ain F #
Transaction T
% Type T
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Field Name Source Field ID Description (NetSuite Budgets)
0: DDN # for filtering | Formula See step 5 DDN # for filtering
0: DDN # for Pivots | Formula See step 5 DDN # for Pivots
Date Transaction trandate Date
OneForlnnerJoin Formula See step 5 Used to create inner join between
datasets
Transaction Transaction trandisplayname Transaction
Type Transaction type Type
The fields will change to blue after you drag them into your data set:
Formulas 3 Date [x]
Transaction Transaction T
# Transaction Line
Type T
» Accrual ID
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5: Formulas

Formula name

Formula

0 DDN # for
filtering

Float

TO_NUMBER(Replace ({trandisplayname},’- iTPM Deduction #," ))

0 DDN # for pivots

String

{trandisplayname}

OneForlnnerJoin

Integer

The fields will change to blue after you drag them into your data set:

Formulas 3 0 DDN For filtering i H#
Transaction 3 @ 0 DDN for pivots 5 T
» Transaction Line OneForlnnerjoin -f;: #
> Accrual ID
» Accruing Transaction Transa...
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7.3 iTPM 730 ALL Open Deduction Transactions

Create a dataset to analyze all transactions that hit your open deduction GL account:

If a dataset is already created, skip ahead and create your workbook. (one-time task)

MNew Dataset
1. Create a new Dataset: . (Name: “-iTPM 730 ALL Open Deduction Transactions”

2. Select Record Type: Transactions

New Dataset

Select a root record type with the fields you want to include in your dataser

tra’usa:jio"‘ @ (O | Showing 8 Record Types

RECORD TYPE

Batch Transaction Information
Custom Transaction Definition
Manufacwuring Transaction [Beta]
Memarized Transaction Definition
MMemarized Transaction Template

Transaction

3. Criteria: See below: USE GL account that matches your suspense account

When creating your dataset, set the filter equal to the deduction account used by iTPM for open deductions.

s Criteria summary Show details

Transaction Accounting Line: Account = AND » Date

i Transaction Accounting Line: Account is 8023 Open Deduction

AND * _
iz Date on or after start of fiscal year before last
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set.

Example: Date

Cate

+ Records

Field [Deductions to Update] on [- iTPM NonGL MassUpdate Queue]

+ Fields

Transaction Date

Transaction Actual Production End Date
Transaction Actual Production Start Date

Q 4

(i
[
[7]

Use the tables on the next pages to add these fields to your budget worksheet:

-iTPM 730 ALL Open Deductio...
1: Debit Amount (Transac... &
2: Credit Amount (Transac... &
Account 5'?3,
Customer (use for pivo.. J‘; T
Date [1]
Document Number/ID T
Entity ov
iTPM Applied To e T
iTPM Customer X T
iTPM Promation X T
Memo T
Posting Period

Posting Period

Status

Transaction

[1]
[i]
Start Date [1]
T
T
T

Type
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r

Field Name Source Field ID Description (NetSuite Budgets)
1: Debit Amount Transaction -> transactionlines.debitfor | Debit Amount
(Transaction TransactionLine eignamount
Currency)
2: Credit Amount Transaction -> transactionlines.creditfo | Credit Amount
(Transaction TransactionLine reignamount
Currency)
Account Transaction -> transactionlines.account | GL Account

Transaction Line -> | ingimpact.account

Transaction

Accounting Line
Customer (use for Formula See step 5 Customer
pivots)
Date Transaction trandate Date
Document Transaction tranid Document Number/ID
Number/ID
Entity Transaction entity Entity associated with transaction
iTPM Applied To Transaction custbody_itpm_appliedt | iTPM Applied To (transaction)

o}

iTPM Customer Transaction custbody_itpm_custome [ iTPM Customer

iTPM Promotion

Transaction ->
iTPM Applied To

custbody_itpm_set _pro
mo

iTPM Promotion

Memo

Transaction

memo

Memo

Posting Period

Transaction

postingperiod

Posting Period (transaction)

Posting Period

Transaction ->
iTPM Applied To

custbody_itpm_appliedt
o’Mransaction.postingpe
riod

Posting Period (applied to transaction)

Start Date Transaction -> postingperiod.startdate | Start Date
Posting Period
Status Transaction status Transaction Status
Transaction Transaction trandisplayname Transaction
Type Transaction type Type
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The fields will change to blue after you drag them into your data set:

Formulas 1

Transaction 0

» Transaction Line
Acknowledgement Status

» Acknowledgement Type

Adjustment Reason

Aszsigned To

Bill of Materials

Bill of Materials Revisicn

Billing Address

Bulk Processing Submission

Campaign Category

L . L

Carrier

Formulas 1
Transaction 10 ©
» Transaction Line
Transaction Accounting ... | 2
iTPM Applied To Transactio... 1

Posting Period 1

Formulas 1
Transaction 10
“ Transaction Line
Transaction Accounting Li..." 2
iTPM Applied To Transacti... (1

Posting Period 1

Date

el
T

iTPM Applied To 32K T
X T
X T

Memo T

Document Number/1D

Entity e

iTPM Customer

iTPM Promotion

Posting Period

Transaction

Type

HHHB

Abbrev. Type

Amount (Credit)
Amount (Debit)
Account
Armount
Amount (Net)

Amount Paid

Posting Period [1]

ame @ HF H H#H e H H

Abbrev. Type T
Account Based Number T
ACH/EFT Reference .. 9 T

Acknowledgement 5. 9 T

srknowladoamant T ¢ T
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Formulas 1 | start Date [1]
Transaction W O splocked >
 Transaction Line AR Locked @

Transaction Accounting Li...” 2
All Locked =

iTPM Applied To Transactio... 1
- s
Posting Period 1 Allow Mon-G/L Changes .
Closed =

5: Formulas
Formula name Formula

Customer (use for pivots)

String

Case

When {entity*entity.althame} is empty and
{custbody_itpm_customer.companyname} is not empty then
{custbody_itpm_customer.companyname}

When {entity*entity.althame} is empty and
{custbody_itpm_customer.companyname} is empty

then
{custbody_itpm_deduction*transaction.custbody_itpm_appliedto#displ
ay}

Else

{entity*entity.altname}

End

The fields will change to blue after you drag them into your data set:

Formulas
Transaction
» Transaction Line

» Accrual ID

» Accruing Transaction Transa...

3 0 DDMN For filtering J";; #H
o 0 DDN for pivots 5 T
OneForlnner]oin J'";; #
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8.0 Monthly Base Forecasts

8.1 iTPM 810 Base Forecasts

Create a dataset to compare open deduction balance to the linked transactions.

This data set will allow you to compare the stored open balance in the deduction to the expected balance based
on all the NetSuite transactions linked to the deduction. Deductions with incorrect balances will have a difference
between your calculated open balance and the amount you calculate by adding up all the settlements, journal
entries and statement charges associated with each deduction.

Create a DATASET to monitor your open deduction balances

If a dataset is already created, skip ahead and create your workbook. (one-time task)
Mew Dataset
1. Create a new Dataset: . (Name: “-iTPM 810 Base Forecasts”)

2. Select Record Type: - iTPM Monthly Base forecast:

New Dataset

Select a root record type with the fields you want to include in your dataset.

|base| <] Ql Showing 2 Record Types

RECORD TYPE

- iTPM Monthly Base forecast

Knowledgze Base

3. Criteria: Type YearTest =1 (YearTest is a formula you will create in Step 5.)

» Criteria summary Show details

YearTest

i YearTest equal 1

Helpful Hint: To see only changes for a specific NetSuite fiscal year, add date as a

O criteria.
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date

&4 Dataset | Pivot1 ¢ |& Pivot2 X |+ Pivot3
Date ®x &
~ Fields

Transaction Date =0
Transaction Reference Date ¥ [

. Sh Is )
Note: You may need to click to find your measure.

Use the table on the next page to add these fields to your Base Forecast worksheet:

= iTPM 810 Monthly Base Rev 4 P11 Base Revenue  f #
Base Forecast Produ... % T || P11 Base Units X #
Base Internal ID XK # || p12BaseRevenue  F #
Base Rev Total F« # || P12 Base units X #
Base Units Total fx # || P2 Base Revenue 5 #
Class & || P2 Base Units K #
Company Name T || P3 Base Revenue £, # || P8 Base Revenue i #
% Customer %€ T || p3 Base Units 4 4 || P8 BaseUnits X H#
Customer Internal ID # || p4 Base Revenue £ # P9 Base Revenue i #
% Item 8¢ % T || p4 Base Units g # || P2 BaseUnits X #
Itemn Internal ID # || P5 Base Revenue F. # || Planning Customer i T
Mame % T || ps Base units & # || Total Base Revenue £ #
P1 Base Revenue £y # || P6 Base Revenue £ 4 || Ynit of Measure X T
P1 Base Units % # || p6 Base Units & # || Units Total X #
P10 Base Revenue  Jfx ## || P7 Base Revenue f 3 || Year X #
P10 Base Units 9¢ #f || P7 Base Units 9% 4 || YearTest i #
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forecast->Customer

Field Name Source Field ID Description (NetSuite Base
Forecasts)

Base Forecast Formula See step 5 Base Forecast Product Line

Product Line

Base Internal ID - iTPM Monthly ID Base Internal ID
Base forecast

Base Rev Total Formula See step 5 Base Rev Total

Base Units Total Formula See step 5 Base Units Total

Company Name - iTPM Monthly companyname Customer Company Name
Base

forecast->Item

Customer - iTPM Monthly custrecord_itpm_monthly | Customer
Base forecast _customer
Customer Internal - iTPM Monthly custrecord_itpm_monthly | Customer Internal ID
ID Base forecast _customer.id
Planning Customer | Formula See step 5 Planning Customer
Item - iTPM Monthly custrecord_itpm_montly | Item
Base forecast item
Item Internal ID - iTPM Monthly custrecord_itpm_montly_ [ Item Internal ID
Base item?item.id

Product Category - iTPM Monthly custrecord_itpm_montly | Product Category
Base item?item.class
forecast->Item
Name - iTPM Monthly Name Forecast Name
Base forecast
P1 Base Revenue Formula See step 5 P1 Base Revenue
P2 Base Revenue Formula See step 5 P2 Base Revenue
P3 Base Revenue Formula See step 5 P3 Base Revenue
P4 Base Revenue Formula See step 5 P4 Base Revenue
P5 Base Revenue Formula See step 5 P5 Base Revenue
P6 Base Revenue Formula See step 5 P6 Base Revenue
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Base forecast

Field Name Source Field ID Description (NetSuite Base
Forecasts)

P7 Base Revenue Formula See step 5 P7 Base Revenue

P8 Base Revenue Formula See step 5 P8 Base Revenue

P9 Base Revenue Formula See step 5 P9 Base Revenue

P10 Base Revenue | Formula See step 5 P10 Base Revenue

P11 Base Revenue | Formula See step 5 P11 Base Revenue

P12 Base Revenue | Formula See step 5 P12 Base Revenue

P1 Base Units - iTPM Monthly custrecord_itpm_units1 P1 Base Units

P2 Base Units

- iTPM Monthly
Base forecast

custrecord_itpm_units2

P2 Base Units

P3 Base Units

- iTPM Monthly
Base forecast

custrecord_itpm_units3

P3 Base Units

P4 Base Units

- iTPM Monthly
Base forecast

custrecord_itpm_units4

P4 Base Units

P5 Base Units

- iTPM Monthly
Base forecast

custrecord_itpm_units5

P5 Base Units

P6 Base Units

- iTPM Monthly
Base forecast

custrecord_itpm_units6

P6 Base Units

P7 Base Units

- iTPM Monthly
Base forecast

custrecord_itpm_units7

P7 Base Units

P8 Base Units

- iTPM Monthly
Base forecast

custrecord_itpm_units8

P8 Base Units

P9 Base Units

- iTPM Monthly
Base forecast

custrecord_itpm_units9

P9 Base Units

P10 Base Units

- iTPM Monthly
Base forecast

custrecord_itpm_units10

P10 Base Units

P11 Base Units

- iTPM Monthly
Base forecast

custrecord_itpm_units11

P11 Base Units

P12 Base Units

- iTPM Monthly
Base forecast

custrecord_itpm_units12

P12 Base Units

Total Base Revenue | Formula See step 5 Total Base Revenue
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Base forecast

uom

Field Name Source Field ID Description (NetSuite Base
Forecasts)
Unit of Measure - iTPM Monthly custrecord_itpm_montly_ | Unit of Measure

Units Total - iTPM Monthly custrecord_itpm_units_to
Base forecast tal
Year - iTPM Monthly custrecord_itpm_monthly
Base forecast _year
5: Formulas

Formula name

Formula

Base Forecast
Product Line

String

{custrecord_itpm_montly_item*item.class#display}

Base Rev Total

Float

{custrecord_itpm_rev1}+{custrecord_itpm_rev2}+{custrecord_itpm_rev3}+
{custrecord_itpm_rev4}+{custrecord_itpm_rev5}+{custrecord_itpm_rev6}+
{custrecord_itpm_rev7}+{custrecord_itpm_rev8}+{custrecord_itpm_rev9}+
{custrecord_itpm_rev10}+{custrecord_itpm_rev11}+{custrecord_itpm_rev12}

Base Units Total

{custrecord_itpm_units1}+{custrecord_itpm_unit2}+{custrecord_itpm_unit3}+
{custrecord_itpm_unit4}+{custrecord_itpm_unit5}+{custrecord_itpm_unit6}+
{custrecord_itpm_unit7}+{custrecord_itpm_unit8}+{custrecord_itpm_unit9}+
{custrecord_itpm_unit10}+{custrecord_itpm_unit11}+{custrecord_itpm_unit12}

P1 Base Revenue

Float

TO_NUMBER(({custrecord_itpm_rev1})

P2 Base Revenue

Float

TO_NUMBER(({custrecord_itpm_rev2})

P3 Base Revenue

Float

TO_NUMBER({custrecord_itpm_rev3})

P4 Base Revenue

Float

TO_NUMBER({custrecord_itpm_rev4})

P5 Base Revenue

Float

TO_NUMBER({custrecord_itpm_rev5})
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P6 Base Revenue | TO_NUMBER({custrecord_itpm_rev6})
Float
P7 Base Revenue | TO_NUMBER({custrecord_itpm_rev7})
Float
P8 Base Revenue | TO_NUMBER({custrecord_itpm_rev8})
Float
P9 Base Revenue | TO_NUMBER({custrecord_itpm_rev9})
Float
P10 Base TO_NUMBER({custrecord_itpm_rev10})
Revenue
Float
P11 Base TO_NUMBER({custrecord_itpm_rev11})
Revenue
Float
P12 Base TO_NUMBER({custrecord_itpm_rev12})
Revenue
Float
Planning {custrecord_itpm_monthly_customer#display}
Customer
String
Total Base TO_NUMBER({custrecord_itpm_rev1})+TO_NUMBER({custrecord_itpm_rev2})+
Revenue TO_NUMBER({custrecord_itpm_rev3})+TO_NUMBER({custrecord_itpm_rev4})+
TO_NUMBER({custrecord_itpm_rev5})+TO_NUMBER({custrecord_itpm_rev6})+
Float TO_NUMBER(({custrecord_itpm_rev7})+TO_NUMBER({custrecord_itpm_rev8})+
TO_NUMBER({custrecord_itpm_rev9})+TO_NUMBER({custrecord_itpm_rev10})+
TO_NUMBER(({custrecord_itpm_rev11})+TO_NUMBER({custrecord_itpm_rev12})
YearTest CASE
when TO_CHAR({custrecord_itpm_monthly_year}) = TO_CHAR(current_date,'YYYY")
Integer THEN
1
ELSE
0
END
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The fields will change to blue after you drag them into your data set:

Formulas 18 Base Forecast Prod... Jy 'L
iTPM Monthly Base forecast 19 o BaseRevTotal I #
» Customer 2 Base Units Total i #
> Data Entry Method P1 Base Revenue -
el £ p10 Base Revenue 5 #
» Last modified by Contact P11 Base Revenue £ #
» Last modified by Customer
» Last modified by Employee P12 Base Revenue  fx #
» Last modified by Entity P2 Base Revenue  fx #
» Last modified by Generic Resource P3 Base Revenue i #
> Last modified by Group P4 Base Revenue -
» Last modified by Other Name BS Base Revenue £ #
» Last modified by Partner 06 Bace Revenue £ #
> Last modified by Project Template
» Last modified by Project P7 Base Revenue i #
» Last modified by Resource Group P8 Base Revenue I #
» Last modified by Vendor P9 Base Revenue i #
> Owner Planning Customer % T
o Fieled Total Base Revenue Jfy #
> Subsidiary Veartect £ #
» Unit of Measure
 new rormuia [
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9.0 Sales and Orders

9.1 iTPM 910 Sales (Invoiced)

Create a dataset to view invoiced sales.

If a dataset is already created, skip ahead and create your workbook. (one-time task)

1. Create a new Dataset: . (Name: - iTPM 910 Sales (Invoiced))

2. Select Record Type: Sales (Invoiced):

New Dataset

Select a root record type with the fields you want to include in your dataset.

‘sales Q ‘ Showing 4 Record Types
RECORD TYPE =_ RECORD CATEGORY

sales (Invoiced) B3 Analytical

sales (Ordered) Ega Analytical

Sales Readiness H standard

Sales Territory B standard

3. Criteria: Type YearTest = 1 (YearTest is a formula you will create in Step 5.)

~ Criteria summary Show details

Transaction Type - AND - Date

:: Transaction Type is Invoice
AND =
i+ Date on or after start of fiscal year before last

O Helpful Hint: To see only changes for a specific NetSuite fiscal year, add date as a
criteria.
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date

& Dataset |+ Pivot1 X |4 Pivot2 X |+ Pivot3
Date ®x K
w Fields

Transaction Date el |
Transaction Reference Date X [

. Sh Is )
Note: You may need to click to find your measure.

Use the table on the next page to add these fields to your Base Forecast worksheet:

- ITPM 210 Sales (Invoiced) -Sal..]

Amount (Net)

K[>

Customer

O

Date

R[>

H = H F H o ge [ g FH

O

[tem
ltem class
Posting Period

Quantity
Sales Rep

O
K[>

Transaction

Transaction Type
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Field Name Source Field ID Description (NetSuite Sales
(Invoices))

Amount (Net) Sales (Invoiced) amountnet Amount (Net)

Customer Sales (Invoiced) entity Customer

Date Sales (Invoiced) trandate Date

ltem Sales (Invoiced) item ltem

Item Class Sales Invoiced -> itemAitem.class Item Class

ltem

All Rights Reserved

Quick Reference Link: Analytics

Posting Period Sales (Invoiced) postingperiod Posting Period
Quantity Sales (Invoiced) itemcount Quantity
Sales Rep Sales (Invoiced) employee Sales Rep
Transaction Sales (Invoiced) transaction Transaction
Transaction Type Sales (Invoiced) type Transaction Type
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9.2 iTPM 920 Sales Orders Analysis

Create a DATASET to view sales orders

If a dataset is already created, skip ahead and create your workbook. (one-time task)

MNew Dataset
1. Create a new Dataset: . (Name: - iTPM 920 Sales Orders Analysis)

2. Select Record Type: Sales (Invoiced):

New Dataset

Select a root record type with the fields you want to include in your dataset.

|Sales Q, ‘ Showing 4 Record Types
RECORD TYPE —_ | RECORD CATEGORY
Sales (Invoiced) Esa Analytical
sales (Ordered) Ess Analytical
Sales Readiness H standard
Sales Territory H standard

3. Criteria: Type YearTest =1 (YearTest is a formula you will create in Step 5.)

~ Criteria summary Show details

Date

i+ Date on or after start of fiscal year before last

Helpful Hint: To see only changes for a specific NetSuite fiscal year, add date as a
criteria.
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4. Data Fields: Enter each field, find it in the list below, and drag it to your data set. Example: Date

& Dataset |+ Pivot1 X |4 Pivot2 X |+ Pivot3
Date ®x K
w Fields

Transaction Date el |
Transaction Reference Date X [

. Sh Is )
Note: You may need to click to find your measure.

Use the table on the next page to add these fields to your Base Forecast worksheet:

- iTPM 220 Sales Order Analysi...
Actual Shipping Date [1]
Amount (Net) # || Posting Period |
Apply iITPM Discounts? ﬁ 3 Fromise Date ﬁ [z
Customer s & Quantity H
Date [1] Remaove iTPM Discount... 5§ 2
Expected Ship Date [T] || salesRrep T
Itemn g% & || ship Date (1]
Item Class & SO processed by iTPM? £, 2
iTPM Discounts Applied ¢ 2 SO status T
Location & Transaction ae T
No promotions X 2 Transaction Type T
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Date

(Ordered)->Transac
tion

actualshipdate

Field Name Source Field ID Description (NetSuite Sales
(Ordered))
Actual Shipping Sales transaction*ransaction. | Actual Shipping Date

Amount (Net) Sales (Ordered) amountnet Amount (Net)
Apply iTPM Sales Apply iTPM Discounts?
Discounts? (Ordered)->Transac | transaction*transaction.
tion custbody_itpm_applydis
counts
Customer Sales (Ordered) entity Customer
Date Sales (Ordered) trandate Date

Expected Ship Date

Sales
(Ordered)->Transac
tion Line

tranline.expectedshipdat
e

Expected Ship Date

ltem

Sales (Ordered)

item

ltem

Iltem Class

Sales
(Ordered)->Item

item?item.class

Iltem Class

iTPM Discounts
Applied

Sales
(Ordered)->Transac
tion

transaction“transaction.
custbody_itpm_discount
s_applied

iTPM Discounts Applied

Location

Sales (Ordered)

location

Location

No Overlapping
Promotions

Sales
(Ordered)->Transac
tion

transaction*transaction.
custbody_itpm_no_ovel
ap_promo

No Promotions

Posting Period

Sales
(Ordered)->Transac
tion

transaction*transaction.
postingperiod

Posting Period

Promise Date

Sales
(Ordered)->Transac
tion

transaction“transaction.
custbody_promisedate

Promise Date

tion

iscounts

Quantity Sales (Ordered) itemcount Quantity
Remove iTPM Sales transaction*ransaction. | Remove iTPM Discount
Discount (Ordered)->Transac | custbody_itpm_removed
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Field Name Source Field ID Description (NetSuite Sales
(Ordered))
Sales Rep Sales (Ordered) employee Sales Rep
Ship Date Sales transaction*transaction. | Ship Date
(Ordered)->Transac | shipdate
tion
SO Processed by Formula See Step 5 SO Processed by iTPM?

iTPM?

SO Status Sales (Ordered) transaction*ransaction. | SO Status
status
Transaction Sales (Ordered) transaction Transaction
Transaction Type Sales (Ordered) type Transaction Type
5: Formulas
Formula name Formula
SO processed by | Case

iTPM?

Boolean

When {transaction*transaction.custbody_itpm_applydiscounts} = 'F' AND
({transaction*transaction.custbody_itpm_discounts_applied} = 'F' or
{transaction*ransaction.custbody_itpm_no_ovelap_promo} ='F') Then

T
Else
E

End
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10.0 Technical Reference

Your .;TPM team must install the iTPM Analytics SDF project.

10.1 Prerequisites to first-time installation

The only prerequisite is that .TPM must be installed. .TPM Analytics is installed AFTER TPM.
If you installed :;TPM, these were enabled before ;TPM was installed:

o  SuiteBuilder section:
m Custom Records
o  SuiteScript section:
m Client SuiteScript
m Server SuiteScript
o Suiteflow section:
m SuiteFlow
o SuiteGL
m Custom Transactions

10.2 First-time installation

If you have the required NetSuite features enabled listed above in 10.1, use these steps to install iTPM Analytics:

Step 1: Go to SuiteApps in your center tab:
]

Activities iTPM Leads Opportunities Customers Reports Analytics Documents Setup SuiteApps  Support
[
Step 2: Search for "iTPM"
SuiteApps
|iTPM 2 SuiteApps Found
Vertical and Business Meed
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Step 3: Click on "iTPM Analytics"

SORT BY |First Release Date -

iTPM

Extend NetSuite for
Trade Promotion
Management

o’y

iTPM: Integrated Trade
Promotion Management by

(G Squared, Inc.

SuiteApps
[iTPM 2 SuiteApps Found
Vertical and Business Need
VERTICALS
Advertising 4]
Consulting 4] "TPM
Extend NetSuite for
EH C Trade Promotion
Health 0 Management
IT Services 4]
Manufacturing 2
Media and Publishing i} ) .
iTPM Analytics
Nonprofit 4]
Other Industry Solutions 0 CG Squared, Inc.
Wheolesale Distribution 1

Step 4: Click INSTALL.

¢ Back [TPM Ana|ytiCS

o insights for your NetSuite dashboard.

iTPM

Extend NetSuite for
Trade Promotion

Management

Overview Features Publisher

NetSuite Datasets for iTPM

* Criteria filters specific to the workbook

iTPM is a native SuiteApp that extends MetSuite for trade promotion
management. iTPM Analytics includes pre-built NetSuite datasets
and workbooks that provide role-based real-time trade promotion

Pre-built NetSuite Analytics for iTPM

* Measures renamed for end-user readibility
* Shared with the appropriate iTPM standard roles

PUBLISHER

CG Squared, Inc.

FIRST RELEASE DATE
11/21/2024

INSTALLED VERSIOM
LATEST VERSION
1.03

UPGRADES
Managed

If you see INSTALLED, then the "iTPM Analytics" SuiteApp is already installed.

If you see "Limited Access", email support@cgsquared.com to make it available for your NetSuite instance.

© 2025 CG Squared, Inc.
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Step 4: Click INSTALL.

This action will install iTPM Analytics. By installing this SuiteApp, you are giving
the publisher permission to install future upgrades in your NetSuite account at
any time. Do you want to proceed?

Install Cancel

NetSuite 2025.1

Step 5: Check the "I have read and understand the terms of service", checkbox, and click INSTALL.
Note: You may get a red error pop-up message "Terms not accepted...".
If you get this, just repeat step 4, and iTPM Analytics should install.

SuiteApp Terms of Service

By installing the iTPM managed bundle and iTPM Analytics, you accept your iTPM Accep Form Ag

entered into between the purchasing company (“Customer”) and CG Squared, Inc. (CGz), and agree to be bound by
the iTPM License Agreement, www.i-TPM.com/professional-services-agreement, incorporated as Exhibit A, and
the Professional Services Ag www.i-TPM.com/professional-services-agreement incorporated as Exhibit
B.

iTPM is a managed bundle to help Consumer Goods companies manage trade promotion spending.

iTPM supports annual planning (purple boxes), promotion planning (blue boxes), settlements, and deduction management
(green boxes).

Annual Planning
s | (e | (e | ;TPM: Manage promo

~ = Y
[ Monthly ]_'_[ Planned ] = Forecast

Base Events

Le

Workflow:
o Draft Actual sales:

Submitted Product Fulfillments
Approved alculate bill-back liability Customer Invoices

Rejected for direct accounts

C
-—

I have read and understand the terms of service
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Step 6: Wait for iTPM Analytics' to be installed.

NetSuite 2025.1

sk iTPM Analytics

iTPM is a native SuiteApp that extends MetSuite for trade promotion

~
management. iTPM Analytics includes pre-built NetSuite datasets
and workbooks that provide role-based real-time trade promotion FUBLISHER
o insights for your NetSuite dashboard.
[TPM CG Squared, Inc.
Extend NetSuite for . . FIRST RELEASE DATE
Trade Promotion Overview Features Publisher 11/21/2024

Management
INSTALLED VERSION

Pre-built NetSuite Analytics for iTPM
LATEST VERSION

NetSuite Datasets for iTPM 103
Note: If you see "Failed" after the install, click the UPGRADE button.

After UPGRADE, click YES to upgrade iTPM Analytics.
If you don't see the "Upgrade" button, email support@cgsquared.com.

2 This action upgrades the iTPM Analytics SuiteApp in your NetSuite account. Do you want to proceed?

Yes No

After 'iTPM Analytics' is installed, then you will see the 20+ prebuilt workbooks under the ANALYTICS center tab:

C'T) * ﬁ Activities iTPM  Transactions Lists Reports Analytics Documents Setup Customization Commerce

» My favorite workbooks

Workbooks Datasets

| Q | |AII Workbooks = | Showing 33 Workboaoks
WORKBOOK NAME = DETAILS DESCRIPTION SCRIPTID
ﬁ - iTPM 210 Open Deduction Analysis (SDF) Details Use this to analyze open deductions _itpm_210
j‘k - ITPM 220 All Deductions Open and Resolved (SDF) Details Analyze open AND resolved deductions _itpm_220
ﬁ - iTPM 230 Deduction Aging by Month/Last Yr (SDF) Details Deduction Aging Current, Last Month, Prior Month & Last Year _itpm_230

After ''TPM Analytics' is installed, with appropriate role permissions you can also confirm that "iTPM Analytics" is
installed by going to Customization ->SuiteCloud Development -> Installed SuiteApps.
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Installed SuiteApps

ACTION PUBLISHER ID APPID HAME VERSION DESCRIPTION INSTALL STATUS INSTALLED BY DATE INSTALLED DATE LAST UPDATED
i’a‘v com.cgsquared com.cgsquared.itpmanalytics erfarﬂ'lica 1.03 COMPLETE iTPM Demo ;Sr:5!2024 922 12/5/2024 9:22 am

10.3 Adjustments after first-time installation

After .TPM Analytics is deployed to your NetSuite account, the CG Squared team will perform these reviews and
tasks. If you do the first-time install, we suggest you follow this checklist to adjust your filters and other workbook

attributes:

1. 7.1 iTPM 710 Reconcile Open Deduction GL suspense account
o Change the GL in this dataset to match your open Deduction Clearing account GL.
o (Same GL you see in iTPM -> Setup -> Preferences.)
2. You may need to make these changes to see data in your pivot tables:
e Remove then re-add dataset filters: 210, 220, 310, 320, 710 and 720
e Remove workbook filters: 210, 220
e [... Section under construction ... ]

10.4 Update to newer versions
Only the CG Squared team can update your templates to a new version.
You are able to update iTPM Analytics in your sandbox.

Follow the same steps to install, then click UPDATE.

Installed Upgrade

If multiple versions are available, select the most recent version:

This action upgrades the iTPM Analytics SuiteApp in your NetSuite account. Which SuiteApp version do you want to upgrade?
1.0.4
(1.03

Yes No

Email support@cgsquared.com to discuss if the CG Squared team should initiate an update to your TPM
Analytics SuiteApp.
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CG Squared, Inc. and this User Guide

CG Squared designs, develops and supports the .;TPM SuiteApp. CG Squared, or CG?, stands for Consumer
Goods Consulting Group. Our passion and 100% focus is trade promotion for the CG industry. We have more
than 30 years experience delivering closed-loop, trade promotion management solutions. CG? is committed to
providing you world-class software and services:

Implementation services to get ;TPM configured, installed and ready for live production.
Training, so your staff can efficiently use ;TPM for trade promotion management.

Help Desk support to answer your questions and help solve any issues.

Ongoing software enhancements, with two new releases scheduled every year.
Optional TPM best-practices consulting.

Learn more and follow our TPM blog at www.CGsquared.com.

CG? services are bound to terms of service of the Professional Services Agreement between the parties.

:{TPM Closed Loop Trade Promotion Management

[TPM is a native SuiteApp built for NetSuite. . TPM is published and installed
into your NetSuite account as a managed bundle. CG?works to make new
releases of TPM backward compatible so you can enjoy new features every
few months.

dPM

Extend NetSuite for
Trade Promotion
Management

ol

This manual has been designed for two-sided printing to save paper!

A PM Analytics is an SDF published library that is available for all ;TPM clients.
We invite you to follow our ;TPM blog at www.i-TPM.com.

Because we publish updates to .-TPM twice each year, features and
screenshots in this User Guide may not match what you see in ;TPM. This document is not intended to be a
reference for NetSuite features, functionality and version releases.

The [TPM Subscription is bound to terms of service of the .;TPM License Agreement between the parties.

Any reproduction or distribution of any part of this document without the prior written permission of CG Squared
Inc. is strictly prohibited.

Information in this document and online is confidential and proprietary information of CG Squared Inc.
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